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THE GS TRUSS INTERFACE 
In this section of the GS Truss Designer’s Manual we will provide a high-level overview of the windows, 
menus, and toolbars you will need to use GS Truss successfully.  Throughout this document, we will also 
mention other documents you can refer to for details about specific functionality and “How To” 
instructions. 

Parts of the GS Truss Window 
When the GS Truss application is started, it will open a window like the one pictured in Figure 1 above. 
The GS Truss window consists of some components that are standard to all windows, as well as others 
that are unique to GS Truss.  The label numbers presented in Figure 1 coincide with the descriptions that 
follow: 

1. Title bar – A standard windows element that displays the title and version of the application 
being used; in this case, GS Truss 5.001. 

2. Control Buttons – These Windows buttons are used to minimize, maximize, and close the GS 
Truss window.  In addition to using the control buttons, you can change the width of the GS 
Truss window by clicking and dragging on any edge. You can also move the GS Truss window to 
any location on your desktop by clicking and dragging on the GS Truss window’s title bar. 

Figure 1: Parts of the GS Truss application window. 
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3. Menu bar – The GS Truss menu bar provides a comprehensive listing of all features and 
functions available within the application.  The list of commands available in the menu bar will 
vary, depending upon the tasks being performed by the user. 

4. Toolbars – GS Truss provides a variety of toolbars containing subsets of the commands listed in 
the menu bar.  The toolbars and commands made available to the user depend upon the task 
being performed at any given time. 

5. Projects Window – The Projects window appears on the upper left-hand side of the GS Truss 
window.  The Projects window displays, and provides access to, the jobs, projects, and truss files 
a user has created and/or has access to.  Truss files can be opened directly from within the 
Projects pane by double-clicking on them.  The Projects window can be undocked and moved to 
a different location within – or even outside of – the GS Truss window. 

6. Main/Gray Screen – The Main/Gray Screen takes up the majority of real estate in GS Truss.  
When no truss file is open (as in Figure 1), this area is referred to as the Gray Screen.  When a 
truss file is open (as in Figure 2 on the following page), it is referred to as the Main Screen. 

7. Data Window – The Data window provides information about various processes executed by 
the user, including: 

 Analysis – The Analysis tab provides details about the specific processes undertaken as 
part of the analysis, as well as the success or failure of each of those processes. 

 Batch Log – The Batch Log tab provides information about the specific batch processes 
being performed. 

 Materials – The Materials tab displays details about the materials being used in the 
truss file that is currently active.  Information provided includes the name and 
Combined Stress Index (CSI) associated with each section of truss, along with the 
material name. 

 Error Log – The Error Log tab provides detailed information about any errors that occur 
during the analysis or batching of trusses. 

 TTC – When analysis is run, the TTC tab provides information about the trusses that 
carry (i.e. support) the truss being analyzed, as well as the trusses that are carried by the 
truss being analyzed. 

The Data window can be undocked and moved to a different location within – or even outside 
of – the GS Truss window. 

8. Status Bar – A section across the bottom-most portion of the GS Truss window, the Status Bar 
provides context-sensitive information about the function currently being performed by the 
user. 

           TIP!  The toolbars and windows visible when you end your GS Truss session will be  
           the ones visible at your next use.  Some tools and toolbars will appear or disappear  
          depending on the current function being performed. 
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More Parts of the GS Truss Window 
Once a truss file has been opened, there are two fundamental changes that occur within the GS Truss 
interface.  As can be seen in Figure 2 below, the first change is that a diagram of the opened truss is 
displayed in the Main Screen.  The second change is that the Job Bar opens up with detailed information 
about the truss.  For more information about the Job Bar, see this document’s section entitled “Creating 
a Truss from Scratch.” 

Truss Icons 
The truss icons in the Projects window deserve special mention, because their  
color and shape provide information about the trusses they represent.  As can be  
seen in the Projects window shown in Figure 3 at right, the Job entitled “House 3”  
has numerous trusses associated with it.  Icons representing truss profiles  
imported from GS Plan (.ITR and .ITF files) are displayed as green truss profiles  
(without webbing).  Trusses created in, or converted to, GS Truss files (.KTS) are 
 represented as webbed trusses and are blue in color.  Icons that include a green  
checkmark represent trusses that have successfully completed the analysis/design  
process.  Icons overlaid with a red “X” signify trusses that have failed the analysis/ 
design process.  Icons that look like a sideways letter “T” denote truss-to-truss  
connection files. 

Figure 2: When a truss file is opened, the truss is displayed on the Main Screen and the Job Bar opens at the top of the window. 

Figure 3:  The Projects 
window 
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The GS Truss Menu Bar 

Taken collectively, the menu bar contains all commands and functions available within the GS Truss 
application.  Menu bar listings change, based upon where the user is within the application and the 
functions he or she is performing. 

FILE MENU 

The File menu provides access to basic commands for creating new truss 
files, opening existing files, and initiating batch processes. 

New Roof Truss – Clicking on the New Roof Truss menu item opens 
the Job bar and a blank page on the Main Screen.  Note that the 
hot-key combination Ctrl+N performs the same function.  For more 
information about creating a new roof truss, refer to the section 
within this document entitled “Creating a Truss from Scratch.” 

New Floor Truss – Clicking on the New Floor Truss menu item 
opens the New Floor Truss dialog box.  Note that the hot-key 
combination Ctrl+F performs the same function. 

New TTC – Selecting New TTC opens a blank truss-to-truss 
connection table.  For more information about truss-to-truss 
connection tables, refer to the section within this document entitled “Working with Truss-to-Truss 
Connection Tables.” 

Open – The Open function is used to locate and open existing truss files.  The Open function can 
also be accessed from the Main toolbar using the icon pictured at left, or by using the hot-key 
combination Ctrl+O.  Users may also elect to open existing truss files by double clicking on their 
file names in the Projects window.   

Close – When the Close function is selected, GS Truss closes the truss file that is currently active 
on the Main Screen.  If there are any unsaved changes, the user will be prompted to save the file 
before it is closed. 

Save – For newly created files, clicking on the Save menu item opens a Save As dialog box, where 
the user is prompted to associate the file with a specific job and enter a file name.  If the file has 
been saved previously, no dialog box will open; the file will simply be saved again under the same 
file name.   The Save function can also be accessed from the Main toolbar using the icon pictured 
at left, or by using the hot-key combination Ctrl+S. 

Save As – The Save As function allows the user to save the current truss file with a new file name 
and/or to a new location.  The Save As function can also be accessed from the Main toolbar using 
the icon pictured at left. 

Batch Process – The Batch Process option provides access to a variety of outputs that can be 
produced for an entire collection of truss files.  The potential outputs include: Design, Plotting, 
Cutting, Jig Settings, Consolidated Cut List, Material List, Billing, Laser Jig Files, and Roll Former 
Files. 

Send Trusses – Clicking on the Send Trusses menu item opens Keymark’s KeyComm application, 
enabling users to send individual truss files or batches of trusses to Keymark engineers for review. 

Figure 4: The GS Truss File menu. 
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[Recent Files] – Near the bottom of the File menu, GS Truss displays the file name and path of the 
six truss files that have been opened most recently. 

Exit – The Exit command closes the GS Truss application.  The user will be prompted to save any 
unsaved changes to open truss files. 

VIEW MENU 

The View menu can be used to hide or display portions of the GS Truss interface, 
including toolbars, the Project and Data windows, and the Status Bar.  It can also 
be used to zoom in or out, or change the perspective in which truss drawing are 
presented. 

Toolbars – The Toolbars menu option allows users to select the specific 
toolbars to be displayed in the GS Truss window.  The toolbar options 
include: Main, View, Geometry, Batch, Design, Job, Auto Web, and Output. 

Status Bar – When this menu item is activated, a Status Bar will appear at 
the bottom of the GS Truss application window.  (See Figure 1 on page 6.) 

Projects Window – When activated, the Projects window will appear within 
the GS Truss application window.  (See Figure 1 on page 6.) 

Data Window – When activated, the Data window will appear within the GS Truss application 
window.  (See Figure 1 on page 6.) 

Element View – When Element View is selected, trusses are displayed as two dimensional 
elements and nodes.  (See Figure 6 below.)  Element View can also be accessed from the View 
toolbar using the icon pictured at left. 

Piece View – Piece View displays the truss as a collection of numbered members.  (See Figure 6 
below.)  Piece View can also be accessed from the View toolbar using the icon pictured at left. 

3D View – As its name implies, 3D View displays a three-dimensional image of the active truss.  
(See Figure 6 below.)  Three function keys can be used to hide and display various pieces of the 
truss in 3D View: 
 F2 – Controls the display of the top and bottom chords. 
 F3 – Controls the display of all webs. 
 F4 – Controls the display of bearings. 

3D View can also be accessed from the View toolbar using the icon pictured at left, above. 

 

Figure 6:  Element View                      Piece View                            3D View                  Applied Loads View                     Analog View 

Figure 5: The View menu. 
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Load View – When Load View is selected, GS Truss displays trusses in Piece View and shows the 
various loads brought to bear on the truss.  (See Figure 6 on the preceding page.)  Load View can 
also be accessed from the View toolbar using the icon pictured at left. 

Analog View – The Analog View model is referenced for all design calculations.  The members are 
represented with centerlines, and bearings are placed precisely.  (See Figure 6 on the preceding 
page.)  If an analog model has not been created for the active truss, the Analog View menu item is 
grayed out and inaccessible.  Analog View can also be accessed from the View toolbar using the 
icon pictured at left. 

Zoom Window – The Zoom Window function allows users to select a specific area of a truss 
diagram as the focus for zooming actions.  The Zoom Window command can also be accessed 
from the View toolbar using the icon pictured at left. 

Zoom Full – The Zoom Full function displays the entire truss in the Main Screen of the GS Truss 
window.  Zoom Full can also be accessed from the View toolbar using the icon pictured at left. 

Refresh Projects – The Refresh Projects command updates listings in the GS Truss Projects 
window. 

PRESETS MENU 

GS Truss presets are a collection of user-defined variables that provide the 
information foundation required to create and modify trusses quickly and 
efficiently.  Presets reflect the most common data and output configurations 
used by an organization in the creation of trusses.  There are eight categories 
of presets: 

System – System Presets provide basic information about specific files 
and file paths to be used in conjunction with truss creation.  System 
Presets also help define such things as connections, batch processes, 
and the format of output. 

Pricing – Pricing Presets allow users to define the price of materials, labor, and overhead for 
bidding and billing purposes. 

Cutting/Plotting – Cutting/Plotting Presets allow users to define such things as roll-former output, 
and the format and content of cutting and plotting reports. 

Jig Settings – Jig Setting Presets are used to create, define, and modify the configuration of the jig 
tables used in the assembly of trusses. 

Geometry – Geometry Presets are used to establish default values for truss heels and overhangs, 
as well as joint cuts and cap trusses. 

Engineering/Design – Engineering/Design Presets are used to define default standards for design 
and loading, as well as material limits and deflection criteria.  Engineering/Design Presets can also 
be accessed from the Design toolbar using the icon pictured at left. 

Auto Web – Auto Web Presets are used to control the automated layout of webbing on trusses.  

Gable Web – Gable Web Presets consist of a set of variables that control how gable trusses are 
designed. 

  

Figure 7: The Presets menu. 
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GEOMETRY MENU 

The Geometry menu provides quick access to the core set of tools used to create 
and modify trusses. 

Library – The Library tool consists of a collection of standard truss profiles 
and webbing patterns that can be used to create or modify trusses quickly 
and easily.  The Library tool can also be accessed from the Geometry toolbar 
using the icon pictured at left. 

WARNING!  It is important to note that using objects in the 
Library negates any changes made to a truss through the use of 
other tools. 

Oddball – Oddball is a collection of tools used to design non-standard or complex trusses, and to 
adjust truss geometry (such as panel points and members) to the desired specifications.  Oddball 
can also be accessed from the Geometry toolbar using the icon pictured at left. 

Piece Editor – The Piece Editor is used to add bracing and non-structural elements to the active 
truss.  Piece Editor can also be accessed from the Geometry toolbar using the icon pictured at left. 

Auto Web – The Auto Web function is used to web the active truss automatically, based upon 
parameters established in the user’s Auto Web Presets.  Auto Web provides users with an 
opportunity to review and adjust these parameters before webbing is applied.  The Auto Web 
function can also be accessed from the Geometry toolbar using the icon pictured at left. 

Gable Web – The Gable Web function is used to web the active gable truss automatically, based 
upon parameters established in the user’s Gable Web Presets.  Gable Web provides users with an 
opportunity to review and adjust these parameters before webbing is applied.  The Gable Web 
function can also be accessed from the Geometry toolbar using the icon pictured at left. 

Stub/Cap – The Stub/Cap function is used to create or modify base trusses with cap tops.  The 
Stub/Cap function can also be accessed from the Geometry toolbar using the icon pictured at left. 

Bearings – Clicking on Bearings in the Geometry menu opens the Bearings window, which is used 
to specify bearings and bearing combinations for the active truss.  The Bearings function can also 
be accessed from the Geometry toolbar using the icon pictured at left. 

Reverse Truss – Selecting the Reverse Truss menu option turns the active truss 180 degrees on its 
bottom chord, displaying the truss in mirror image. 

Quick Auto Web – The Quick Auto Web tool automatically webs the active truss using existing 
panel points and web-design parameters defined in the user’s Auto Web Presets.  Quick Auto Web 
can also be accessed from the Geometry toolbar using the icon pictured at left. 

Quick Gable Web – The Quick Gable Web tool automatically webs the active gable truss using 
existing panel points and web-design parameters defined in the user’s Gable Web Presets. The 
Quick Gable Web function can also be accessed from the Geometry toolbar using the icon pictured 
at left. 

  

Figure 8: The GS Truss 
Geometry menu. 
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LOADS MENU 

The Loads menu is used to access GS Truss functions for creating and 
applying a wide range of load cases to truss designs.  Users can create as 
many load cases as needed, and each load case can include multiple loads. 

User Load Input Macro – The User Load Input Macro tool is designed 
for quick entry of load data, and is used as an alternative to the User 
Load Case and Combination Entry screen. 

User Load Cases/Combos – The User Load Cases/Combinations option under the Loads menu 
allows users to view and edit load cases and apply them in various combinations.  Note that, if the 
truss being viewed is locked, the loads cannot be edited.  

KeyBuild Load Cases – This function has temporarily been disabled. 

Drag Load – The Drag Load function is used to add lateral stresses, imposed by wind or 
earthquakes, which must be resisted by a structure. 

MATERIAL MENU 

The features listed on the Material menu are used to customize materials for 
chords, webs, splices, and bracing. 

Selection – Clicking on Selection opens the Material Selection dialog box, 
which is used to select and force specific materials for user-selected truss 
pieces. 

Edit MPT – The Edit MPT function opens the Material Priority Table Editor dialog box, which is 
used to specify the materials to be made available for truss construction, as well as the bumping 
sequence for those materials.  For more information on Material Priority Tables, refer to the 
section within this document entitled “Working Materials & Material Priority Tables.” 

Chord Bracing – This menu option opens the Chord Bracing dialog box, which is used to specify 
the type of bracing (Sheathed or Sparse) to be used on the top and bottom chords of trusses. 

Properties – The Properties menu option opens a Materials dialog box which provides details 
about the weight, layout, connectors, plates, and engineering values associated with specific 
materials.  This is an “engineer only” function that is grayed-out for users logged into GS Truss 
with “designer” credentials. 

ANALYZE MENU 

The Analyze menu lists functions for the analysis of the structural 
performance of trusses using loading, design, and material criteria. 

Analyze – The Analyze function calculates forces, loads, and 
geometry for a truss.  Specifically, the truss is evaluated for 
deflection, moment, Combined Stress Indices (CSI’s), bearings, 
bracing, loading, screws, gusset plates, and a host of other 
variables.  The analysis process uses only the first material listed in 
the truss MPT; no material bumping occurs.  The Analyze function 
can also be accessed from the Design toolbar using the icon pictured at left, or by using the hot-
key combination Ctrl+A. 

Figure 9: The Loads menu. 

Figure 10: The Material 
menu. 

Figure 11: The Analyze menu. 
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Design – The Design function calculates forces, loads, and geometry for a truss.  The design 
process is similar to the analysis process except that it is not limited to the first material in the 
truss Material Priority Table (MPT).  If there is a material failure for the truss, the design process 
bumps through the MPT until either a material that passes testing is identified, or material options 
in the MPT have been exhausted (whichever comes first).  The Design function can also be 
accessed from the Design toolbar using the icon pictured at left, or by using the hot-key 
combination Ctrl+D. 

NOTE: The Design process does not bump truss plate or screw materials. 

Create Analog – This function creates an analog model of the current truss.  The analog model 
utilizes a multi-node analysis process which is the industry standard.1  This method of modeling 
trusses explicitly describes the flow of forces.  The members are represented with centerlines, and 
bearings are placed more precisely and forces are distributed more accurately than in other model 
representations.  Note that this function can also be accessed by using the hot-key combination 
Ctrl+Shift+A. 

Abort – The Abort menu option cancels the currently executing analysis/design process.  The 
Abort function can also be accessed from the Design toolbar using the icon pictured at left. 

Unlock – This function is used to unlock a truss that has already been analyzed, allowing the user 
to modify truss components.  The Unlock function can also be accessed from the Design toolbar 
using the icon pictured at left, or by using the F8 function key. 

Analog Bearings – The Analog Bearings function provides for the override of bearings in an analog 
model. 

Plate Editor – The Plate Editor function is used to move and resize plates.  The Plate Editor can 
also be accessed from the Design toolbar using the icon pictured at left. 

BATCH MENU 

The Batch menu provides commands for managing the execution of batch processes. 

Next – This function opens the next truss file in the current batch.  The Next Truss 
function can also be accessed from the Batch toolbar using the icon pictured at 
left. 

Previous – This command opens the previous truss file in the current batch.  The 
Previous Truss command can also be accessed from the Batch toolbar using the icon pictured at 
left. 

Quit – The Quit Batch function cancels the batch process currently being executed.  The Quit 
Batch function can also be accessed from the Batch toolbar using the icon pictured at left. 

  

                                                             
1 As described by “AISI Standard for Cold-Formed Steel Framing-Truss Design”, Dec. 2000. 

Figure 12: The 
Batch menu. 
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OUTPUT MENU 

The Output menu provides access to all of the reports and diagrams that can be 
generated in GS Truss. 

Preview – The Preview feature is used to view output prior to printing.  The 
document types that can be previewed include: Cut Lists, Plot Drawings, Joint 
Details, Pricing, and Jig Settings. 

Print – The Print function sends the designated report directly to the printer.  
The document types that can be printed are the same as those listed under 
Preview above. 

Eng Diagrams – This menu option opens the Applied Loads View window.  For detailed 
information about the Applied Loads View, see page 156. 

Reports – The Reports menu item provides access to 
two different outputs: 

 Engineering – Selecting this option creates an 
Engineering Report (like the one pictured at 
right) for the truss file that is currently active.  
This report provides extremely detailed 
information about the truss, including: 
geometry, load cases, reaction tables, force 
and momentum tables, and joint details. 

 Materials – Selecting this option creates a 
Materials Report, which contains detailed 
information about materials and the 
Combined Stress Indices (CSIs) associated with 
each node within the active truss. 

Debug All – Debug All is an “engineer only” function 
that is used to produce an extremely detailed report 
for validating the engineering of a truss.  Debug All 
can also be accessed from the View toolbar using the icon pictured at left. 

  

Figure 13: The 
Output menu. 

Figure 14: A detailed Engineering Report. 
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WINDOW MENU 

The Window menu provides access to functions for arranging and managing 
windows within the GS Truss application. 

Tile – As pictured in Figure 16 below, the Tile option arranges all open 
truss files side-by-side and top-to-bottom on the Main Screen. 

Cascade – The Cascade option displays all open truss 
files laid out like a hand of cards, as pictured at right. 

Close All – The Close All option closes all open truss 
files. 

[Open Files] – At the bottom of the Window menu, GS 
Truss provides a list of all of the truss files that are 
currently open.  The active truss file is highlighted with 
a checkmark. 

HELP MENU 

The Help menu contains commands for accessing GS Truss online help files, the 
Keymark website, and information about the version and build of GS Truss 
installed on your system. 

Contents – The Contents menu option displays the GS Truss Help Topics 
window, opened to the Table of Contents tab. 

What’s New – Clicking on the What’s New menu item opens a window displaying Release Notes 
for the installed version of GS Truss. 

Figure 16:  The Tile option displays truss files side-by-side and top-to-bottom on the GS Truss Main Screen. 

Figure 15: The Window menu. 

Figure 17: Truss files displayed in Cascade mode.  

Figure 18: The Help menu. 
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Visit Website – Clicking on the Visit Website option opens the user’s default browser to the 
Keymark website home page. 

About GS Truss – The About GS Truss option opens a message box with detailed information 
about the installed version of GS Truss, including the version and build number. 

TTC MENU 

When you have a Truss-to-Truss Connection Table open on the Main Screen, the 
GS Truss menu bar will include a TTC listing.  This menu provides access to 
functions for working with your Truss-to-Truss Connection Tables.  The functions 
provided in this menu are identical to those found on the TTC toolbar. 

New Connection – Clicking on the New Connection icon inserts a new, 
blank row at the bottom of the TTC.  If you add a new connection to an 
existing TTC, GS Truss will display the message box pictured in Figure 20.  Click on the Yes button 
to continue the process of adding a new connection to the table. 

Delete Connection – Clicking on this icon will 
delete the currently selected row from the TTC.  
If you delete and existing connection from a 
TTC, GS Truss will display the message box 
pictured in Figure 20.  Click on the Yes button 
to continue the process of deleting the existing 
connection. 

Reverse Connection – Clicking on this icon 
exchanges the values in the truss type (Carrying 
Truss and Carried Truss), Offset, and V Offset columns with one another.  In addition, the value in 
the Angle column is changed to its opposite counterpart.  (For example, a 315 degree angle is 
changed 45 degrees, a 90 degree angle changes to 270 degrees, and so on.)  If you reverse a 
connection in an existing TTC, GS Truss will display the message box pictured in Figure 20.  Click on 
the Yes button to confirm your intention to reverse the designated connection. 

Analyze Truss – After making changes to an existing TTC, click on the Analyze icon to update the 
layout of all trusses affected by your changes without bumping any truss materials in the process. 

Design Truss – After making changes to an existing TTC, click on the Design icon to update the 
layout of all trusses affected by your changes, and to bump truss materials as needed during the 
process. 

GS Truss Toolbars 
The seven GS Truss toolbars contain a subset of the most commonly used commands and functions 
available from the GS Truss menu bar. 

MAIN TOOLBAR 

The Main toolbar provides quick access to commands for creating, saving, and 
opening truss files, as well as the Undo and Redo commands. 

New – The New drop-down arrow provides a list of new file types that 
can be created in GS Truss.  The three options are: New Roof Truss, New Floor Truss, and New TTC. 

Figure 20:  Confirm changes to an existing TTC by clicking 
on the Yes button in this message box. 

Figure 19: The TTC menu. 

Figure 21: The Main toolbar. 
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Open – The Open tool is used to locate and open existing truss files. 

Save – For newly created files, clicking on the Save tool opens a Save As dialog box, where the 
user will be prompted to associate the file with a specific job and enter a file name.  If the file has 
been saved previously, no dialog box will open; the file will simply be saved again under the same 
file name. 

Save As – The Save As function allows the user to save the current truss file with a new file name 
and/or to a new location. 

Undo – The Undo button cancels the user’s previous action. 

Redo – The Redo button reapplies the previously cancelled action. 

VIEW TOOLBAR 

The View toolbar provides quick access to Zoom In and Zoom Out function-
ality, and offers five different perspectives on truss designs. 

Element View – When Element View is selected, trusses are displayed 
as two dimensional elements and nodes.  (See Figure 6 on page 10.) 

Piece View – Piece View displays the truss as a collection of numbered members.  (See Figure 6 on 
page 10.) 

3D View – As its name implies, 3D View displays a three-dimensional image of the active truss.  
(See Figure 6 on page 10.)  Three function keys can be used to hide and display various pieces of 
the truss in 3D View: 
 F2 – Controls the display of the top and bottom chords. 
 F3 – Controls the display of all webs. 
 F4 – Controls the display of bearings. 

Applied Loads View – When Applied Loads View is selected, GS Truss displays trusses in Piece 
View and provides a view of over 50 different load scenarios that can be applied and reviewed by 
the user.  (See Figure 6 on page 10.) 

Analog View – The Analog View model is referenced for all design calculations.  The members are 
represented with centerlines, and bearings are placed precisely. (See Figure 6 on page 10.)  If an 
analog model has not been created for the active truss, the Analog View icon is grayed out and 
inaccessible. 

Zoom Window – The Zoom Window function allows users to select a specific area of a truss 
diagram as the focus for zooming actions. 

Zoom Full – The Zoom Full function displays the entire truss in the Main Screen of the GS Truss 
window. 

Debug All – Debug All is an “engineer only” function that is used to produce an extremely detailed 
report for validating the engineering of a truss. 

  

Figure 22: The View toolbar. 
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BATCH TOOLBAR 

The Batch toolbar provides users with commands to navigate through the trusses in a 
batch, as well as to stop a batch in the process of execution. 

Next Truss – This option opens the next truss file in the current batch. 

Previous Truss – This option moves to the previous truss file in the current batch. 

Quit Batch – The Quit Batch function cancels the batch process currently being executed. 

OUTPUT TOOLBAR 

The Output toolbar provides quick access to previews for a variety of GS Truss 
reports. 

Preview Cut List – Cut List reports provide information about the materials, 
cut types, and piece lengths for cutting and assembling trusses.  The specific 
content and format of these reports is governed by the values defined on the Cutting tab of 
Cutting/Plotting Presets.  For more information about Cut Lists, refer to the section within this 
document entitled “GS Truss Outputs.” 

Preview Plot – Generally speaking, Engineering Plot Drawings provide detailed information about 
truss load cases, forces, and reactions, however, the precise content of Engineering Plot reports is 
governed by the values defined on the Plotting tab of Cutting/Plotting Presets.  For more 
information about Plot Drawings, refer to the section within this document entitled “GS Truss 
Outputs.” 

Preview Joint Details – The Joint Details report provides detailed information about the all of 
joints in a single truss.  Each report contains a diagram of the entire truss, along with thumbnail-
sized diagrams of all joints in that truss.  For more information about Joint Detail reports, refer to 
the section within this document entitled “GS Truss Outputs.” 

Preview Single Page Joint Details – Similar in content to the Joint Details report, each page of a 
Single Page Joint Details report provides an enlarged diagram of a single joint, along with a 
diagram of the entire truss as a whole.  For more information about Single Page Joint Detail 
reports, refer to the section within this document entitled “GS Truss Outputs.” 

Preview Full Scale Joint Details – Each page of a Full Scale Joint Details report provides a life-sized, 
full-scale diagram of a single joint in a truss. 

Preview Pricing – Pricing reports provide both summary and detail information about truss 
material and labor costs.  For more information about Pricing Outputs, refer to the section within 
this document entitled “GS Truss Outputs.” 

Preview Jig Settings – The Jig Settings report provides information about the jig-table setup required for 
assembly of the active truss.  For more information about Jig Setting outputs, refer to the section 
within this document entitled “GS Truss Outputs.” 

  

Figure 23: The 
Batch toolbar. 

Figure 24: The Output 
toolbar. 
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DESIGN TOOLBAR 

The Design toolbar contains commands for both executing and aborting analysis and 
design processes, unlocking truss files, and editing plates and some presets. 

Eng/Design Presets – Engineering/Design Presets are used to define default 
standards for design and loading, as well as material limits and deflection 
criteria. 

Analyze Truss – The Analyze Truss function calculates forces, loads, and geometry for a truss.  
Specifically, the truss is evaluated for deflection, moment, Combined Stress Indices (CSI’s), 
bearings, bracing, loading, screws, gusset plates, and a host of other variables.  Unlike the design 
process, the analysis process uses only the first material listed in the Material Priority Table (MPT) 
to gather data.  No material bumping occurs. 

Design Truss – The Design Truss function calculates forces, loads, and geometry for a truss.  The 
design process is similar to the analysis process except that, unlike analysis, the design process 
is not limited to the first material in the Material Priority Table (MPT).  If there is a material failure 
for the truss, the design process bumps through the MPT until either a material that passes testing 
is identified, or material options in the MPT have been exhausted (whichever comes first).   

Abort Analysis – The Abort tool cancels the currently executing analysis/design process. 

Plate Editor – The Plate Editor tool is used to move and resize plates.   

Unlock Truss – This function is used to unlock a truss that has already been analyzed, allowing the 
user to modify truss components.  All data generated during the previous analysis/design process 
is deleted when a truss file is unlocked. 

GEOMETRY TOOLBAR 

The Geometry toolbar provides quick access to the core set of tools used to 
create and modify trusses. 

Library – The Library tool consists of a collection of standard truss profiles 
and webbing patterns that can be used to create trusses quickly and easily. 

        WARNING!  It is important to note that using objects in the Library negates any changes made  
        using other tools. 

Oddball – Oddball is a collection of tools used to design non-standard, complex trusses, and to 
adjust truss geometry (such as panel points and members) to the desired specifications.   

 Piece Editor – The Piece Editor is used to add bracing and non-structural elements to a truss. 

Auto Web Settings – The Auto Web Settings function is used to define the parameters for 
webbing the active truss automatically.  The initial values listed within the Auto Web Settings 
window are derived from the user’s Auto Web Presets. 

Gable Web Settings – The Gable Web Settings function is used to define the parameters for 
webbing the active gable truss automatically.  The initial values listed within the Gable Web 
Settings window are derived from the users Gable Web Presets. 

Stub/Cap – The Stub/Cap function is used to create base trusses with cap tops. 

Figure 25: The 
Design toolbar. 

Figure 26: The 
Geometry toolbar. 
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Bearings – Clicking on the Bearings icon opens the Bearings window, which is used to specify 
bearings and bearing combinations for the active truss.   

AUTO WEB TOOLBAR 

The Auto Web toolbar provides access to the Quick Auto Web and Quick Gable Web functions. 

Quick Auto Web – The Quick Auto Web tool automatically webs the active truss using 
the existing panel points and the values defined in the user’s Auto Web Presets. 

Quick Gable Web – The Quick Gable Web tool automatically webs the active gable truss using the 
existing panel points and the values defined in the user’s Gable Web Presets. 

TTC TOOLBAR 

When you have a Truss-to-Truss Connection Table open on the Main Screen, GS 
Truss will display the TTC toolbar.  This toolbar provides access to functions for 
working with your Truss-to-Truss Connection Tables.  The functions provided on 
this toolbar are identical to those found in the TTC menu. 

New Connection – Clicking on the New 
Connection icon inserts a new, blank row at the 
bottom of the TTC.  If you add a new connection 
to an existing TTC, GS Truss will display the 
message box pictured in Figure 29.  Click on the 
Yes button to continue the process of adding a 
new connection to the table. 

Delete Connection – Clicking on this icon will 
delete the currently selected row from the TTC.  If you delete and existing connection from a TTC, 
GS Truss will display the message box pictured in Figure 29.  Click on the Yes button to continue 
the process of deleting the existing connection. 

Reverse Connection – Clicking on this icon exchanges the values in the truss type (Carrying Truss 
and Carried Truss), Offset, and V Offset columns with one another.  In addition, the value in the 
Angle column is changed to its opposite counterpart.  (For example, a 315 degree angle is changed 
45 degrees, a 90 degree angle changes to 270 degrees, and so on.)  If you reverse a connection in 
an existing TTC, GS Truss will display the message box pictured in Figure 29.  Click on the Yes 
button to confirm your intention to reverse the designated connection. 

Analyze Truss – After making changes to an existing TTC, click on the Analyze icon to update the 
layout of all trusses affected by your changes without bumping any truss materials in the process. 

Design Truss – After making changes to an existing TTC, click on the Design icon to update the 
layout of all trusses affected by your changes, and to bump truss materials as needed during the 
process. 

  

Figure 29:  Confirm changes to an existing TTC by clicking 
on the Yes button in this message box. 

Figure 27: Auto 
Web toolbar. 

Figure 28: The TTC toolbar 
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WORKING WITH GS TRUSS PRESETS 

What Are Presets? 
GS Truss presets are a collection of user-defined variables that provide the information foundation 
required to create and modify trusses quickly and efficiently.  Presets reflect the most common data and 
output configurations used by an organization in the creation of trusses. 

System Presets 
System Presets provide basic information about specific files and file paths to be used in conjunction 
with truss creation.  System Presets also help define such things as connections, batch processes, and 
the format of output.  The System Presets dialog box contains three separate tabs of information: Files, 
Paths, and Runtime. 

FILES TAB 

The Files tab allows users to select files and data that will play a central role in the creation and output 
of truss designs and their related documentation. 

Material Priority Table (MPT)  
This drop-down displays a list 
of all Material Priority Tables 
entered into the system.  Each 
table contains a list of 
material options for webs and 
chords, and specifies the 
desired bumping sequence for 
these materials.  Click on the 
drop-down arrow to select the 
MPT to be used as the default 
for the creation of new 
trusses.   

Edit MPTs – The Edit MPTs 
command button opens the 
Material Priority Table Editor.  
The MPT Editor is used to 
view, copy, and modify existing MPTs, as well as to create new tables.  For more information, refer 
to the section within this document entitled “Working with Materials & Material Priority Tables.” 

Use Preset MPT – When this checkbox is activated, and a user goes to open an existing truss file, the 
MPT assigned to the file being opened will be overwritten by the MPT currently selected in the MPT 
drop-down list. 

User Title Block File (TBF)  
This drop-down displays a list of all User Title Block Files (TBFs) entered into the system.  User Title 
Block Files contain general company information to be displayed in GS Truss reports.  Users can 
create multiple Title Block Files and, thereby, customize the company information displayed on a 

Figure 30: The Files tab in System Presets. 
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wide variety of reports.  Click on the drop-down arrow to select the TBF to be used as the default for 
the creation of new trusses.  Your selection will not affect trusses that have already been created. 

Edit TBFs – The Edit TBFs command 
button opens the Title Block Editor, 
which is used to view and modify 
existing User Title Block Files.  (See 
Figure 31 at right.) 

Use Preset – When this checkbox is 
activated, and a user opens an existing 
truss file, the TBF assigned to the file 
being opened will be overwritten by the 
TBF currently selected in the TBF drop-
down list. 

Engineer Title Block File (TBE) 
This drop-down displays a list of all Engineer Title 
Block (TBE) files entered into the system.  The 
Engineer Title Block file contains information  
about the component engineer or company-
specific engineering information.  Users can create 
multiple TBEs and, thereby, customize the 
engineering information displayed on engineering 
diagrams.  Click on the drop-down arrow to select 
the TBE to be used as the default for the creation 
of new trusses.  Your selection does not affect 
trusses that have already been created. 

Edit TBEs – The Edit TBEs command button opens 
the Engineering Title Block Editor, which is used to view and modify existing TBEs.  (See Figure 32 
above.) 

Other Command Buttons 
The command buttons at the bottom of the Files tab allow users to save preset changes perma-
nently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button.   

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

Figure 31: The Title Block Editor dialog box. 

Figure 32: The Engineering Title Block Editor dialog box. 
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      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

PATHS TAB 

The Paths tab allows users to define locations for storing and sharing truss-related files.  

Jobs Path – The Jobs Path 
field specifies the directory 
used to store truss folders 
and files.  Click on the drop-
down arrow to select from a 
list of paths and folders that 
have been used previously.  
Click on the ellipses button to 
browse for, and select, a 
previously unused folder. 

Sharing Path – The Sharing 
Path field specifies the 
directory used to share 
pricing and material files with 
other GS Truss users.  Click on 
the ellipses button to browse 
for, and select, a folder. 

Command Buttons 
The command buttons at the bottom of the Paths tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button.   

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

  

Figure 33: The Paths tab in System Presets. 
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RUNTIME TAB 

The Runtime tab is used to define a host of system defaults, including the content and format of file 
output, batch processes, connection behavior, automated splicing, and more.   (See Figure 34 below.) 

Output Files 
Checkboxes in the Output Files 
section of the tab are used to 
define the types of files that 
GS Truss will generate.  All file 
types are created during the 
GS Truss analysis/design 
process. 

MTR File – When this 
checkbox is activated, GS Truss 
creates Material Management 
(MTR) files in the 
JOBS/[Project Name] folder.  A 
separate MTR file is generated 
for each truss, and each file 
contains detailed information 
about truss geometry, member coordinates, and materials.  MTR files are used by Keymark’s GSS 
Output application. 

DXF File – Drawing Exchange Format (DXF) is a file format supported by many CAD applications.  
When the DXF File checkbox is activated, GS Truss creates a separate DXF file, containing profile 
information, for each truss.  DXF files are stored in the JOBS/[Project Name] folder.   

Joint Data File – When this checkbox is activated, GS Truss creates Joint Data Files (JDFs) in the 
JOBS/[Project Name] folder.  A separate JDF is generated for each truss, and each file contains 
detailed information about truss materials, joints, and bearings. 

CSV File – When this checkbox is activated, and the user runs the Batch → Consolidated Cut List 
process, GS Truss creates a Consolidated Cut List in Comma Separated Value (CSV) format, and 
places the file in the JOBS/[Project Name]/Production folder.  This file contains information about all 
pieces required to fabricate the trusses in the batch, including their material, length, quantity, and 
weight. 

Batch Processes 
Runtime Presets for Batch Processes allow users to choose how batches are run.  Depending on the 
combination of the options selected users can, for example, review each truss prior to analysis for 
verification of proper geometry, loads, and bearings.  Alternatively, users can simply let the program 
import and analyze truss files as a group.  To have the batch run as desired, presets must be defined 
prior to executing the batch process.   

Profile Preview – The Profile Preview option can only be used in conjunction with the batch 
importation and conversion of GS Plan roof truss (ITR) and floor truss (ITF) files.  ITR and ITF files 
contain information about truss outline dimensions and load and bearing information, as well as 
some additional building data. 

Figure 34: The Runtime tab in System Presets. 
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When the Profile 
Preview checkbox is 
activated, and a batch 
design process is 
executed, GS Truss 
displays the profile of 
each truss, one truss at 
a time, in a window 
similar to the one 
pictured at right.  The 
user can chose to 
accept the truss profile 
and continue the 
importation process by 
clicking on the Continue 
button.  Conversely, a 
user may reject a given 
profile by clicking on 
the Skip button.  If the Skip function is chosen, the displayed truss is not imported and the next truss 
in the batch is processed.  The user can also elect to terminate the entire batch-import process at 
any time by clicking on the Cancel Batch button.   

         TIP!  ITR and ITF files do not contain any webbing information, so enabling the Auto Web  
        checkbox in the Profile Preview window (above) can be a real time saver.   

Batch Preview – When the Batch Preview checkbox is activated, GS Truss loads the first truss profile 
in a Design batch and displays it on the Main Screen.  The application then pauses for user input 
prior to executing the analysis/design process.  This gives the user an opportunity to fine-tune the 
truss prior to initiating analysis/design.  When ready, pressing the End key executes the 
analysis/design process, and information about the success or failure of that process is displayed in 
the Batch Log tab of the Data window.  When all trusses have been processed in this manner, the 
Batch Log displays the message, “Batching Complete.” 

Design Review – Similar to the Batch Preview option, when the Design Review checkbox is activated, 
GS Truss loads the first truss profile in a batch and displays it on the Main Screen.  Unlike Batch 
Preview however, the analysis/design process for the truss is executed immediately.  Information 
about the success or failure of that process is displayed in the Batch Log tab of the Data window.  
The application then pauses, giving the user time to review details about the analysis/design.  When 
ready, pressing the End key loads the next truss in the batch.  This process is repeated until the 
batch is complete.  When all trusses have been processed in this manner, the Batch Log displays the 
message, “Batching Complete.” 

        NOTE! If both the Batch Preview and the Design Review checkboxes are activated, GS Truss  
        will pause for user input both before and after the analysis/design process has run.  If none  
of the Batch Process options are selected, the program will import and analyze all of the trusses 
in a batch without pausing between trusses for user input. 

  

Figure 35: The Profile Preview window. 
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Batch Design Process – The Batch Design Process drop-down list provides two options: 

 Analyze – When the Analyze option is selected, the viability of newly created trusses (and 
trusses that have not previously completed the Design process) is evaluated on the basis of 
the first material listed in the Material Priority Table.  Trusses that have previously 
completed the Design process are evaluated on the basis of the final material used in the 
previous truss design.  No materials are substituted for trusses that fail the Analyze process. 

 Design – When the Design option is selected, trusses are run through the design process, 
bumping through the Material Priority Table (MPT) until a suitable material is found or all 
materials in the MPT have been tried and failed. 

Select Printer – When the Select Printer checkbox is activated, the batch printing process opens a 
Print dialog box rather than automatically printing to the computer’s default printer. 

Load BOL from file – When this checkbox is activated, GS Truss loads customer name and address 
information (gleaned from GS Plan LAY files) into the GS Truss Batch Billing Screen.  Having this 
information entered automatically helps expedite the process of generating quotes, invoices, and 
bills of lading. 

Connections 
Rotate plate before bumping – 
When this option is selected, GS 
Truss attempts to resolve design-
failure issues by turning the plates 
on a truss.  If plate rotation fails to 
resolve the issue, material bumping 
is initiated. 

Truss Dimensions 
Panels – When this radio button is 
selected, the Main Screen in GS 
Truss displays dimensions for each 
individual panel within a truss. 

 
 
 
Segments & Bearings – When this 
radio button is selected, the Main 
Screen in GS Truss displays 
dimensions for each individual 
segment of a truss.  (See Figure 37 
at left.) 

  

Figure 36: Panel dimensions. 

Figure 37: Segment & Bearing dimensions. 
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System of Units 
This section determines the unit of measure displayed within GS Truss, and in the application’s 
output: 
 US – United States (imperial units). 
 SI – International System of Units (metric units). 

Splicing 
Automated splicing – When this checkbox is activated, GS Truss splices materials automatically, 
based upon the maximum length of those materials as specified in the Splice Length field of the 
Member Pricing tab in Pricing Presets.  This function works only in conjunction with Design Mode; 
not Analysis Mode. 

Remove all splices before analysis – This drop-down list is enabled when the Automated Splicing 
checkbox is activated.  The list provides users with three choices:  

 No – When No is selected, splices are not removed from a truss prior to analysis/design. 

 Yes – The Yes option temporarily removes all existing splices from a truss prior to execution 
of the analysis/design process.  These same splices are then reinstated after the analysis/ 
design process has completed. 

 Confirm – When the Confirm option is selected and the analysis/ 
design process is initiated, a message box like the one pictured 
at right will open, asking the user to confirm the removal of all 
splices.  As with the Yes option above, all original splices are 
reinstated after the analysis/design process has completed. 

[Miscellaneous] 
Enter key activates the next field – When this option is checked, hitting 
either the Enter or the Tab key on your keyboard causes the application to tab to the next field in 
the user interface.  When unchecked, the Tab key alone is used for this function. 

Show Oddball startup dialog – When this checkbox 
is activated, and the user is creating a new truss, 
clicking on the Oddball tool pulls up the Oddball 
dialog box pictured at right.  When this option is not 
checked, clicking on the Oddball tool takes the user 
directly to the Oddball window without opening the 
Oddball dialog box first.  For more information 
about using the Oddball dialog box, refer to the 
section within this document entitled “Creating a 
Truss from Scratch.” 

Show Piece Labels – When activated, this option 
displays labels for truss pieces on the Main Screen, 
as well as in all drawing outputs. 

Figure 38: Confirming splice 
removal. 

Figure 39: The Oddball Startup dialog box. 
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ITR Import 
Center vertical webs over cantilever bearings – If this checkbox is selected, vertical webs for ITR 
files imported from GS Plan are centered over their cantilever bearings.  If this checkbox is not 
activated, vertical webs are aligned with the outer edge of cantilever bearings.  

[Other] 
Show IT* file even if the KT* file is present – When activated, this function 
displays the source truss files imported from GS Plan (ITR and ITF) in the main 
Projects window – even after native GS Truss files (KTS) have been generated.  
As can be seen in the Figure 40 at right, icons for ITR and ITF files are displayed 
in green font, while truss files in native GS Truss format (KTS) are displayed in 
blue. 

Command Buttons 
The command buttons at the bottom of the Runtime tab allow users to save 
preset changes permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system 
defaults), click on the Save to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

  

Figure 40: ITR and 
ITF files in green. 
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Pricing Presets 
Pricing Presets allow users to define the price of materials, labor, and overhead for bidding and billing 
purposes.  The Pricing Presets dialog box contains six separate tabs of information: Overhead, Member 
Pricing, Plate Pricing, Price Connection, Labor Factors, and Sharing. 

OVERHEAD TAB 

The Overhead tab is used to define 
extraneous costs that will be 
added to customer quotes and 
billing documentation. 

% Material Overhead – This 
field is used to establish an 
additional percentage, over 
cost, for materials. 

Delivery Charge – The Delivery 
Charge field adds a flat fee for 
delivery that will be passed on 
to customers. 

% Tax Rate – This field allows 
users to set tax rates for 
materials and services, based 
on local standards. 

Include Individual Truss Pricing on Output – When activated, this checkbox provides the charges for 
each individual truss on all document output.  If this option is not selected, truss pricing is  
output as a single, lump sum. 

Itemize Composite Materials Output – When this checkbox is activated, GS Truss provides a 
detailed breakdown of costs associated with multi-part materials. 

Command Buttons 
OK – To save your changes and close the Pricing Presets dialog box, click on the OK button. 

Cancel – To discard your changes and close the Pricing Presets dialog box, click on the Cancel button. 
  

Figure 41: The Overhead tab in Pricing Presets. 
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MEMBER PRICING TAB 

The Member Pricing tab allows users to define the cost for each type of material in the Material 
Database. 

Material – This field provides a 
drop-down list of all Material 
Databases available in the 
system.  The contents of the 
selected Material Database 
are displayed in the columns 
that appear below this drop-
down field. 

Material Details 
Description – The Description 
field contains the name 
assigned to each material.  
Values in this field may not be 
edited by the user. 

Unit Cost (Length) – This field 
lists the truss manufacturer’s 
cost, by specified length, for 
each given material.  Values in this field may be edited directly by the user.  When a user changes 
the Unit Cost (Length) value, GS Truss automatically recalculates the associated value in the Unit 
Cost (Weight) field. 

Unit Cost (Weight) – This field provides the truss manufacturer’s cost, by specified weight, for each 
given material.  Values in this field may be edited directly by the user.  When a user changes the Unit 
Cost (Weight) value, GS Truss automatically recalculates the associated value in the Unit Cost 
(Length) field. 

Splice Length – Values in the Splice Length field reflect the maximum length to be used for each 
given material.  Materials that exceed this limit will be spliced.  Values in this field may be edited 
directly by the user. 

Command Buttons 
OK – To save your changes and close the Pricing Presets dialog box, click on the OK button. 

Cancel – To discard your changes and close the Pricing Presets dialog box, click on the Cancel button. 

Load Material – The Load Material 
command button opens the Material 
Pricing dialog box, which is used to assign 
cost and splice-length values to materials 
that have been added to the Material 
Database.  As you can see in the Figure 43 
at right, the topmost section of the 
Material Pricing dialog box displays a 
description of the new material, and 
prompts the user to enter a value for its 

Figure 42: The Member Pricing tab in System Presets. 

Figure 43: The Material Pricing dialog box. 
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Unit Cost and Splice Length.  Once these values have been entered, clicking on the OK button adds 
the new pricing and splice-length data to the Material Database and pulls up the next new material 
to be configured.  When values for all new materials have been entered, clicking on the OK button 
closes the Material Pricing dialog box.  If you wish to enter identical values for multiple materials, 
enable the Apply Cost to all materials being added checkbox, and/or the Apply length to all 
materials being added checkbox, as appropriate. 

PLATE PRICING TAB 

The Plate Pricing tab allows users to define the cost for each type of plate in the Material Database. 

Material – This field provides a 
drop-down list of all Material 
Databases available in the 
system.  The plate-related 
contents of the selected 
Material Database are 
displayed in the columns that 
appear below this drop-down 
field.  Note that some Material 
Databases do not contain 
plates. 

Plate Details 
Plate ID – The Plate ID column 
displays a unique identifier for 
each plate in the database.  
Values in this field may not be 
edited by the user. 

Unit Cost – The Unit Cost field lists the  
truss manufacturer’s cost for each plate  
type.  Values in this field may be edited directly by the user. 

Command Buttons 
OK – To save your changes and close the Pricing Presets dialog box, click on the OK button. 

Cancel – To discard your changes and close the Pricing Presets dialog box, click on the Cancel button. 

Load Material – The Load Material 
command button opens the Material 
Pricing dialog box, which is used to assign 
prices to plates that have been added to 
the Material Database.  As you can see in 
the Figure 45 at right, the topmost section 
of the Material Pricing dialog box displays 
a description of the new plate, and 
prompts the user to enter a value for its 
Unit Cost.  Once a Unit Cost value has been 
entered, clicking on the OK button adds the pricing data to the Material Database and pulls up the 
next new plate to be priced.  When values for all new plates have been entered, clicking on the OK 

Figure 44: The Plate Pricing tab in Pricing Presets. 

Figure 45: The Material Pricing dialog box for plates. 
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button closes the Material Pricing dialog box.  If you wish to enter identical cost values for multiple 
plates, enable the Apply Cost to all materials being added checkbox. 

PRICE CONNECTION TAB 

The Price Connection tab allows users to define the cost for each type of connector in the Material 
Database. 

Material – This field provides a 
drop-down list of all Material 
Databases available in the 
system.  The connector-related 
contents of the selected 
Material Database are 
displayed in the columns that 
appear below this drop-down 
field.  

Connection Details 
Description – The Description 
column displays a unique 
identifier for each connector in 
the database.  Values in this 
field may not be edited by the 
user. 

Category – The Category column provides a classification for each type of connector.  Categories of 
connectors include Screw, Pin, and Glue.  Values in this field may not be edited by the user. 

Factor Units – The Factor Units column applies only to “glue” connector types.  It specifies the unit 
of measure used to express the coverage provided by a given glue type (for example, milliliters).  
Values in this field may not be edited by the user. 

Factor – As with Factor Units, this column applies only to “glue” connector types.  The Factor 
column lists the number of units of glue that are required to cover a specified area.  (For example, 
the number of milliliters of glue required per square inch.)  Values in this field may not be edited by 
the user.   

Unit Cost – The Unit Cost column provides the truss manufacturer’s cost, per piece or specified 
number of pieces, for a given connector.  Values in this field may be edited directly by the user. 

Command Buttons 
OK – To save your changes and close the Pricing Presets dialog box, click on the OK button. 

Cancel – To discard your changes and close the Pricing Presets dialog box, click on the Cancel button. 
  

Figure 46: The Price Connection tab in Pricing Presets. 
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Load Material – The Load Material 
command button opens the Material 
Pricing dialog box, which is used to assign 
prices to connectors that have been added 
to the Material Database.  As you can see 
in Figure 47 at right, the topmost section of 
the Material Pricing dialog box displays a 
description of the new connector, and 
prompts the user to enter a value for its 
Unit Cost.  Once a Unit Cost value has been 
entered, clicking on the OK button adds the pricing data to the Material Database and pulls up the 
next new connector to be priced.  When values for all new connectors have been entered, clicking 
on the OK button closes the Material Pricing dialog box.  If you wish to enter identical cost values for 
multiple connectors, enable the Apply Cost to all materials being added checkbox. 

LABOR FACTORS TAB 

The Labor Factors tab allows users to define workforce expenses associated with the truss 
manufacturing process. 

Factor Desc – The Factor 
Description column provides a 
drop-down list of work 
products associated with 
specific, labor-related 
processes or activities.  A 
single value is selected from 
the drop-down list for each 
row in this column.  Drop-
down-list values cannot be 
edited by the user. 

Param – Where applicable, the 
Parameters column provides a 
variable that is used to 
constrain the calculation of 
costs for a given work product.  
Depending upon the Factor 
Description selected, values in 
the Parameters column may or may not be edited directly by the user. 

Cost Per ? – This column contains the unit of measure associated with the Cost Per field.  (For 
example, cost per unit, cost per specified length, and so on.)  Values in this field cannot be edited by 
the user. 

Cost Per – The Cost Per column lists the total expense associated with a given Factor Description, 
based on the defined unit of measure.  Values in this field can be edited directly by the user. 

Process – The Process column provides a drop-down of activities to which a cost is to be applied.  A 
single value is selected from the drop-down list for each row in this column.  The list of potential 
values includes: Saw Set, Saw Run, Tbl Set, and Tbl Run.  Drop-down-list values cannot be edited by 
the user. 

Figure 47: The Material Pricing dialog box for connectors. 

Figure 48: The Labor Factors tab in Pricing Presets. 
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Command Buttons 
Add – The Add button is used to insert a blank row at the bottom of the current list. 

Delete – The Delete button erases the currently selected row. 

OK – Clicking on the OK button saves your changes and closes the Pricing Presets dialog box. 

Cancel – Clicking on the Cancel button discards your changes and closes the Pricing Presets dialog 
box. 

SHARING TAB 

The Sharing tab is used to create a file with pricing information that can be distributed to multiple users.  
This file provides a way to maintain consistent pricing information across a group of designers. 

Name 
Name – This field is used to 
enter a Name for a new, 
shared pricing-information file. 

Create – Once a new name has 
been entered into the Name 
field, the Create button is 
activated.  When a user clicks 
on the Create button, GS Truss 
creates a new pricing file and 
the newly created file name 
appears in the Files pane 
below. 

Files 
Load – To activate a specific 
pricing-information file, select 
the desired file in the Files pane and then click on the Load button.  The Pricing values defined in the 
selected file will be loaded into each of the tabs of the Pricing Presets window. 

         NOTE! Changes made to values in any of the Pricing Preset tabs only affect the active  
         pricing file. 

Save – When clicked, the Save button saves changes to the active pricing file. 

Delete – The Delete button erases the selected pricing-information file. 

Other Command Buttons 
OK – Click on the OK button to save your changes and close the Pricing Presets dialog box. 

Cancel – Click on the Cancel button to discard your changes and close the Pricing Presets dialog box.  
(Note: Clicking on the Cancel button will not undo changes implemented through the use of the 
other command buttons on the Sharing tab.) 

Figure 49: The Sharing tab in Pricing Presets. 
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Cutting/Plotting Presets 
Cutting/Plotting Presets allow users to define such things as roll-former output and the format and 
content of cutting and plotting reports. 

CUTTING TAB 

The Cutting tab defines options for Cut List reports and roll-former outputs. 

Report Format 
Output Type – The Output Type radio buttons are 
used to designate the kind of Cut List reports to 
be produced.  The two potential values are: 

 Individual – When selected, this radio 
button outputs a separate Cut List report 
for each truss. 

 Consolidated – When the Consolidated 
radio button is selected, GS Truss outputs 
a single Cut List report for an entire job. 

Show Elevation Table – When activated, this 
checkbox adds Elevation Table information to the 
bottom of Cut List reports. 

Show End Cuts – When this checkbox is 
activated, Cut List reports include a picture of 
each piece needed to construct the truss. 

Measure channel chord lengths on the closed side – Depending on the Cut Type specified, the 
length of the closed and open sides of channel chords may differ slightly.  Activating this checkbox 
ensures that measurements are always calculated using the closed side of channel chords.   

Include Material Optimization Report – When this checkbox is activated, GS Truss generates a 
Material Optimization Report when outputting roll former files. 

Truss Drawing Parameters 
The Truss Drawing Parameter radio buttons are used to define the detail level of joint information 
to be included in Cut List reports. 

No Joint Details – When the No Joint Details radio button is selected, GS Truss omits all joint-specific 
information from Cut List reports.  

Gusset Joint Details Only – When this radio button is selected, Cut List reports provide detailed 
information about all truss members joined with a gusset plate. 

All Joint Details – When the All Joint Details radio button is selected, comprehensive information 
about each joint is provided in Cut List reports. 

Roll Former 
Files – The Files drop-down list determines whether roll-former files are output as Individual text 
files or Combined into a single text file. 

Figure 50: The Cutting tab in Cutting/Plotting Presets. 
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Style – The Style drop-down list defines the type of roll-former files to be produced.  Potential 
values include: AMS, Bosch, GSS (Global Steel Systems), and JSS.  Other fields within the Cutting tab 
become enabled or disabled, depending upon the value selected in this field. 

Separate Chords from Webs – When this checkbox is activated, information about webs is broken 
out from chord information in roll-former files. 

Min Piece Size – The Minimum Piece Size field defines the smallest length, for an individual truss 
piece, that can be accommodated by the roll former.  Truss pieces that fall below the Minimum 
Piece Size are not sent to the roll former and must be manufactured by another method. 

Include Index Holes – When this checkbox is activated, roll-former output includes index holes for 
aligning chords and webs. 

Create Cut List for Short Pieces – When activated, this checkbox generates a Cut List for truss pieces 
too small to be created by a roll former. 

Plant Code – The Plant Code field is used to enter the truss manufacturer’s internal code, which will 
be printed on roll-former files and materials. 

Additional Output Folder – When activated, this checkbox indicates that roll-former files are to be 
written to a secondary location.  Usually, this secondary location is a network share, made available 
to all users with a need to access roll-former files.  Once the Additional Output Folder checkbox is 
activated, users can browse for, and select, the secondary folder of their choosing by clicking on the 
ellipses command button immediately below this checkbox. 

Character Width – The Character Width field defines the size of characters printed on pieces output 
from the roll former.  If the roll former selected in the Style field of this tab is incapable of printing, 
or varying the size of print output, this field is disabled.  

Set String Overrides – 
When clicked, the Set 
String Overrides button 
opens the Roll Former 
String Overrides dialog box 
pictured at right.  Note 
that, if GSS is selected as 
the value in the Style field, 
then the Set String 
Overrides button changes 
to GSS Settings. (Additional 
information about String 
Overrides and GSS Settings 
is scheduled for 
publication under a 
separate document.)   

  

Figure 51: The Roll Former String Overrides dialog box. 
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Other Command Buttons 
The command buttons at the bottom of the Cutting tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

PLOTTING TAB 

The Plotting tab is used to define the content and format of GS Truss engineering drawings. 

Report Format 
Output Type – The Output Type radio buttons are 
used to designate the kind of plot drawings to be 
produced.  The two potential values are: 

 Full – When the Full radio button is 
selected, GS Truss generates plot 
drawings that contain detailed analysis 
information, as well as lists of all bearing 
combinations and load cases. 

 Consolidated – When the Consolidated 
radio button is selected, GS Truss outputs 
an abbreviated version of the Full Output 
Type.  Detailed analysis information is 
provided, however, load-case and 
bearing-combination data are displayed 
only as brief notes. 

Show Elevation Table – When this checkbox is 
activated, Elevation Table data is added to the 
bottom of all plot drawings. 

Show Gusset Table – When the Show Gusset Table checkbox is activated, GS Truss inserts a table 
with gusset plate information into plot drawings.  Note that the gusset-table data is not populated 
automatically for all material types. 

Figure 52: The Plotting tab in Cutting/Plotting Presets. 
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Truss Drawing Parameters 
The Truss Drawing Parameter radio buttons are used to define the detail level of joint information 
to be included in plot drawings.   

No Joint Details – When selected, this radio button excludes all detailed joint information from plot 
drawings. 

Gusset Joint Details Only – When this radio button is selected, GS Truss includes detailed 
information about gusset joints in plot drawings. 

All Joint Details – The All Joint Details radio button provides detailed information about all joint 
types in plot drawings. 

[Other] 
Show Additional Joint Data – When this checkbox is activated, GS Truss adds coordinate-point data 
to the Joint Details section of plot drawings. 

Optimize to Paper Size – When activated, this checkbox adjusts the size of plot drawings to best fit 
the paper on which they are being printed. 

Command Buttons 
The command buttons at the bottom of the Plotting tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 
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Jig Setting Presets 
Jig Setting Presets are used to create, define, and modify the configuration of jig tables.  Users may 
create as many jig tables as needed for the manufacture of trusses. 

Height of all tables – This field is used 
to define the maximum height of jig 
tables.  (See “Table Height” in Figure 
54 below.) 

Distance from bottom of tables to 
bottom of rails – This field specifies 
the gap between the bottom portion 
of the jig table and the rails that are 
affixed to it.  (See “Bottom Rail 
Distance” in Figure 54.) 

Stop Diameter – The Stop Diameter 
field defines the width of fixtures 
(stops) used to hold trusses in place on  
the jig table during assembly. 

Distance from center of stop to 
pointer – This field specifies the 
distance between stops and the 
pointer, which is a measurement guide 
used for placing stops on the jig table. 

Show Stops on Report – When this 
checkbox is activated, GS Truss displays 
the location of jig table stops on the Jig 
Settings report.  (See “Stops” in Figure 
54.) 

TABLES 

Add – The Add command button opens the Add Jig Table dialog 
box pictured at right.  This dialog box is used to create settings 
for a new jig table within GS Truss. 

Modify – The Modify command button is used to edit the 
properties of the jig table currently selected in the Table 
Information pane of the Jig Table Settings dialog box. 

Remove – The Remove command button deletes the jig table 
currently selected in the Table Information pane of the Jig Table Settings dialog box. 

Remove All – The Remove All command button deletes all jig tables listed in the Table Information 
pane of the Jig Table Settings dialog box. 

  

Figure 54: An example of a jig table set up. 

Figure 53: The Jig Setting Presets dialog box. 

Figure 55: The Add Jig Table dialog box. 
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TABLE INFORMATION 

Columns in the Table Information pane display basic configuration information about each separate jig 
table that has been created in GS Truss. 

Start Loc – The Start Location column displays the location at which measurement of the jig table 
begins. 

End Loc – The End Location column displays the location at which measurement of the jig table 
ends.   

# Rails – The # Rails column lists the total number 
of rails secured to the jig table. 

RAILS 

Add/Modify Rails – The Add/Modify Rails 
command button opens the Rail Settings dialog box 
(right), which is used to place additional rails on a 
jig table, modify the location of existing rails, or 
delete one or more rails altogether. 

Geometry Presets 
Geometry Presets are used to establish default values for truss shapes and configurations. 

GENERAL TAB 

The General tab of Geometry Presets is used to define parameters for truss heels and overhangs. 

Heels 
Heel Height – The 
Heel Height field 
defines the vertical 
dimension, 
measured from the 
top of the top chord 
through the bottom 
of the bottom chord, 
on either end of the 
truss. 

Plate Height – The 
Plate Height field 
specifies the height 
of the wall on which 
a truss will sit.  The 
value entered here 
will also populate 
the Plate Height field 
in the Oddball Startup dialog box. 

  

Figure 56: The Rail Settings dialog box. 

Figure 57: The General tab in Geometry Presets. 
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Seat Cut – Used primarily for scissor trusses, this field specifies dimensions for a 
Seat Cut; a horizontal section of truss, at the end of a sloping bottom chord, 
which provides a level surface for the truss to rest on a bearing.  (See the figure 
at right.) 

Bearing Width – The Bearing Width field defines the default thickness of the 
wall or structure on which a truss will sit. 

Maximum Connected Heel Height – This measurement dictates whether or not a truss has a 
connected heel.  (Connected heels do not have diagonal webs placed at their ends.)  Any heel that is 
below the Maximum Connected Heel Height will be drawn as a connected heel.  Any heel that is 
greater than this value will include a connecting (vertical) heel web, as well as a diagonal web. 

Center Vert. Heel Webs Over Bearings – When this checkbox is activated, vertical-heel webs are 
centered over their supporting bearings. 

      WARNING!  When the Center Vert. Heel Webs Over Bearings checkbox is  
          activated and you have a vertical-heel web that is substantially wider than the  
         bearing on which it sits, centering the web over the bearing may force the web  
    to extend beyond the natural profile of the truss.  (See the figure at right.) 

Overhangs 
Measurement Type – The Measurement Type drop-down list specifies how the length of the 
overhang will be measured.  The list of potential values includes:  

 Vertical – The dimension/length of the overhang is calculated vertically, from the specified 
top of the heel down. 

 Horizontal – The dimension/length of the overhang is calculated horizontally from the 
specified reference point. 

 Rake – The dimension/length of the overhang is calculated along the angle of the truss 
member from which the overhang extends. 

Cut Type – The Cut Type drop-down list defines the style of cut to be made at the end of truss 
overhangs.  The list of potential values includes: Plumb, Square In, Square Out, and Horizontal.  (See 
Figure 58 below.) 

NOTE!  The difference between “Square In” and “Square Out” is one of dimension.  That is to say, 
though the cuts themselves are identical, the actual length of each overhang will differ, with a 
“Square In” overhang being slightly shorter than a “Square Out” overhang of the same specified 
dimension. 

  

Figure 58: Plumb Cut                  Square In                        Square Out                     Horizontal Cut 
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Floor Trusses 
Default Depth – This field defines the standard depth for floor trusses that are created manually. 

Command Buttons 
The command buttons at the bottom of the General tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 
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STEEL JOINT CUTS TAB 

The Steel Joint Cuts tab allows users to differentiate joint-cut criteria for all truss segments, based on 
whether a truss is a standard or a tube truss.  Cuts for standard trusses are further differentiated based 
upon whether the truss is Structural or Non-Structural. 

Pitch Break Cuts  
There are four 
potential cut types 
for pitch breaks on 
standard trusses:  
Open, Lapped, 
Vertical, and Miter.  
Before going into 
detail about these 
cuts types, we will 
turn to defining the 
truss segments to 
which these cuts 
may be applied. 

Top Chord Pitch 
Break Both Sloped – 
A top chord joint 
where both of the 
intersecting 
members are sloped.  (See Figure A below.) 
Top Chord Pitch Break Flat/Sloped Down – A top chord joint where a flat portion of top chord 
intersects with a sloped section of top chord.  (See Figure B below.) 

Bottom Chord Pitch Break Both Sloped – A bottom chord joint where both of the intersecting 
members are sloped.  (See Figure C below.) 

Bottom Chord Pitch Break Flat/Sloped Up – A bottom chord joint where a flat portion of bottom 
chord intersects with a sloped section of bottom chord.  (See Figure D below.) 

As mentioned previously, there are four different cut types that can be specified for joints at pitch 
breaks.  (See Figure 60 on the following page):  

 Open – The ends of Open cut truss members touch at a single point. 

 Lapped – The ends of Lapped cut truss members overlie one another. 

 Vertical – The ends of Vertical cut truss members connect on a vertical plane.  (That is, 
materials are cut at the angles needed to form a vertical connection.) 

 Miter – The ends of Miter cut truss members are joined at complimentary angles that allow 
the two pieces to dovetail together at the joint. 

                     Figure A                                          Figure B                                           Figure C                                        Figure D 

Figure 59: The Steel Joint Cuts tab in Geometry Presets. 
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End Joint Cuts 
There are three potential cut types for end joints on standard trusses:  Cut In, Cut Out, and Plumb 
Cut.  Before going into detail about these cuts types, we will turn to defining the truss segments to 
which these cuts can be applied. 

Top Chord End Joint < 90 degrees – An end joint, usually at a heel, where the top chord members 
intersect at less than 90 degrees. 

Top Chord End Joint > 90 degrees – An end joint, usually at a heel, where the top chord members 
intersect at an angle greater than 90 degrees. 

Bottom Chord End Joint < 90 degrees – An end joint where the bottom chord intersects the heel at 
less than 90 degrees. 

Bottom Chord End Joint > 90 degrees – An end joint where the bottom chord intersects the heel at 
an angle greater than 90 degrees. 

As mentioned previously, there are three different cut types that can be specified for End Joints. 
(See Figure 61):  

 Cut In – A Cut In joint connection 
does not allow a chord to extend 
beyond the vertical plane of its heel.  
The chord is cut at 90 degrees. 

 Cut Out – This joint connection allows 
a chord to extend beyond the vertical 
plane of its heel.  The chord is cut at 
90 degrees. 

 Plumb Cut – With a Plumb Cut joint connection, the chord forms a flush connection with its 
heel member.  The chord is cut at the angle necessary to achieve this connection. 

Chord at Run Thru Goes To – This drop-down list defines whether or not a chord will extend beyond 
its anchoring vertical run through.   

 Near Side – If this option is 
selected, the chord is trimmed 
flush with the vertical web to 
which it is anchored and does not 
extend beyond it. 

 Far Side – If this option is 
selected, the chord extends  
beyond the vertical web (run through) to which it is anchored. (See Figure 62.) 

Figure 60:     Open                                        Lapped                                        Vertical                                          Miter 

Figure 62: The bottom chord of this studio truss extends to the Far 
Side of its anchoring king post. 

Figure 61: Cut In                      Cut Out                       Plumb Cut 
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Extend Chord at Run Thru – This field is used to define specifically how far the chord extends 
beyond its anchoring vertical web.  It can be used in conjunction with either the Near Side or the Far 
Side options presented above. 

Tubes 
This section of the Steel Joint Cuts tab is used to specify the cut types and weld gaps applied to tube 
materials.  There are three potential cut types that can be applied to tube joints: Single Cut, Double 
Cut, and Square Cut.  Before going into detail about these cuts types, we will turn to defining the 
truss segments to which these cuts can be applied. 

 Raised Heel Joint – A joint where the heel is elevated such that the top and bottom chords 
of the truss do not actually touch one another. 

 Smooth Chord Joint – Any joint that is not at a pitch break or the end of a truss. 

 Pitch Break Joint – A joint between intersecting chord members where the slope of both 
members is of equal or varying pitch. 

 Studio Joint – A joint where a chord intersects the vertical web of a studio truss.  (See Figure 
62 on the preceding page.)  

 Interior Joint – A joint where a web on the top part of an attic truss gets a collar tie (a 
horizontal web). 

As mentioned previously, there are three different cut types that can be applied to tube joints.  (See 
the figures below): 

 Single Cut – Tubes are cut once, at varying degrees, and do not overlap one another at 
joints. 

 Double Cut – Tubes are cut twice, allowing webs to connect fully at the joint. 

 Square Cut – Tubes are cut at 90 degrees, providing minimal contact at the joint. 

 Web Weld Gap –The Web Weld Gap field is used to define the space required between 
tubes in order to accommodate a weld. 

Command Buttons 
The command buttons at the bottom of the Steel Joint Cuts tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

  

Figure 63:          Single Cut                                                          Double Cut                                                         Square Cut 
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OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

       WARNING!  When you make changes to presets, once you click on the Save to System button,  
          clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

CAP TRUSS TAB 

The Cap Truss tab is used to define the default settings for stubbing and capping trusses. 

Create Cap With Stub 
Top – When this 
checkbox is activated, 
GS Truss allows for 
the creation of 
trusses that are too 
tall to be manufactur-
ed and delivered as a 
single unit.  That is, 
the topmost section 
of truss can be 
created as a separate 
entity (a “cap”), 
which is joined to the 
main body of the 
truss on site.  (See Figure 65 below.) 

Heel Height – The Heel Height field is used to define the default dimension of heels for all cap 
trusses.  (See Figure 65.) 

Overhang Gap – The 
Overhang Gap field 
defines the space between 
the ends of the cap’s 
overhangs and the pitch 
break of the base.  (See 
Figure 65.) 

Include Chord Gap – 
When this checkbox is 
activated, a gap is created 
between the base truss and its cap.  (See Figure 65.) 

Chord Gap Dimension – This field defines the measurement of the space between a base truss and 
its cap.  (See Figure 65.) 

Purlin Spacing – The Purlin Spacing field defines the default distance between bracing mechanisms 
connecting neighboring trusses on the top chord and the bottom chord.  (See Figure 65.) 

Figure 65: A base truss with a cap truss on top. 

Figure 64: The Cap Truss tab in Geometry Presets. 
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Command Buttons 
The command buttons at the bottom of the Cap Truss tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 
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Engineering/Design Presets 
Engineering/Design Presets delineate default design and loading standards, as well as material limits and 
deflection criteria. 

DESIGN TAB 

The Design tab is used to define engineering fundamentals, such as the building code to be 
implemented, bumping rules for chords, and web crippling. 

Building Code – The Building Code drop-down list is used to select the primary building code to be 
applied to truss designs.  The list of potential values includes: 

FBC – 2010 
FBC – 2007 
FBC – 2004 
IBC – 2012 
IBC – 2009 
IBC – 2006 
IBC – 2003 
IBC – 2000 
IRC – 2012 
IRC – 2009 
IRC – 2006 
IRC – 2003 
IRC – 2000 

 

 

Method – The Method drop-down list is used to select the preferred design methodology.  
Currently, Allowable Strength Design (ASD) is the only methodology available in GS Truss. 

Bumping Rules  
The Bumping Rules section of the Design tab is used to define the rules for upgrading materials 
automatically to satisfy design requirements. 

Top Chord – The Top Chord drop-down list provides three options for bumping top-chord materials:  
 Chord – The entire chord will be bumped as a single unit. 
 Segment – Bumping will be implemented, as required, for individual segments of a chord. 
 Piece – Material bumping will be applied at the level of individual truss pieces. 

Bottom Chord – The Bottom Chord drop-down list provides three options for bumping bottom-
chord materials:  
 Chord – The entire chord will be bumped as a single unit. 
 Segment – Bumping will be implemented, as required, for individual segments of a chord. 
 Piece – Material bumping will be applied at the level of individual truss pieces. 

Figure 66: The Design tab in Engineering/Design Presets. 
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Web Crippling 
The Web Crippling section of the Design tab is used to define parameters for the automated review 
and revision of the structural integrity of webs. 

Web Crippling Check – When this checkbox is activated, GS Truss executes web-crippling checks on 
all trusses with point loads.  (Note: This checkbox is only enabled for those working in GS Truss with 
engineer credentials.) 

Bump Chord Material on Failure – When this checkbox is activated, GS Truss automatically bumps 
chord materials that fail the web-crippling check. 

Default Pt Load Trib Width – This field defines the Tributary Width to be used as the default value 
for the application of point loads. 

Max Point Load Trib Width – This field defines the maximum Tributary Width to be used for the 
application of point loads. 

Truss-to-Truss Connections 
Connection Configuration – The value selected from this drop-down list is used to define the default 
connections between carried trusses and girders. The list of potential values includes: 

 Chord - Chord 
 Web - Web Flange 
 Web - Web Face 

Command Buttons 
The command buttons at the bottom of the Design tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

        WARNING!  When you make changes to presets, once you click on the Save to System  
        button, clicking on either the Restore or Cancel buttons will not reinstate previous settings. 
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STANDARD/AUTO LOADS TAB 

The Standard/Auto Loads tab is used to define default values for live and dead loads, as well as the 
spacing of purlins for top and bottom chords. 

Roof Standard Loads 
Standard Loads 
are applied to 
all trusses 
created in GS 
Truss.  Default 
values for live 
and dead loads 
are to be 
entered as per 
code. 

Top Chord Live 
– This figure 
represents 
weight that is 
produced by 
the use and 
occupancy of a 
building, as it 
applies to the 
top chords of 
trusses. 

 
Top Chord Dead – This figure represents weight that is permanent, unmoving, and consistent across 
the top chord of a truss. 

Bottom Chord Live – This figure represents weight that is produced by the use and occupancy of a 
building, as it applies to the bottom chord of trusses. 

Bottom Chord Dead – This figure represents weight that is permanent, unmoving, and consistent 
across the bottom chord of a truss. 

Spacing – This field is used to define the default distance between trusses. 

10* – When this checkbox is activated, GS Truss adds a new, non-concurrent, live load case that 
applies 10 pounds per square foot to the bottom chord of trusses. 

Floor Standard Loads 
Top Chord Live – This figure represents weight that is produced by the use and occupancy of a 
building, as it applies to the top chords of trusses. 

Top Chord Dead – This figure represents weight that is permanent, unmoving, and consistent across 
the top chord of a truss. 

Bottom Chord Live – This figure represents weight that is produced by the use and occupancy of a 
building, as it applies to the bottom chord of trusses. 

Figure 67: The Standard/Auto Loads tab in Engineering/Design Presets. 
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Bottom Chord Dead – This figure represents weight that is permanent, unmoving, and consistent 
across the bottom chord of a truss. 

Spacing – This field is used to define the default distance between trusses. 

10* – When this checkbox is activated, GS Truss adds a new, non-concurrent, live load case that 
applies 10 pounds per square foot to the bottom chord of trusses. 

Roof Purlin Spacing 
Top Chord – The Top Chord field is used to specify the distance between horizontal bracing 
components that connect neighboring trusses on their top chords.  Users may elect to type in a 
dimension for the on-center spacing of purlins, or they may select one of the following two options 
from the drop-down list: 

 Sheathed – Rather than using purlins, bracing is provided solely by the layer of sheathing 
materials applied to the top chord. 

 Sparse – With Sparse bracing, purlins are placed within 6" of each panel point. 

Bottom Chord – The Bottom Chord field is used to specify the distance between horizontal bracing 
components that connect neighboring trusses on their bottom chords.  Users may elect to type in a 
dimension for the on-center spacing of purlins, or they may select one of the following two options 
from the drop-down list: 

 Sheathed – Rather than using purlins, bracing is provided solely by the layer of sheathing 
materials applied to the bottom chord. 

 Sparse – With Sparse bracing, purlins are placed within 6" of each panel point. 

Building Standard Loads 
The fields of the Building Standard Loads section of the Standard/Auto Loads tab are populated with 
values pulled from the most recent GS Plan ITR file to be opened within GS Truss.  The values 
entered into these fields cannot be edited directly by the user. 

Top Chord Live – This figure represents weight that is produced by the use and occupancy of a 
building, as it applies to the top chords of trusses. 

Top Chord Dead – This figure represents weight that is permanent, unmoving, and consistent across 
the top chord of a truss. 

Bottom Chord Live – This figure represents weight that is produced by 
the use and occupancy of a building, as it applies to the bottom chord of 
trusses. 

Bottom Chord Dead – This figure represents weight that is permanent, 
unmoving, and consistent across the bottom chord of trusses. 

Std Trib Width – The Standard Tributary Width field holds the default 
value for that area of a roof where a load acts on the truss immediately 
below it.  Tributary Width includes the width of the given truss, plus half 
the distance to the adjoining trusses on either side of it.  (See Figure 68 at 
right.) 

  

Figure 68: Tributary width 
shown here in yellow. 
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Command Buttons 
The command buttons at the bottom of the Standard/Auto Loads tab allow users to save preset 
changes permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

ROOF LIVE LOADS TAB 

This tab is used to define the Building Code to be provisioned for Roof Live Loads, as well as the default 
values for the Slope and Supported Area to which those loads will be applied. 

Apply 
automated 
roof live load 
adjustments – 
When this 
checkbox is 
activated, roof 
live loads are 
adjusted 
automatically in 
accord with the 
other settings 
on this tab. 

Roof Live Load 
Provisions – 
This read-only 
field displays 
the building 
code currently 
being used to 
calculate roof 
live loads.  The 
value for this field  
is defined using the Building Code drop-down list found on the Design tab. 

Figure 69: The Roof Live Loads tab in Engineering/Design Presets. 



 

54 

 

Slope – This field is used to manually enter the roof slope used for roof-live-load-adjustment 
calculations.  Alternatively, users may activate the Determine from Truss Geometry checkbox to have 
GS Truss calculate the roof slope automatically. 

 Determine from Truss Geometry – If this checkbox is activated, the Slope field is grayed out 
and cannot be edited.  GS Truss will calculate the roof slope based on the existing truss 
geometry.  If this checkbox is not activated, the user must manually enter a value in the 
Slope field. 

Supported Area – This field is used to manually enter the Supported Area used for roof-live-load-
adjustment calculations.  (The Supported Area is equal to the tributary width multiplied by the total 
span of trusses.)  Alternatively, users may activate the Determine from Truss Geometry checkbox to 
have GS Truss calculate the Supported Area automatically. 

 Determine from Truss Geometry – If this checkbox is activated, the Supported Area field is 
grayed out and cannot be edited manually.  GS Truss will calculate the Supported Area based 
upon the length of the truss and the defined spacing between trusses.  If this checkbox is 
not activated, the user must manually enter a value in the Supported Area field. 

Command Buttons 
Details – Clicking on the Details command button opens 
a log window like the one pictured at right.  This window 
displays the actual formulas used by GS Truss to adjust 
roof-live-load calculations.  The user must have a truss 
file open in order for this command button to be 
enabled and available. 

Save to System – To save your changes to the Roof Live 
Load settings permanently (as the new system defaults), 
click on the Save to System button. 

Restore – To discard your changes and return to the 
previously defined default settings, click on the Restore 
button. 

OK – To save your changes temporarily, without 
overwriting the previously defined defaults, click on the OK button.  This will apply your preset 
changes to the active truss file.  When you are done with your temporary changes, click on the 
Restore button to reinstate the previously defined default settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

  

Figure 70: Roof Live Load Calculation Details Log. 
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SNOW LOADS TAB 

The Snow Loads tab is used to define the building code to be provisioned for snow loads, as well as such 
things as building, terrain, and exposure categories, thermal conditions, ventilation, and roof-surface 
types. 

Apply Snow 
Loads – When 
this checkbox is 
activated, snow 
loads will be 
applied to your 
trusses. 

Snow Load 
Provisions – 
The Snow Load 
Provisions drop-
down list is 
used to define 
the version of 
ASCE7 to be 
referenced for 
snow loads.  
The potential 
values are:  

ASCE7-02 
ASCE7-05 
ASCE7-10 

Note that changes to the value listed here are mirrored in the Wind Load Provisions field on the 
Wind Loads tab. 

Ground Snow Load – This field is used to define the default value for the collective weight of snow 
fallen to the ground.  Users may select a value from 0 psf to 100 psf in the drop-down list, or type in 
a value of their own choosing. 

Terrain Category – The Terrain Category drop-down list defines the topography of the area in which 
construction is to take place.  There are three potential values: 

 B – Farmland with boundary hedges, occasional small farm structures, houses, or trees. 

 C – Suburban or industrial areas, or permanent forest. 

 D – Urban areas in which at least 15% of the terrain is covered by buildings with mean  
       heights above 15 meters. 

  

Figure 71: The Snow Loads tab in Engineering/Design Presets. 
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Exposure Category – The Exposure Category drop-down list defines the degree to which a building 
or structure is exposed to elemental forces such as wind, rain, and snow.  The three potential values 
are: 

 Fully Exposed – A building or structure that is entirely subjected to elemental forces. 

 Partially Exposed – A building that is partly subjected to, and partly sheltered from, 
elemental forces. 

 Sheltered – A building that is entirely protected from elemental forces. 

Thermal Condition – The Thermal Condition drop-down list defines the predominant temperature 
conditions for a roof.  There are four potential values: 

 Cold ventilated roof – A structure in which the thermal resistance (R-value) between the 
ventilated space and the heated space exceeds 25° F x h x ft2/Btu (4.4 K x m2/W). 

 Unheated – Includes both unheated structures and structures intentionally kept below 
freezing. 

 Greenhouses – A continuously heated greenhouse with a roof having a thermal resistance 
(R-value) less than 2.0° F x h x ft2/Btu (0.4 K x m2/W). 

 All Others – All with structures with roofs that do not meet the criteria of any of the 
categories listed above. 

Building Category – The Building Category drop-down list is used to define the anticipated human-
population density of a structure.  Values include: 

 I (I = 0.8) – Category I is the classification used for buildings with little to no human 
occupancy.  If there is human occupancy, it is only for a very short time; mainly just long 
enough to store things or to tend to livestock. 

 II (I = 1.0) – Category II is the most commonly used Building Category.  It includes most 
residential buildings, hotels, restaurants, public buildings, and all other dwellings not 
classified in Category I. 

 III (I = 1.1) – Category III is intended for buildings that represent a substantial hazard to 
human life in the event of failure.  This category includes buildings where more than 300 
people congregate, day care facilities, schools, jails and detention facilities, power 
generating stations, and other public utility facilities not included in Category IV. 

 IV (I = 1.2) – Category IV represents essential facilities.  These buildings include: hospitals; 
fire, rescue, ambulance, and police stations; designated earthquake, hurricane, and other 
emergency shelters; and buildings containing extremely hazardous materials. 

Note that changes to the value listed here are mirrored in the Building Category field on the Wind 
Loads tab. 

Apply Ice Dam Loads to Overhangs – When this checkbox is activated, GS Truss applies additional 
loads to overhangs. 

Ventilation – The ventilation drop-down list defines the default air-circulation mechanism for a roof.  
Values include: 

 Ventilated 
 Unventilated 
 Unknown 
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Roof R-Value – The Roof R-Value drop-down list defines a roof’s measure of thermal resistance.  
Under uniform conditions, this is the ratio of the temperature difference across an insulator and the 
heat flux.  There are numerous values from which to choose. 

Roof Slope – The Roof Slope field is used to enter the default roof slope manually.  Alternatively, 
users may activate the Determine from Truss Geometry checkbox to have GS Truss calculate the roof 
slope automatically. 

 Determine from Truss Geometry – If this checkbox is activated, the Roof Slope field is 
grayed out and cannot be edited.  GS Truss will calculate the roof slope based on the 
existing truss geometry.  If this checkbox is not activated, the user must manually enter a 
value in the Roof Slope field. 

[Other] 
Surface Type – The Surface Type drop-down list has two potential values: 

 Unobstructed slippery surface – The standard, common roof surface. 

 All Others – A non-standard roof surface.  (For example, a roof with parapet walls.) 

Command Buttons 
The command buttons at the bottom of the Snow Loads tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

       WARNING!  When you make changes to presets, once you click on the Save to System  
        button, clicking on either the Restore or Cancel buttons will not reinstate previous settings. 
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WIND LOADS TAB 

GS Truss adds automated wind loads to each truss, based on the values entered on the Wind Loads tab.  
Each wind-load case is calculated in accordance with ASCE7 building codes.  In all, seven load cases are 
calculated.  Wind Loads are applied to the entire truss clockwise, from the left to the right bearing. 

Apply Wind 
Loads – When 
this checkbox is 
activated, wind 
loads are 
applied to 
trusses. 

Wind Load 
Provisions:  The 
Wind Load 
Provisions drop-
down list is 
used to define 
the version of 
ASCE7 to be 
referenced for 
wind loads.  
The potential 
values are:  
 ASCE7 – 02 
 ASCE7 – 05 
 ASCE7 – 10 

Note that changes to the value listed here are mirrored in the Snow Load Provisions field on the 
Snow Loads tab. 

Basic Wind Speed – The Basic Wind Speed drop-down list is used to define the default wind speed.  
Listed values range from 85 mph to 200 mph (in five mile-per-hour increments), or users may elect 
to type in a value of their own choosing. 

Exposure Category:  The Exposure Category drop-down list defines the degree to which a building or 
structure is exposed to elemental forces.  The three potential values are: 

 B – Urban and suburban areas, wooded areas, or other terrain with numerous, closely 
spaced obstructions, having the size of single-family dwellings or larger. 

 C – Open terrain with scattered obstructions, including surface undulations or other 
irregularities, having heights generally less than 30 feet and extending more than 1,500 feet 
from the building site in any quadrant.  This category includes flat open country, grasslands, 
and shorelines in hurricane prone regions. 

 D – Flat, unobstructed areas exposed to wind flowing over open water (excluding shorelines 
in hurricane prone regions) for a distance of at least one mile.  This exposure applies only to 
those buildings and other structures exposed to the wind coming from over the water.  
Exposure D extends inland from the shoreline a distance of 1500 feet, or 10 times the height 
of the building or structure, whichever is greater. 

Figure 72: The Wind Loads tab in Engineering/Design Presets. 
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Building Category – The Building Category drop-down list is used to define the anticipated human-
population density for a structure.  Values include: 

 I – Category I is the classification used for buildings with little to no human occupancy.  If 
there is human occupancy, it is only for a very short time; mainly just long enough to store 
things or to tend to livestock. 

 II – Category II is the most commonly used Building Category.  It includes most residential 
buildings, hotels, restaurants, public buildings, and all other dwellings not classified in 
Category I. 

 III – Category III is intended for buildings that represent a substantial hazard to human life in 
the event of failure.  This category includes buildings where more than 300 people 
congregate, day care facilities, schools, jails and detention facilities, power generating 
stations, and other public utility facilities not included in Category IV. 

 IV – Category IV represents essential facilities.  These buildings include: hospitals; fire, 
rescue, ambulance, and police stations; designated earthquake, hurricane, and other 
emergency shelters; and buildings containing extremely hazardous materials. 

Note that changes to the value listed here are mirrored in the Building Category field on the Snow 
Loads tab. 

Mean Roof Ht – This field is used to define the value for the average height of a building’s roof. 

Roof Type – The Roof Type drop-down list defines the default roof profile.  There are three potential 
values: 

 Gable/Hip – A standard gable and/or hip-end roof. 

 Mono-Slope – A roof with a single, sloping plane. 

 Multi-Span – A roof, generally with a modest pitch, that extends 
over multiple adjoining structures. 

Hurricane Prone Region – When this checkbox is activated, GS Truss increases 
wind loads for certain building categories and locations.  In addition, GS Truss adds hurricane 
notation to all truss drawings. 

Apply Wind Loads on End Webs – If the end webs of your trusses are tall and placed on the exterior 
side of a building, the Left and Right checkboxes presented here should be activated.  This will apply 
additional wind loads to test their strength. 

Overall Building Plan Dimensions 
Perpendicular to wind (B) – The dimension of a structure that  
runs perpendicular to the normal wind direction.  (See Figure 73  
at right.) 

Parallel to wind (L) – The dimension of a structure that runs parallel to 
the normal wind direction.  (See Figure 73 at right.) 

  

     Gable            Hip          Mono 

Multi-span. 

Figure 73: Dimensions Perpendic-
ular (B) and Parallel (L) to wind. 
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[Other]  
End Zone Truss – When this checkbox is activated, GS Truss applies additional 
wind pressures to trusses within the End Zone of a roof.  (See Figure 74 at 
right.) 

Enclosure Classification – The Enclosure Classification drop-down list is used 
to identify the internal pressures on a structure, as a function of the  
magnitude and location of openings around the building envelope that allow 
air to flow through the building.  The three potential values are: 

 Full – All structures which do not qualify under the definitions of either Open or Partial 
enclosure. 

 Partial – A structure in which the total area of openings in walls receiving positive external 
pressure:  1) exceeds the total area of openings in the remaining building envelope by more 
than 10%, and 2) exceeds the lesser of 4ft2 or 1% of the area of those walls. 

 Open – A structure in which each wall is at least 80% open. 

CC Zone Width (a) – The Components and Cladding Zone Width is an un-editable field, the value of 
which is calculated based on the ASCE7 description of the relevant components and cladding.  GS 
Truss calculates this value using the Mean Roof Height and the Overall Building Plan Dimensions. 

Command Buttons 
The command buttons at the bottom of the Wind Loads tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

  

Figure 74: End Zone Trusses 
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MATERIAL LIMITS TAB 

The Material Limits tab is used to define restrictions on the use of open shapes and 22-gauge steel, as 
well as bumping rules for when overhang limits have been exceeded.  

No Open Shapes on 
Multi-Ply Girder 
Trusses – When this 
checkbox is 
activated, GS Truss 
prohibits the use of 
open-shaped webs 
and chords in the 
design of multi-ply 
girder trusses. 

Bump Material if 
Overhang Limit 
Exceeded – The 
overhang limit for 
each material is 
defined in the 
Material Database.  
If this checkbox is 
activated, when this 
limit is exceeded, GS Truss bumps the material. 

No 22 Gauge Top Chords – When this checkbox is activated, GS Truss prohibits the use of 22-gauge steel 
in the construction of top chords. 

Command Buttons 
The command buttons at the bottom of the Material Limits tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save to 
System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on the 
OK button.  This will apply your preset changes to the active truss file.  When you are done with your 
temporary changes, click on the Restore button to reinstate the previously defined default settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

        WARNING! When you make changes to presets, once you click on the Save to System button 
          clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

  

Figure 75: The Material Limits tab in Engineering/Design Presets. 
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DEFLECTION TAB 

The Deflection tab defines the measures used for deflection load testing.  In order to pass the 
analysis/design process, deflection values must be less than the calculated values listed on this tab.  
Acceptable calculated values can be represented by the formula D < L/x where D = Deflection, L = the 
length of the specified truss member, and x = a value supplied by a specific building code. 

Deflection Criteria 
ROOF 

Live Load – The 
building-code-
supplied deflection 
limit for roof live 
loads. 

Total Load – The 
building-code-
supplied deflection 
limit for total roof 
loads. 

Cantilever – The 
building-code-
supplied deflection 
limit for roof 
cantilevers. 

Overhang – The 
building-code-
supplied deflection 
limit for roof overhangs. 

FLOOR 

Live Load – The building-code-supplied deflection limit for floor live loads. 

Total Load – The building-code-supplied deflection limit for total floor loads. 

Cantilever – The building-code-supplied deflection limit for floor cantilevers. 

Overhang – The building-code-supplied deflection limit for floor overhangs. 

Miscellaneous 
Webs – The building-code-supplied deflection limit for webs. 

Command Buttons 
The command buttons at the bottom of the Deflection tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save to 
System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

Figure 76: The Deflection tab in Engineering/Design Presets. 
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OK – To save your changes temporarily, without overwriting the previously defined defaults, click on the 
OK button.  This will apply your preset changes to the active truss file.  When you are done with your 
temporary changes, click on the Restore button to reinstate the previously defined default settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

FASTENERS TAB 

The Fasteners tab is 
used to specify the 
minimum number of 
fasteners to be used 
for various member 
types, as well as the 
maximum number of 
screws to be used in a 
line perpendicular to 
the member axis. 

Standard Fasteners – 
The Standard 
Fasteners drop-down 
provides a list of all 
fasteners in the 
Material Database.  
The fastener selected 
here will be used as 
the default in the 
design of your trusses. 

Minimum Number of Fasteners 
Structural Member – This field defines the minimum number of fasteners to be used on the structural 
members of a truss. 

Structural Gable Block End – This field specifies the minimum number of fasteners to be used on each 
end of the vertical blocks that are inserted at the ends of a gable truss. 

Tension Rupture Calc Override 
Maximum number of screws in a line perpendicular to the member axis – Placing numerous screw 
holes in a straight line along a truss member can substantially weaken that member.  To avoid this 
problem, this field defines the maximum number of screws that can be used in a straight line on any 
given member. 
  

Figure 77: The Fasteners tab in Engineering/Design Presets. 
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Command Buttons 
The command buttons at the bottom of the Fasteners tab allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save to 
System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on the 
OK button.  This will apply your preset changes to the active truss file.  When you are done with your 
temporary changes, click on the Restore button to reinstate the previously defined default settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 
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Roof Auto Web Presets 
When creating a roof truss, selecting Presets → Auto Web from the GS Truss menu bar opens the Auto 
Web dialog box pictured below.  This dialog box is used to control the automated layout of webbing on 
roof trusses.  

Max TC Panel 
Length – This 
field defines the 
maximum length 
for a top chord 
panel. 

Max TC Girder 
Panel Length – 
This field defines 
the maximum length for a top chord panel on a girder truss. 

Fixed TC Heel Panel Length – This field establishes a fixed length for a top chord heel panel. 

Max BC Panel Length – This field defines the maximum length for a bottom chord panel. 

Max BC Girder Panel Length – This field defines the maximum length for a bottom chord panel on a 
girder truss. 

Max Heel Height for Fixed Heel Panel – When the Maximum Heel Height value entered here is 
exceeded, then the Fixed Top Chord Heel Panel Length is ignored and GS Truss uses the Maximum 
Top Chord Panel Length instead. 

Min Distance between Nodes – Used to avoid any overlapping members, this field defines the 
minimum distance between nodes. 

Max Seatcut w/o Diag Heel Web – When the value entered here for the maximum allowable length 
of a Seatcut is exceeded, GS Truss adds diagonal-heel webs to the truss. 

Min End Web Height for K-Web – When the height of an end-web exceeds the value entered here, 
GS Truss inserts a K-web into the truss. 

GIRDER WEB STYLE 

The Girder Web Style radio buttons define the default webbing pattern to be used for roof trusses.  The 
two potential values are Howe and Pratt: 

VERTICAL WEB 

At Pitch Breaks – When this checkbox is activated, GS Truss automatically inserts a vertical web at 
all pitch breaks. 

At Internal Bearings – When this checkbox is activated, vertical webs are automatically inserted 
over all internal bearings. 

Figure 78: The Roof Auto Web Presets dialog box. 

Pratt webbing Figure 79:      Howe webbing 
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At Point Loads – When this checkbox is activated, vertical webs are added to all areas of the truss 
supporting point loads. 

       WARNING!  If bearings or panel points are added to a truss after the Auto Web function has  
         run, then you will need to re-run Auto Web in order to have GS Truss add vertical webs over  
       the newly created bearing locations and/or panel points. 

COMMAND BUTTONS 

The command buttons at the bottom of the Roof Auto Web dialog box allow users to save preset 
changes permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 
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Floor Auto Web Presets 
When creating a floor truss, selecting Presets → Auto Web from the GS Truss menu bar opens the 
System PCT Autoweb Presets dialog box pictured below.  This dialog box is used to control the 
automated layout of webbing on floor trusses.  

Standard Panel 
Length – This field 
defines the 
default length for 
typical floor-truss 
panels. 

Web Pattern – The Web Pattern drop-down list defines the default configuration of webs within 
floor trusses.  The three potential values are Warren, Fan, and Howe:  

Odd Web Condition – The Odd Web Condition drop-down list establishes the protocol to be used by 
GS Truss when standard webbing techniques would result in an odd or uneven distribution of web 
lengths.  There are two potential values: 

  Auto – When the Auto option is selected, GS Truss will add a single odd web to the truss, if 
doing so does not result in either:  A) a web with an angle that is too steep to be structurally 
sound, or B) a panel that is too short to accommodate its webbing. 

 Even – When the Even option is selected, GS Truss adds or subtracts space between webs, 
evenly across the entire length of the truss.  

Web Right to Left – When this checkbox is activated, GS Truss webs trusses from right to left, rather 
than from left to right. 

Verticals at Internal Bearings – When this checkbox is activated, vertical webs are placed over all 
internal bearings supporting the truss. 

Verticals at Point Loads – When this checkbox is activated, GS Truss adds vertical webs to all areas 
of the truss supporting point loads. 

         NOTE! If bearings or panel points are added to a truss after the Auto Web function has run,  
         then you will need to re-run Auto Web in order to have GS Truss add vertical webs over  
    the newly created bearing locations and/or panel points. 

COMMAND BUTTONS 

The command buttons at the bottom of the Floor Auto Web dialog box allow users to save preset 
changes permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Figure 80: The Floor Auto Web Presets dialog box. 

Figure 81:          Warren                                                              Fan                                                              Howe 
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Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 

Gable Web Presets  
Gable Web Presets are used to control the automated layout of blocks on gable trusses. 

BLOCKING 

Direction – The 
Direction drop-down 
list defines the 
orientation of 
blocking within a 
truss.  The three 
potential values are: 

 Ends In – Blocking starts at each end of the truss and meets in the middle. 

 Center Out – Blocking begins at the center of the truss and works out toward the ends. 

 Dimension Out – Blocking begins at a set point and works out toward the ends of the truss. 

Start Dim – The Start Dimension field identifies the location where blocking is to begin.  This field is 
only active if Dimension Out is selected as the Blocking Direction.  

Spacing – The Spacing field is used to define the distance between the center lines of vertical webs. 

Min Block Len – The Minimum Block Length field defines the minimum allowable length of vertical 
web blocks. 

Block Width – This field defines the width of the blocks to be used within a truss. 

DROP TOP 

If the gable is to have a drop top (to allow for outlookers), then a Drop Dimension can be defined. 

Drop Dim – The Drop Dimension field is used to define the distance that the top of the gable is to be 
lowered, measured perpendicular to the slope. 

Drop – When clicked, the Drop command button implements the value specified in the adjoining 
Drop Dimension field. 

Figure 82: The Gable Web Presets dialog box. 
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VENT 

Type – This drop-down list defines the type of vent to be accommodated by a gable truss.  The two 
potential values are None and Rectangular. 

Width – The Width field is used to define the horizontal dimension of a vent to be included in the 
gable.  (Note: This field is only enabled when Rectangular has been specified as the value in the Type 
field described above.) 

[OTHER] 

Force Block at Pitch Breaks – When this checkbox is activated, GS Truss forces the insertion of a 
vertical web at all pitch breaks. 

COMMAND BUTTONS 

The command buttons at the bottom of the Gable Web dialog box allow users to save preset changes 
permanently or temporarily, or to discard changes altogether. 

Save to System – To save your changes permanently (as the new system defaults), click on the Save 
to System button. 

Restore – To discard your changes and return to the previously defined default settings, click on the 
Restore button. 

OK – To save your changes temporarily, without overwriting the previously defined defaults, click on 
the OK button.  This will apply your preset changes to the active truss file.  When you are done with 
your temporary changes, click on the Restore button to reinstate the previously defined default 
settings. 

Cancel – To discard your changes altogether, without affecting the settings for either new or existing 
truss files, click on the Cancel button. 

      WARNING! When you make changes to presets, once you click on the Save to System button 
         clicking on either the Restore or Cancel buttons will not reinstate the previous settings. 
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WORKING WITH FILES IN GS TRUSS 
Understanding File Types & Functions 
There are just two file types that are native to GS Truss: 

 KTC – Files with the KTC extension contain truss-to-truss connection  
(TTC) information that defines the specific relationship between carried 
trusses and their carrying trusses.  The contents of KTC files can be 
edited directly within the GS Truss interface.  GS Truss uses the 
following icon to represent KTC files in the Projects window:    

 KTS – GS Truss generates files with a KTS extension whenever an 
imported or newly created truss is saved.  KTS files contain all of the 
information required for truss outputs and production.  GS Truss uses 
the following icon to represent KTS files in the Projects window:   

In addition to its own native file types, GS Truss is able to import the three truss 
file types that can be created in GS Plan: 

 LDG – A GS Plan truss-to-truss connection (TTC) file.  GS Truss uses the 
following icon to represent LDG files in the Projects window:   

 ITR – A GS Plan roof truss file.  GS Truss uses the following icon to 
represent ITR files in the Projects window:   

 ITF – A GS Plan floor truss file.  GS Truss uses the following icon to represent ITF files in the 
Projects window:   

Opening Existing Files 
There are five different ways to open existing truss files in GS Truss, regardless of whether they were 
originally created in GS Truss or GS Plan: 

1. Begin by clicking on the Open icon on the Main toolbar.  
Follow the instructions listed under “Using the ‘Open’ Dialog 
Box” on page 71. 

2. From the File menu, select File → Open, as pictured in the  
figure at right.  Follow the instructions listed under “Using the 
‘Open’ Dialog Box” on page 71. 

3. Click on a recently accessed file from the File menu, as 
pictured in Figure 84 at right. 

4. In the Projects window, double-click on the file you wish to 
open. 

5. In the Projects window, right click on the file you want, and  
select Open from the context menu. 

  

Figure 83: Truss files display-
ed in the Projects window. 
 

Figure 84: The Open command and 
recently opened files available on the 
File menu. 
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Figure 85: The GS Truss Open dialog box allows users to select a file to open. 

Using the ‘Open’ Dialog Box 
Opening files using either method 1 or 2 listed on the previous page will pull up the GS Truss Open 
dialog box pictured in Figure 85.  As can be seen in Figure 85, the GS Truss Open dialog box has a 
number of components: 

A. Job Name – The 
name of the job 
currently selected 
in the Job List 
section of the Open 
dialog box. 

B. Root Path – The full 
path to the 
directory in which 
job folders and 
truss files are 
stored. 

C. File Name – The 
name of the file 
currently selected 
in the Truss List 
section of the Open 
dialog box. 

D. File Types – A drop-
down list of truss-related file types that are searchable within the interface.  The potential 
values include: *.kts, *.itr/*.ltf, *.ttc, *.ldg, and *.*.  (This last value is used to search all file 
types.)  For more information about these file types, see the section on the preceding page 
entitled “Understanding File Types & Functions.” 

E. Job List – A list of existing GS Truss jobs that can be searched for truss files.  The Job List is 
automatically populated with the names of user-created subfolders within the Jobs directory.2   

F. Truss List – Displays a list of all truss and truss-connection files stored within the currently 
selected job.  To open a file you can either double click on the file name within the Truss List, or 
click once on the file to select it and then click on the OK button.  

         NOTE!  GS Truss does not currently support the selection of multiple files from within  
         the Open dialog box. 

G. List button – When this button is clicked, the Truss List only displays the name of truss-related 
files; file creation and modification dates, and file-status fields are all hidden from view. 

H. Details button – When this button is clicked, in addition to the file name, the Truss List displays 
the creation date, last-modified date, and current status information (Passed, Failed, or 
Unlocked) of truss files. 

  

                                                             
2 Users may specify a different directory to store job folders and truss files, via System Presets. 
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Now that we 
have introduce-
ed the Open 
dialog box, it is 
perhaps some-
what ironic to 
say that you are 
not likely to use 
it very often.  
That is because, 
generally 
speaking, the 
quickest and 
easiest way to 
open files in GS 
Truss is simply 
to double-click 
on them from 
within the 
Projects 
window. 

Working with GS Plan Files 
When GS Truss is used to open truss files created in GS Plan, GS Truss automatically creates an 
equivalent file type in its own native format.  GS Truss KTC files are created to replace GS Plan LDG 
files.  GS Truss KTS files are created to replace GS Plan ITR and ITF files.  Put in other words, users 
cannot work directly with GS Plan files in GS Truss.  The only function GS Plan files serve within GS 
Truss is to provide the foundation information required for GS Truss to generate its own KTS and KTC 
file equivalents.  The original GS Plan files are unchanged and unharmed during this process. 

          TIP!  GS Plan’s ITR and ITF files provide GS Truss with truss-profile information, along with  
          some bearing and loading data.  Webbing, bracing, and other internal design functions are  
          added by GS Truss automatically, once the profile has been imported.   

There are basically two ways to generate GS Truss versions of your GS Plan truss 
files; one truss at a time, or collectively, as a batch.  GS Plan floor (ITF) and roof 
(ITR) truss files can be converted one file at a time by double-clicking on them in 
the Projects window.  

To create GS Truss files as a batch, double click on a GS Plan LDG file.  GS Truss 
will step through the process of creating trusses, one at a time, until the entire 
batch has been processed.  The specific process GS Truss will execute to create 
these truss files will depend upon the user’s preset settings.  (For more 
information about presets, refer to the section within this document entitled 
“Working with GS Truss Presets.”)   

Figure 86: The easiest way to open truss files is to double-click on them from within the Projects window. 

Figure 87: Double click on 
GS Plan files to create GS 
Truss equivalents. 
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If there are issues with one or more ITR/ITF files being 
converted to KTS format, users will receive an error 
message like the one pictured at right.  Identified issues 
must be resolved before a GS Truss file can be generated. 

 
 
 
If you double click on a GS Plan ITR or ITF file for which a 
GS Truss equivalent has already been generated, a 
message box like the one pictured in Figure 89 will open. 
 

 
If you double click on a GS Plan LDG file that has already 
been imported, a message box like the one pictured in 
Figure 90 will open.  Clicking on the Yes button will 
continue the import process, and the previously 
imported version of your GS Truss files will be 
overwritten.  

Making GS Plan Files Visible 
If you can see GS Truss KTC and 
KTS files in the Projects window, 
and you want, but are unable, to 
view their GS Plan counterparts, 
you will need to change one of 
the settings in your GS Truss 
presets.  To begin, go to the GS 
Truss menu bar and select Presets 
→ System.  On the Runtime tab of 
the System Presets dialog box, 
click in the checkbox entitled 
Show IT* file even if the KT* file is 
present.  (See Figure 91.)  Once 
this checkbox has been activated, 
you will be able to view all GS 
Plan truss file types from within 
the Projects window, even after 
GS Truss has created equivalent 
files in its own, native  
format. 
 
  

Figure 88: Resolve errors to complete the 
conversion process. 

Figure 89: Choose whether not to replace the 
existing file. 

Figure 90: Choose whether not to delete previously 
imported files. 

Figure 91: Click in this highlighted checkbox to make GS Plan files visible in the GS 
Truss Projects window, even after importing has completed. 
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Identifying File Properties 
You may wish to view details about a given truss file, 
beyond those provided in the Projects window or the 
Open dialog box.  To view a file’s property details, right-
click on the file in the Projects window and select 
Properties from the context menu.  A Properties window 
like the one pictured at right will open.  Here is a brief 
description of the information provided: 

File name – The name of the file associated with your 
truss.  Notice that the file name includes the file’s 
three-letter extension, identifying the type of file that 
it is. 

Location – The full directory path to where the truss 
file is stored. 

Status – The current status of the truss.  Potential 
values include: Passed, Failed, and Unlocked.  The 
Status of KTC files is listed as Unknown. 

Material – The name of the Material Database used to construct the truss.  For KTC files, the 
Material is listed as Unknown. 

Created – A date-time stamp that shows when the file was created. 

Modified – A date-time stamp that shows when the file was last modified. 

[Diagram] – A diagram of the given truss, when applicable.  For truss-to-truss-connection (TTC) files, 
this section is blank. 

Deleting Truss Files 
To delete a GS Truss or GS Plan truss file from the Projects window, right-click on the file and select 
Delete from the context menu.  Here are a few tips to remember: 

 If you delete a KTC or KTS file that has been generated by importing its GS Plan file equivalent, 
the KTC/KTS file will be sent to the Windows Recycle Bin and its equivalent ITR/ITF file will be 
reopened in the Projects window to take its place. 

 If a user attempts to delete a file from the Projects 
window while the file is open, an error message like 
the one pictured at right will open.  Click on the OK 
button and then close the file before attempting to 
delete it once again. 

  

Figure 92: Truss file properties. 

Figure 93: Open files cannot be deleted. 
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CREATING A TRUSS FROM SCRATCH 
          TIP! Before creating new trusses, be sure to define your GS Truss presets. For information,  
           refer to the section within this document entitled “Working with GS Truss Presets.” 

Creating a New Roof Truss 
Within GS Truss, there are four different ways to begin creating a new roof truss: 

1. Click directly on the New icon on the Main toolbar. 

2. Click on the drop-down arrow next to the New icon on the 
Main toolbar and select New Roof Truss.  (See Figure 94 at 
right.) 

3. Click on File on the menu bar and select New Roof Truss.  

4. Press Ctrl+N on your keyboard. 

Regardless of the method used, GS Truss opens a blank design field in the Main Screen, along with the 
Job bar pictured in Figure 96 on the following page.  To continue with the design of your new roof truss, 
skip to the section on the following page entitled “The GS Truss Job Bar.” 

Creating a New Floor Truss 
As with roof trusses, there are several ways a user can go about creating a new floor truss: 

1. Click on the New icon drop-down arrow on the Main toolbar and select New Floor Truss. 

2. Click on File on the menu bar and select New Floor Truss. 

3. Press Ctrl+F on your keyboard. 

As soon as you have executed one of these procedures, a New Floor 
Truss dialog box (like the one pictured at right) will appear on your 
screen.  Enter a Span for the new truss.  The Depth field is automatically 
populated with the Floor Trusses Default Depth value entered in your 
Geometry Presets.  If you wish to specify a different depth for your floor 
truss, this is the time and place to do so.  If you want your new floor truss 
to be webbed automatically, make sure the Autoweb checkbox is 
enabled. 

Once you have completed entering values into the New Floor Truss 
dialog box, click on the OK button.  GS Truss opens a draft version of 
your truss in the Main Screen, along with a Job bar like the one pictured in Figure 96 on the following 
page.  The next step is to complete the fields in the Job bar. 
  

Figure 94: The New icon drop-down list. 

Figure 95: The New Floor Truss 
dialog box. 
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The GS Truss Job Bar 

The Job bar is used for the input and display of general information about your truss.  The information in 
the Job bar has a direct impact on analysis/design and output processes, so it is important to make sure 
this data is accurate. 

Notice that a number of the fields are blank when the Job bar is first opened.  Other fields are already 
populated with data entered in the user’s GS Truss presets.  Data that appears in black font can be 
edited within the Job bar.  Data in light gray font can only be edited from within the GS Truss presets 
and/or the Oddball and Library windows.  Following is a brief description of the fields in the Job bar and 
the data they contain: 

Job Name – The unique name assigned to a collection of one or more trusses, and used to organize 
trusses into logical groups.  The Job Name can be newly created, or carried over from the GS Plan 
application.  Keymark suggests that jobs be named for the structure, location, or client with which 
the job’s trusses will be associated.  Enter a new Job Name, or select the name of an existing job 
from the Job Name drop-down list. 

Truss Name – Enter a name for the new truss.  Each truss name must be unique within a given job.  
It is suggested that the name given to each truss represent its type and/or its placement within the 
structure.  If a new truss file has not yet been named when the analysis/design process is initiated, 
the user will be prompted to enter a name for the truss at that time. 

         TIP!  Users can copy an existing truss by opening the truss file and typing in a new name for  
         the truss in the Job bar. 

Span – The total length of the truss as measured along the bottom chord.  For new floor trusses, the 
Span field is populated with data entered into the Span field of the New Floor Truss dialog box.  For 
new roof trusses, the initial value is “0-0-0.”  Span data cannot be edited directly within the Job bar, 
but can be edited using either the Library or Oddball tools. 

Pitch –The overall slope of the top chord.  The Pitch field is initially populated with placeholder data 
that cannot be edited directly within the Job bar.  Users can edit data for this field using either the 
Library or Oddball tools. 

Spacing – The distance between trusses.  Initially, data in the Spacing field is populated using 
Engineering/Design Presets information.  Spacing data can be edited directly within the Job bar.  Any 
changes made to the data in this field will take precedence over the user’s Engineering/Design 
Presets. 

TC Live – The pounds per square foot (psf) or kilopascals (kPa) to be applied to the top chord as a 
live (temporary) load during the analysis process.  Initial values for the TC Live field are defined on 
the Standard/Auto Loads tab in Engineering/Design Presets.  Note: This value cannot be edited 
directly in the Job bar if the Roof Live checkbox is enabled on the Job bar, or if the Apply Automated 
Roof Live Loads checkbox is enabled on the Roof Live Loads tab of Engineering/Design Presets. 

Figure 96: The Job bar opens when you elect to create a new roof or floor truss. 
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TC Dead – The pounds per square foot (psf) or kilopascals (kPa) to be applied to the top chord as a 
dead (permanent) load during the analysis process.  Initial values for the TC Dead field are defined 
on the Standard/Auto Loads tab in Engineering/Design Presets.  Data in this field can be edited 
directly within the Job bar. 

BC Live – The pounds per square foot (psf) or kilopascals (kPa) to be applied to the bottom chord as 
a live (temporary) load during the analysis process.  Initial values for the BC Live field are defined on 
the Standard/Auto Loads tab in Engineering/Design Presets.  Data in this field can be edited directly 
within the Job bar. 

BC Dead – The pounds per square foot (psf) or kilopascals (kPa) to be applied to the bottom chord 
as a dead (permanent) load during the analysis process.  Initial values for the BC Dead field are 
defined on the Standard/Auto Loads tab in Engineering/Design Presets.  Data in this field can be 
edited directly within the Job bar. 

TC Purlins – The type of bracing that is to be used for the top chord of the truss.  There are three 
options.  Users can select either Sheathed or Sparse from the drop-down list, or they may elect to 
type in inches for the on-center spacing of purlins.  Default values for the TC Purlins field are defined 
on the Standard/Auto Loads tab in Engineering/Design Presets.  Data in this field can be edited 
directly within the Job bar. 

BC Purlins – The type of bracing that is to be used for the bottom chord of the truss.  There are 
three options.  Users can select either Sheathed or Sparse from the drop-down list, or they may 
elect to type in inches for the on-center spacing of purlins.  Default values for the BC Purlins field are 
defined on the Standard/Auto Loads tab in Engineering/Design Presets.  Data in this field can be 
edited directly within the Job bar. 

Brg Combo – The Bearing Combo drop-down list is used to select one of any number of bearing 
combinations defined using the Bearings tool.  If the user has not defined any custom Bearing 
Combinations, then the Brg Combo drop-down list defaults to “1” and there will be no other entries 
available in the list. 

Plies – The number of trusses to be joined together as a single unit.  Values range from one to four. 

Wgt/Ply – The total calculated weight of a single ply for the given truss.  Values for the Weight per 
Ply field are defined in Material Priority Tables and cannot be modified directly within the Job bar. 

Price/Ply – The total calculated price charged, per ply, for the given truss.  Values for the Price per 
Ply field are defined in Pricing Presets and cannot be modified directly within the Job bar. 

Qty – The number of trusses that are to be manufactured to the specification of the current, active 
truss. 

10* – When this checkbox is enabled, GS Truss adds 10 pounds per square foot to the Bottom Chord 
Live Load during the analysis process.  Whether or not this checkbox is enabled when the Job bar is 
first opened is contingent upon Engineering/Design Presets under the Standard/Auto Loads tab. 

Wind – When this checkbox is enabled, GS Truss adds wind loads defined in the user’s 
Engineering/Design Presets during the analysis/design process. 

Snow – When this checkbox is enabled, GS Truss adds snow loads defined in the user’s 
Engineering/Design Presets during the analysis/design process. 



 

78 

 

Girder – When enabled, this checkbox indicates that the truss is a girder and GS Truss adjusts the 
analysis accordingly. 

Roof Live – When this checkbox is enabled, GS Truss adds calculated Roof Live loads during the 
analysis/design process, based on the parameters defined in the user’s Engineering/Design Presets. 

Roof/Floor – Designates the active file as either a roof truss or a floor truss. 

LEFT/RIGHT 

Heel Height – The length from the top of the top chord through the bottom of the bottom chord on 
both ends of a truss.  Initially, this field is populated with data from the General tab of Geometry 
Presets.  Any changes made to the data in this field will take precedence over the user’s presets. 

Brg Width – The girth of the structure supporting the truss.  Values for Bearing Width are initially 
populated using the Bearing Width settings on the General tab of Geometry Presets.  The Brg Width 
field is used for reference only and values cannot be modified directly in the Job bar. 

Overhang – The length that the top chord is to extend beyond the bottom chord.  Overhang data 
cannot be edited directly within the Job bar, but can be edited using either the Library or Oddball 
tools. 

Cantilever – The dimensions of the projecting structure that extends beyond the face of its carrying 
wall.  Data in this field can be edited directly within the Job bar. 

Creating a Truss in Library Mode 
After filling out the fields in the Job bar, the quickest and easiest way to create a new truss is 
to click on the Library icon on the Geometry toolbar.  This will open a blank design window 
and the Library Input bar pictured in Figure 97 below. 

Like the Job bar, notice that some fields in the Library Input bar are pre-populated with 
presets data while other fields remain blank.  Complete the fields in the Library Input bar as 
follows: 

Span – Enter the total length for the bottom chord of the truss, from bearing to bearing. 

Slope – Enter the pitch for the top chord of the truss. 

Qty – Enter the number of trusses that are to be manufactured to the specification of 
the current, active truss. 

Truss Family – Click on the drop-down arrow and select the Truss Family that best 
matches the profile of the truss to be created.  As pictured at right, there are 24 options 
listed in the Truss Family drop-down list.  Depending on the Truss Family selected, 
additional fields may appear on the Library Input bar for you to complete.  See the 
section entitled “Truss Family Values” on page 80 for a list of the additional fields associated with 
specific truss families. 

Figure 97: The Library Input bar provides for quick and easy truss creation. 

Figure 98: Truss 
Families. 
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Web – The webbing options available in the Web drop-down list depend upon the Truss Family 
selected in the previous field.  Entering the number “99” into this field will Auto Web your truss.  
Entering “00” will result in no webbing added to the truss. 

LEFT/RIGHT 

Heel Height – Enter the measurement from the top of the top chord through the bottom of the 
bottom chord on both ends of the truss. 

Seat Cut – Enter the dimension for the Seat Cut to be placed at the bottom of the truss.  This field is 
grayed out (inapplicable) unless the bottom chord is sloped and, therefore, requires a Seat Cut. 

Overhang – Enter the length of the top-chord Overhang the truss is to include, if any. 

As data is entered into the fields in the Library Input bar, the profile of the truss being created will 
appear in the design window.  Notice that the bottom chord of the truss is represented with a green 
line, while the lines representing the top chord and webbing are in blue and red respectively. 

In addition to lines representing the truss, the design screen includes a host of different numbers as 
pictured in Figure 99 above and explained as follows: 

A – Overhang Length 
B – Heel Height 
C – Slope 
D – Point Number (blue font) 
E – Member Number (black font) 
F – Dimension from Point 2 to Point 3 
G – Cumulative horizontal dimension from Point 1 to Point 4 
H – Overall height of the truss 

Figure 99: Parts of a truss shown in Element View. 



 

80 

 

 
Return to Main – Once you have completed your truss design in Library mode, click on the Return to 
Main button to navigate back to the main GS Truss window. 

Note:  If a user attempts to return to the main GS Truss 
screen with incorrect or inappropriate values entered 
into one or more fields in the Library Input bar, he will 
receive an error message like the one pictured here.  
These issues must be resolved before the user can save 
his work and return to the main screen. 

Truss Family Values 
As mentioned earlier, selection of some truss families in Library Mode pulls up additional fields that 
require user input.  Below is a list of truss families, and the additional input required (if any) for each: 
  

NO. TRUSS NAME SHAPE ADDITIONAL FIELDS 
01 Common  N/A 

02 Scissor  Bottom Chord Slope 

03 Mono  N/A 

04 Mono Scissor  Bottom Chord Slope 

05 Dual Pitch Scissor  Left Bottom Chord Slope; Right Bottom Chord Slope 

06 Type 1 Cathedral  Vault Slope; Horizontal Offset 

07 Type 1 Studio  Vault Slope; Horizontal Offset 

09 Tray  Bottom Chord Slope; Horizontal Offset 

10 Type 2 Cathedral  Vault Slope; Horizontal Offset; Width 

11 Porch  Horizontal Offset; Porch Height 

13 Type 2 Studio  Vault Slope; Horizontal Offset; Width 

14 Gambrel  Upper Top Chord Slope; Horizontal Offset 

15 Attic  Horizontal Offset; Width; Height 

16 Flat Top  Horizontal Offset 

18 Raised Heel  N/A 

19 Box  N/A 

20 Parallel Chord  N/A 

21 Non-Symmetric  Right Top Chord Slope 

23 Half Hip  Horizontal Offset 

24 Partial Scissor  Bottom Chord Slope; Horizontal Offset 

25 Dog Leg  Bottom Chord Slope; Right Plate Drop 

26 Studio Dog Leg  Bottom Chord Slope; Right Plate Drop; Horizontal Offset 

27 Coffered  Horizontal Offset; Width; Vertical Slope 

28 Scissor Dog Leg  Left Bottom Chord Slope; Peak Offset; Bottom Offset 

 

Figure 100: Input bar values must be valid to exit 
Library Mode. 
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Creating or Modifying a Truss in Oddball Mode 
Given its wide selection of truss profiles and webbing options, it is generally recommended that users 
design as much of a truss as possible using Library Mode.  Oddball Mode can then be used to adjust the 
truss geometry to the desired specifications.  That said, however, it is entirely possible to create a truss 
from start to finish using Oddball Mode alone.  Oddball Mode provides a wide array of tools for 
designing non-standard and complex trusses, piece by piece. 

There are two different ways to open Oddball Mode: 

 Go to the Geometry toolbar and click on the Oddball icon. 

 On the menu bar, select File → Geometry → Oddball. 

Depending on your System Presets, and where you are in the truss-design process, Oddball Mode will 
open in one of two different ways: 

 If your System Presets are setup 
appropriately and if you have a blank (new) 
truss design window open, starting Oddball 
opens up the Oddball Startup dialog, pictured at 
right. 

 If you have not enabled the Oddball Startup 
dialog in System Presets, or if you are working 
with an existing truss, the Oddball Startup 
dialog process is bypassed and you are launched 
into full-blown Oddball Mode. 

         TIP!  To enable the Oddball Startup dialog box, go to the menu bar and select File → Presets →   
         System → Runtime tab, and click in the Show Oddball startup dialog checkbox. 

With the exception of the Span field, all fields in the Oddball Startup dialog box are pre-populated with 
user values entered in the Presets → Geometry → General tab.  (See Figure 102 on the following page.)  
Change values in the Oddball Startup dialog box as needed to meet the requirements of the truss you 
wish to create.  When you are done, click on the OK button at the bottom of the dialog to proceed to the 
main Oddball window. 

              NOTE! You cannot reopen the Oddball Startup dialog box once you have exited it. 

 

 

 

 

 

 

 

Figure 101: The Oddball Startup dialog box. 
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The Oddball toolbar contains 25 different icons, which are identified below.  Their use is described in 
detail in the section immediately following.  From left to right, the Oddball toolbar icons are as follows: 

1. Return to Main 
2. Undo 
3. Redo 
4. Point to Point 
5. Point to XY 
6. Horizontal Slope 
7. Vertical Slope 
8. Intersect Member 
9. Slope Intersect 
10. Overhang Member 
11. Off Member Point 
12. On Member Point 
13. Increment/Decrement 

14. Divide Points 
15. Divide Member/Chord 
16. Reverse Web 
17. Shift Point 
18. Shift Slope 
19. Delete Point 
20. Delete Member 
21. Clear Webs 
22. Clear All 
23. Quick Web 
24. Auto Divide 
25. Auto Quick Web 

When using Oddball tools, there are a variety of ways to enter data into the fields associated with each 
tool.  Some fields provide up- and down-arrow buttons users can click on until the desired value 
appears.  Other fields provide a drop-down list from which users can select the desired value or type in 
the number associated with that value.  If a field is used to reference a point number or member 
number, users can simply click on the desired point or member in the design screen, and that number 
will automatically be entered into the field.  Last but not least, users can elect to type the desired value 
into each field.  

         NOTE! Reference point numbers and member numbers will change throughout the design  
         process, as points and members are added to, and deleted from, your drawing. 

    1        2       3       4       5       6       7      8      9     10      11    12     13     14    15      16    17    18      19    20     21    22     23    24     25 

Figure 102: The Oddball dialog fields (pictured at 
left) are pre-populated using values entered in 
Geometry Presets (pictured at right). 
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POINT TO POINT 

Oddball’s Point to Point tool is used to add new chords and webs between existing points on a truss. 

Point 1 – Enter the starting point for the new truss member. 

Point 2 – Enter the end point for the new truss member. 

Member Type – Enter the type of truss member to be created.  The three potential values are: Top 
Chord, Bottom Chord, and Web. 

# of Panels – Enter the number of panel points the new member is to contain.  Panel points will be 
distributed evenly across the length of the newly created truss member. 

POINT TO XY 

The Point to XY tool is used to create a panel point and to add a new chord or web between the new 
point and an existing Reference Point. 

Point # – Enter the point where the new truss member is to begin. 

Ref Point – Enter the number of the panel point from which the dimension measurement is to 
begin. 

X Dimension – Enter the horizontal length the new truss member is to extend beyond the specified 
Reference Point.  Enter a positive number to draw the truss member to the right of the defined 
Reference Point.  Enter a negative number to draw the truss member to the left of the Reference 
Point. 

Y Dimension – Enter the vertical length the new truss member is to extend beyond the specified 
Reference Point.  Enter a positive number to draw the truss member above the Reference Point.  
Enter a negative number to draw the truss member below the Reference Point. 

Member Type – Enter the type of member to be created.  The three potential values are: Top Chord, 
Bottom Chord, and Web. 

# of Panels – Enter the number of panel points the new member is to contain.  Panel points will be 
distributed evenly across the length of the newly created truss member. 
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HORIZONTAL SLOPE 

The Horizontal Slope tool is used to create a new truss member at a defined slope.  The new member 
starts at the point entered into the Point # field, and it extends beyond the Reference Point by the length 
entered into the Dimension field.   

For example, take the bottom chord pictured in Figure 103 below, which has a span of 10 feet.  As can 
be seen by the information entered at the top of Figure 103, a new Top Chord will be created at a 6/12 
slope, starting at Point #3.  The Dimension is set to 5’, so the new Top Chord will extend 5’ beyond 
whatever value is entered as the Reference Point.  Therefore, if Point 3 is used as the Reference Point, 
the resulting Top Chord will be 5’ in length, as pictured in Figure 104.  If, instead, Point 4 is used as the 
Reference Point, the resulting Top Chord is 15’ in length, as pictured in Figure 105. 

 

 

 

 

 

 

 

Figure 103:  This truss is being created with a Bottom Chord that has a 10 foot span. 
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Figure 104:  Drawn from Point 3 with Point 3 as the Reference Point, the resulting Top Chord is 5 feet in length. 

Figure 105:  Drawn from Point 3 with Point 4 as the Reference Point, the resulting Top Chord is 15 feet in length. 
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Point # – Enter the starting point from which the new member is to be drawn. 

Slope – Enter the desired pitch for the new truss member.  For a 45° slope, enter a value of 12/12.  
For a 90° (vertical) pitch, enter a value of 999/12. 

Ref Point – Enter the number of the panel point from which the new truss member will extend by 
the distance entered into the Dimension field.  

Dimension – Enter the length that the new truss member is to extend horizontally beyond the 
specified Reference Point.  Enter a positive number to draw the truss member to the right of the 
defined Reference Point.  Enter a negative number to draw the truss member to the left of the 
Reference Point. 

Member Type – Select the type of truss member to be created.  The three potential values are: Top 
Chord, Bottom Chord, and Web. 

# of Panels – Enter the number of panel points the new member is to contain.  Panel points will be 
distributed evenly across the length of the newly created truss member. 

VERTICAL SLOPE 

Like the Horizontal Slope tool, Oddball’s Vertical Slope tool is used to create new truss members at a 
defined slope.  The length of the new member is calculated by setting a point at the intersection of the 
specified vertical dimension and the specified slope.  For example, if a dimension of 1-0-0 is entered 
along with a slope of 6/12, the system will start one foot vertically above the Reference Point and then 
move across to meet the slope.  It will then draw the member from the starting point to the calculated 
intersection. 

Point # – Enter the point from which the new member is to start. 

Slope – Enter the desired pitch for the new truss member.  For a 45° slope, enter a value of 12/12.  
For a 90° (vertical) pitch, enter a value of 999/12. 

Ref Point – Enter the point from which the vertical dimension will be measured. 

Dimension – Enter the length that the new truss member is to extend vertically beyond the 
specified Reference Point.  Enter a positive number to draw the truss member above the defined 
Reference Point.  Enter a negative number to draw the truss member below the Reference Point. 

Member Type – Enter the type of truss member to be created.  The three potential values are: Top 
Chord, Bottom Chord, and Web. 

# of Panels – Enter the number of panel points the new member is to contain.  Panel points will be 
distributed evenly across the length of the newly created truss member. 
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INTERSECT MEMBER 

Oddball’s Intersect Member tool is used to create a new truss member, at a slope designated by the user 
that will intersect an existing truss member. 

Point # – Enter the point from which the new member is to start. 

Mbr # – Enter the number of the existing member that is to be intersected by the new truss 
member. 

Slope – Enter the pitch at which the new truss member is to intersect the existing member.  For a 
45° slope, enter a value of 12/12.  For a 90° (vertical) pitch, enter a value of 999/12. 

Member Type – Enter the member type to be created.  The three potential values are: Top Chord, 
Bottom Chord, and Web. 

# of Panels – Enter the number of panels the new member is to contain.  Panel points will be 
distributed evenly across the length of the newly created truss member. 

   WARNING! If you enter Slope, Point #, and/or Member # that  
          will result in a failure of the new member to intersect the  
        targeted existing truss member, GS Truss will generate an  
  error message like the one pictured at right. 

SLOPE INTERSECT 

The Slope Intersect tool is used to create two new sloped-truss members that intersect one another. 

Point 1 – Enter the panel point from which the first new member is to start. 

Slope – Enter the desired pitch for the first new truss member.  For a 45° slope, enter a value of 
12/12.  For a 90° (vertical) pitch, enter a value of 999/12. 

Member Type – Enter the Member Type to be used for the first new truss member.  The three 
potential values are: Top Chord, Bottom Chord, and Web. 

# of Panels – Enter the number of panels the first new member is to contain. 

Point 2 – Enter the panel point from which the second new member is to start. 

Slope – Enter the desired pitch for the second new truss member.  For a 45° slope, enter a value of 
12/12.  For a 90° (vertical) pitch, enter a value of 999/12. 

Member Type –Enter the member type to be used for the second new truss member.  The three 
potential values are: Top Chord, Bottom Chord, and Web. 

# of Panels – Enter the number of panels the second new member is to contain.  Panel points will be 
distributed evenly across the length of the newly created truss member. 

Figure 106: Failure to intersect error. 
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       WARNING! For the two slopes to intersect, one slope must be  
          entered as a positive value and the other as negative.  If either  
        positive or negative values are entered for both, the error message 
pictured at right will appear.  

OVERHANG MEMBER 

The Overhang Member tool is used to add overhangs to a truss. 

Point # – Enter the panel point where the overhang is to begin. 

Member # – Enter the number of the truss member which the overhang will extend. 

Dimension – Enter the distance that the overhang is to span.  Enter a positive number to draw the 
overhang to the right of the defined Point #.  Enter a negative number to draw the overhang to the 
left of the Point #. 

Measurement Type – Enter the orientation of the measurement.  Values include:  

 Vertical – The dimension/length of the overhang is calculated vertically from the specified 
Reference Point. 

 Horizontal – The dimension/length of the overhang is calculated horizontally from the 
specified Reference Point. 

 Rake – The dimension/length of the overhang is calculated along the angle of the host truss 
member from which the overhang extends. 

Cut Type – Enter the type of cut to be applied to the overhanging member.  Values include:  

 Plumb – Creates a straight vertical cut at the end of the overhang. 

 Square In – Creates a square cut where the length of the overhang is measured from the 
Point # to the top outside corner at the end of the overhang. 

 Square Out – Creates a square cut where the length of the overhang is measured from the 
Point # to the bottom inside corner at the end of the overhang. 

  

Figure 107: A slope-intersect error. 

Figure 108: Plumb Cut                             Square In                                Square Out 
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NOTE! Even if the length entered into the Dimension field remains the same, the actual length of an 
overhang will vary based upon the Slope of the truss member and the Measurement Type selected.  For 
example, given a slope of 6/12, if 1’ is used as the overhang Dimension, the actual length of the 
overhang will vary by Measurement Type as follows: 

 Horizontal – 1’ overhang 

 Vertical – 2’ overhang 

 Rake – 10 ¾” overhang 

OFF MEMBER POINT 

The Off Member Point tool is used to create a new point based on XY coordinates that are not located 
on an existing truss member. 

Ref Point – Enter the Reference Point that is to serve as the starting location for the dimension 
measurements. 

X Dimension – Enter the horizontal dimension.  Use a positive number if the new point is to fall to 
the right of the specified Reference Point.  Use a negative number if the new point is to fall to the 
left of the Reference Point.   

Y Dimension – Enter the vertical dimension.  Use a positive number if the new point is to fall above 
the specified Reference Point.  Use a negative number if the new point is to fall below the Reference 
Point.   

ON MEMBER POINT 

The On Member Point tool is used to create a new point on an existing truss member.  This tool is 
commonly used to specify points for web connections, or to specify points for bearings or loads. 

Member # – Enter the number of the truss member to which the new point is to be added. 

Ref Point – Enter the Reference Point from which the dimension is to be measured. 

Direction – Enter the direction of measurement, from the Reference Point to the new point being 
added.  Values include:  

 Horizontal – The Dimension is calculated horizontally from the Reference Point. 

 Vertical – The Dimension is calculated vertically from the Reference Point. 

 Rake – The Dimension is calculated at the angle of the host truss member. 

 Percent – The Dimension is calculated as a percentage of the remaining span from the 
Reference Point. 
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Dimension – Enter the distance from the Reference Point that the new point is to be located.  Enter 
a positive number to draw the new point to the right of the defined Reference Point.  Enter a 
negative number to draw the new point to the left of the Reference Point. 

INCREMENT/DECREMENT 

The Increment/Decrement tool is used to increase or decrease the number of members on a chord 
segment. 

Increment – Select Increment to increase the number of members for the selected truss segment.  
All panel points, both new and pre-existing, will be distributed evenly across the specified member. 

Decrement – Select Decrement to decrease the number of members for the selected truss segment.  
All remaining panel points will be distributed evenly across the specified member. 

Member # – Enter the number of the truss member for which the number of members is to be 
increased or decreased. 

DIVIDE POINTS 

The Divide Points tool is used to create equal divisions between two points on a single segment of truss. 

Start Pt – Enter the truss point that is to serve as the first reference location for dividing points.  

End Pt – Enter the truss point that is to serve as the second and final reference location for dividing 
points. 

# of Panels – Enter the number of panel points into which the piece is to be split.  Panel points will 
be distributed evenly between the designated Start Point and End Point. 

DIVIDE MEMBER/CHORD 

The Divide Member/Chord tool is used to split the specified chord or member into equal lengths, based 
on the number of divisions requested. 

Member Type: 

 Chord – Specifies that a chord is to be divided into equal parts. 

 Panel – Specifies that a truss panel is to be divided into equal parts. 

Member # – Identifies the number of the specific chord or panel that is to be divided. 

# of Panels – Enter the number of panels the newly divided member is to contain.  Panel points will 
be distributed evenly along the designated member. 



 

91 

 

REVERSE WEB 

Oddball’s Reverse Web tool is used to reverse the direction of a diagonal web.  If a web runs diagonally 
from the top of a truss to the bottom, then the web will be reversed and run from the bottom of the 
truss to the top.  (See Figure 109.) 

Member # – Enter the identification number of the diagonal web to be reversed.  Alternatively, 
users may simply click on the target member to initiate the Reverse Web function.  

SHIFT POINT 

The Shift Point tool is used to move a panel point from one location on a member to another location on 
that same member. 

Point # – Enter the number assigned to the truss point to be moved. 

Member # – Enter the number of the truss member to which the point is to be moved. 

Ref Point – Enter the panel point number which is to serve as the starting location for the dimension 
measurement. 

Dimension – Enter the distance the specified Point # is to be moved in relation to the Reference 
Point.  Enter a positive number to move the point to the right of the defined Reference Point.  Enter 
a negative number to move the point to the left of the Reference Point. 

Direction – Enter the plane along which the Dimension is to be measured.  Potential values include:  

 Horizontal – The Dimension is calculated horizontally from the Reference Point. 

 Vertical – The Dimension is calculated vertically from the Reference Point. 

 Rake – The Dimension is calculated at the angle of the host truss member. 

Figure 109: The Reverse Web tool has been used to alter the direction of webs 12, 14, and 16 of this truss. 
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SHIFT SLOPE 

The Shift Slope tool is used to modify the defined slope of a truss member. 

Member # – Enter the specific truss member for which the slope is to be altered. 

Hold Point – Enter the point number that is to remain constant (not move) when the slope is 
redrawn. 

Slope – Enter the new pitch specification to be applied to the selected truss member.  For a 45° 
slope, enter a value of 12/12.  For a 90° (vertical) pitch, enter a value of 999/12. 

Hold – Enter the dimension of the truss that is to remain unaltered.  Potential values include:  

 Horizontal Dim – The length of the truss member targeted for slope change – and the length 
of its opposing member – will remain unchanged. 

 Vertical Dim – The overall height of the truss will remain unaltered. 

 Opposite Slope – The slope of the opposing truss member will remain the same, even when 
the slope of the target truss member is changed.  The span of the target truss and the 
opposing truss will change as needed to accommodate the newly defined slope of the target 
truss. 

For examples of how these three different Hold dimensions affect a truss, see Figures 111-114 on 
the following two pages of this document. 

 

          WARNING! Entering invalid or unworkable data into the Hold Point and/or Slope fields will  
          generate one or more error messages like the ones pictured below. 

  
Figure 110: Error messages generated by unworkable Hold Point and Slope entries. 
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Figure 111: Prior to use of the Shift Slope tool, this common truss has an overall height of 3’.  The top chord members are both 
5’ in length and have a slope of 6/12. 

Figure 112: With a new slope of 12/12 defined for member 1 *AND* the Vertical Dimension held constant, the revised truss 
remains 3’ in height, but length of and truss members 1 and 2 changes, as does the slope of truss member 2. 
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Figure 113: With a new slope of 12/12 defined for member 1 *AND* the Opposite Slope held constant, the revised truss is now 
10” taller in overall height and the length of both members 1 and 2 have changed. 

Figure 114: With a new slope of 12/12 defined for member 1 *AND* the Horizontal Dimension held constant, the span of truss 
members 1 and 2 has not changed, however, the overall height of the revised truss is now 2’ 6” greater than the original, and 
the slope of truss member 2 has changed to 12/12 as well. 
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DELETE POINT 

The Delete Point tool is used to erase one or more points from a truss, one point at a time.  Note that 
points that are connected to joints cannot be deleted until the connected member is deleted. 

Node # – Enter the number of the point that is to be deleted, or simply click on the point within the 
design screen. 

DELETE MEMBER 

The Delete Member tool is used to erase chords and/or webs from a truss, one member at a time. 

Member # – Enter the number of the truss member to be deleted, or simply click on the member 
within the design screen. 

  NOTE!  If you delete a truss member that has a    
  “free-standing” panel point, such as member 31  
  in Figure 115 at left, a message box like the one  
  pictured below will open. 
  

Figure 115: A deleted member may result in an unsupport-
ed panel point. 

Figure 116: Choose whether or not to delete the 
free node. 
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CLEAR WEBS 
Oddball’s Clear Webs tool removes all webs 
from the active truss.  When a user clicks on 
the Clear Webs icon, the warning message 

pictured at right will open.  To proceed with 
erasing all webs, click the OK button.  To abandon 
the operation and leave webbing intact, click Cancel. 

CLEAR ALL 
 As its name implies, the Clear All tool deletes 
the entire active truss.  All chords, webs, 
panels, points, and pieces will be erased.  
When a user clicks on the Clear All icon, the 

warning message pictured at right will open.  To 
proceed with erasing the entire truss, click the OK 
button.  To abandon the operation and leave the 
truss as is, click Cancel. 

QUICK WEB 

The Quick Web tool is used to insert webs into a truss manually, one web at a time.  Users need only 
specify the panel points where each new web is to start and end. 

Start Pt – Enter the number of the panel point where the new web is to begin. 

End Pt – Enter the number of the panel point where the new web is to end. 

Instead of typing values into the Start Pt and End Pt fields, users may elect to click on the target 
panel points with the left mouse button to select them.  This feature is particularly useful when 
creating multiple webs on a truss.  When finished, clicking anywhere on the design screen with the 
right mouse button deactivates this drawing feature. 

AUTO DIVIDE 
 The Auto Divide tool re-divides all existing chords based upon the user’s Auto Web Presets.  
When a user clicks on the Auto Divide icon, additional panel points are added to the truss 
immediately, without any further input from the user. The Auto Web Presets that control the  

 Auto Divide function include: 
 Min Distance between Nodes 
 Vertical Web (at Pitch Breaks, and/or Internal Bearings, and/or Point Loads) 

AUTO QUICK WEB 

The Auto Quick Web tool automatically webs a truss using the existing panel points. 

 

Figure 117: Confirm or cancel deletion of all webs. 

Figure 118: Be sure you really want to delete your 
entire truss before clicking on the OK button here. 
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GS TRUSS BATCH PROCESSES 
The Batch Menu 
The batch function is used to perform a single action against 
multiple truss files simultaneously.  There are two basic types 
of actions that can be performed.  The first is to run a 
collection of truss files through the analysis/design process.  
The second is to generate output for a collection of truss files.  
As can be seen in the Figure 119 at right, the list of potential 
Batch Process outputs includes: Plotting, Cutting, Jig Settings, 
Full Scale Joint Details, Consolidated Cut List, Material List, 
Billing, Laser Jig Files, Roll Former Files, and Production 
Output.  Four of these ten different output types (Material 
Lists, Billing Documents, Roll Former Files, and Production 
Output) can only be generated as part of a batch process.  
The remaining six output types (Plotting, Cutting, Jig Settings, 
Full Scale Joint Details, Consolidated Cut List, and Laser Jig 
Files) can be generated for a single truss file as well as for a 
batch.  These six outputs are covered in detail in the section 
of this document entitled “GS Truss Outputs.”  Within this section, they will only be discussed 
peripherally, in terms of how they pertain to batch processing. 

         NOTE!  None of the options under the File → Batch Process menu are available if there are any  
         truss files open on the GS Truss Main Screen.  

It is worth noting that many of the parameters that control the execution of batch functions are defined 
within System Presets.  We will briefly explore these batch-related preset settings before turning to an 
examination of the various batch functions themselves. 

Batch-Related System Presets 
The Runtime tab within System 
Presets contains six different 
settings that impact how batch 
processes are executed.  (See 
Figure 120.) 

Profile Preview – When the Profile 
Preview checkbox is activated, and 
a batch analysis/design process is 
executed, GS Truss displays the 
profile of each truss, one truss at a 
time, in a separate window.  Note 
that the Profile Preview function 
applies exclusively to the batch 
importation and conversion of GS 
Plan roof truss (ITR) and floor truss 
(ITF) files.  For additional 
information about the Profile Preview function, please refer to pages 25-26 of this document. 

Figure 120:  Batch-related System Presets. 

Figure 119: Batch Process menu options. 
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Batch Preview – When the Batch Preview checkbox is activated, GS Truss loads the profile of each 
truss on the Main Screen, one truss at a time, pausing for user input prior to executing the analysis/ 
design process.  This gives the user an opportunity to fine-tune each truss prior to initiating analysis 
or design.  For additional information about the Batch Preview function, please refer to page 26 of 
this document. 

Design Review – Similar to the Batch Preview option, when the Design Review checkbox is activated, 
GS Truss loads the first truss profile in a batch and displays it on the Main Screen.  Unlike Batch  
Preview however, the analysis/design process for the truss is executed immediately.  After one file 
has been processed the application pauses, giving the user time to review details about the 
analysis/design results before proceeding to the next file.  For additional information about the 
Design Review function, please refer to page 26 of this document. 

Batch Design Process – The Batch Design Process drop-down list provides two options: 

 Analyze – When the Analyze option is selected, GS Truss evaluates the viability of trusses 
based upon the calculation of applied loads and internal member forces, using only the first 
material listed in the Material Priority Table.  No materials are substituted for trusses that 
fail the Analyze process. 

 Design – When the Design option is selected, trusses are subjected to the same testing 
scenarios involved in the Analyze process.  The only difference is that, when there is a 
failure, truss materials are bumped through the Material Priority Table (MPT) until a viable 
material is found or all materials in the MPT have been tried and failed. 

Select Printer – When the Select Printer checkbox is activated, any batch process that involves 
printing outputs opens a Print dialog box, rather than automatically printing to the computer’s 
default printer.  This allows the user to change the target printer and printer properties, as well as 
the number of copies to be printed. 

Load BOL from file – When this checkbox is activated, GS Truss loads customer name and address 
information (gleaned from GS Plan LAY files) into the GS Truss Batch Billing Screen.  Having this 
information entered automatically helps expedite the process of generating quotes, invoices, and 
bills of lading. 
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The Batch Selection Dialog Box 
Selecting any of the functions on the Batch Process menu will launch a Batch Selection dialog box like 
the one shown in Figure 121.  The Batch Selection dialog is used to create, save, and load collections of 
truss files as a batch.  What follows is a quick overview of the various parts of this dialog box. 

1. Project Tree – The Project Tree 
displays a list of GS Truss jobs and 
the truss-related files that are 
associated with those jobs.  Users 
can open and browse jobs to view 
their associated truss files by clicking 
on the plus sign to the left of the job 
name.  Note that the specific 
contents that are displayed within 
the Project Tree will depend upon 
the user’s selection of radio buttons 
under the File Types section of this 
dialog box. 

Users can select multiple truss files 
at one time from within the Project 
Tree.  There are two ways to select 
multiple files: 

 Shift – The Shift key is used 
to select multiple truss files 
that are listed consecutively 
under a single job.  To select multiple consecutive listings, simply click on the first truss 
to select it, then hold down the Shift key and click on the last truss in the group to be 
added to the batch.  The first and last trusses become highlighted, as well as all the 
trusses in between them. 

 Ctrl – The Control key is used to select multiple truss files that are not listed 
consecutively in the Project Tree.  These can be non-consecutive listings under a single 
job, or they can be listings from different jobs.  To select multiple, non-consecutive 
listings, hold down the Control key while clicking on the files to be added to your batch. 

Once the desired trusses have been selected in the Project Tree, click on the Add button to 
insert the files into the Selected Trusses list on the right-hand side of the Batch Selection dialog.  
The name of each selected truss in the Project Tree will change from black to gray font to 
indicate that the trusses have been added to the batch.   

2. File Types – The File Type radio buttons are used to specify the type(s) of files that will be 
displayed within the Project Tree.  The options include: 

 *.KTS – When the KTS radio button is selected, only truss files in the native GS Truss 
format (KTS) will be visible and selectable from within the Project Tree. 

 *.ITR  *.ITF – When the ITR/ITF radio button is selected, only GS Plan roof and floor truss 
files that have been imported into GS Truss will be visible and selectable from within the 
Project Tree of the Batch Selection dialog box. 

 

Figure 121:  The numbers presented here in the Batch Selection 
dialog box correspond with their descriptions. 
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3. System Overrides 

 MPT – When this checkbox is activated, GS Truss will overwrite truss-specific Material 
Priority Table files (MPTs) with the values in the default System MPT file.  For more 
information about MPT files, refer to the section within this document entitled 
“Working with Materials & Material Priority Tables.” 

 PPT – When the Plate Priority Table (PPT) checkbox is activated, GS Truss will overwrite 
truss-specific PPT files with the values in the default System PPT file.  For more 
information about PPT files, refer to the section within this document entitled “Working 
with Plate Priority Tables.” 

 Fasteners – When the Fasteners checkbox is activated, GS Truss overrides the fasteners 
used on each truss in the batch with the fastener values specified on the Fasteners tab 
of the user’s Engineering/Design Presets. 

 Building Code – When this checkbox is activated, GS Truss will overwrite any truss-
specific Building Code with the Building Code value selected on the Design tab of the 
user’s Engineering/Design Presets. 

 Standard/Auto Loads – When this checkbox is activated, GS Truss will overwrite any 
truss-specific Standard/Auto Loads with the load values defined on the Standard/Auto 
Loads tab of the user’s Engineering/Design Presets. 

 Roof Live Loads – When this checkbox is activated, GS Truss will overwrite any truss-
specific Roof Live Loads with the load values defined on the Roof Live Loads tab of the 
user’s Engineering/Design Presets. 

 Snow Loads – When this checkbox is activated, GS Truss will overwrite any truss-specific 
Snow Loads with the load values defined on the Snow Loads tab of the user’s 
Engineering/Design Presets. 

 Wind Loads – When this checkbox is activated, GS Truss will overwrite any truss-specific 
Wind Loads with the load values defined on the Wind Loads tab of the user’s 
Engineering/Design Presets. 

 Deflection – When this checkbox is activated, GS Truss will overwrite any truss-specific 
Deflection values with the values defined on the Deflection tab of the user’s 
Engineering/Design Presets. 

 Geometry – When this checkbox is activated, GS Truss will overwrite truss-specific 
Geometry values (such as Heel Height, Seat Cut, etc.) with the values defined in the 
user’s Geometry Presets. 

4. Selected Trusses – The Selected Trusses pane displays all the truss files that have been added to 
a batch by the user. 

COMMAND BUTTONS 

Add – Clicking on the Add command button adds the trusses currently selected in the Project Tree to 
the Selected Trusses pane of the Batch Selection dialog box. 

Remove – Clicking on the Remove command button deletes the currently selected truss(es) from the 
Selected Trusses pane of the Batch Selection dialog box. 

Remove All – Clicking on the Remove All command button deletes all trusses from the Selected 
Trusses pane of the Batch Selection dialog box. 
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Load Batch – 
Clicking on the 
Load Batch 
command button 
opens the Batch 
Options pane in 
the Batch 
Selection dialog 
box.  (See Figure 
122 at right.)  To 
load an existing 
batch of files, 
click on batch 
name within this 
pane to select it, 
and then click on 
the Load button 
below.  The 
individual truss 
files contained  
within the batch  
will appear under the 
Selected Trusses pane. 

Save Batch – If you 
have selected a 
group of files from 
the Project Tree 
that you wish to 
save as a batch, 
click on the Save 
Batch command 
button.  This will 
open the Batch 
Options pane in 
the Batch Selection 
dialog box, as 
pictured at right.   
Type in a unique 
name for your new 
batch in the Batch 
Name field and 
then click on the 
Save button below. 
Your new batch file  
will now appear in  
the Batch Files list. 

 

Figure 122: The Batch Options pane opens when a user clicks on the Load Batch button. 

Figure 123: The Batch Options pane opens when a user clicks on the Save Batch button. 
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         NOTE!  When a collection of truss files is saved as a batch, GS Truss saves the batch (with a  
         KBS extension) in a subfolder named Batch under the Jobs folder.  Once created, a batch 
file cannot be deleted directly from within the Batch Files pane of the Batch Selection dialog 
box.  Instead, the file must be deleted from within this Batch subfolder.  

OK – Clicking on the OK command button closes the Batch Selection dialog box and kicks-off 
execution of the selected batch process. 

Cancel – Clicking on the Cancel command button closes the Batch Selection dialog box without 
executing the selected batch process. 

Batch-Only Output Processes 
As mentioned at the beginning of this document, three of the eight output processes that can be 
executed for a batch cannot be executed for individual truss files.  These include Material Lists, Billing 
Documents, and Roll Former Files.  We will now turn to an examination of these three “batch-only” 
functions. 

MATERIAL LISTS 

The Material List batch function is used to print a Consolidated Material List.  Each Consolidated 
Material List contains aggregated information for all trusses in a batch, and includes: the name of the 
required materials, the number of pieces to be produced for each material type, and the total length, 
price, and weight of each material.  To create a Material List for a batch, complete the following steps:   

1. From within GS Truss, go to the menu bar and select File → Batch Process → Material List.   

2. The Batch Selection dialog box will open.  From within this dialog box, create or select a batch of 
truss files to be included in your Consolidated Material List and then click on the OK button. 

3. GS Truss will open your Consolidated Material List report in Print Preview mode.  When you are 
done reviewing the preview of your report, click on the Print button at the top of the Print 
Preview window. 

4. A Print dialog box will open.  Select the printer to which you wish to print, and the desired 
number of copies.  When you are ready, click on the OK button to send your job to the printer 
and close the Print dialog box. 

BILLING 
The Billing batch function is used to generate Quote, Invoice, and 
Bill of Lading documents.  To create a billing document, complete 
the following steps: 

1. Go to the menu bar in GS Truss and select File → Batch 
Process → Billing.  This will open a Billing dialog box like the 
one pictured at right. 

2. From within the Billing dialog box, click on the New button.  
The Batch Selection dialog box will open. 

3. From within the Batch Selection dialog box, select the files 
to be batched for your billing operation, and then click on 
the OK button at the bottom of the dialog. Figure 124: The Billing dialog box. 
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4. The Quote/Invoice/Bill of Lading dialog box, like the one in Figure 125 below, will open.  Enter 
data into the fields of this dialog box as appropriate.  Be sure to select the radio button for the 
type of document you wish to produce.  Note that pricing information is entered into this dialog 
box automatically by GS Truss, based on the user’s Pricing Presets. 

When all fields within the Quote/Invoice/Bill of Lading dialog box have been completed to your 
satisfaction, click on one of the three command buttons at the bottom of the dialog: 

Save – Clicking on the Save command button will open a dialog box 
like the one shown at right.  Type in a name for your new document 
in the field provided and click on the OK button.  Your file will be 
saved to a subfolder named Quotes, under the GS Truss Jobs folder. 

View – Clicking on the View command button will open your new 
document in Print Preview.  From here, you can review the contents 
of your document and, if satisfied, proceed with printing by clicking 
on the Print button. 

Close – Clicking on the Close command button closes the Quote/Invoice/Bill of Lading dialog box 
(without saving the new document) and returns the user to the main window in GS Truss. 

  

Figure 125: The Quote/Invoice/Bill of Lading dialog box. 

Figure 126: Save your billing 
document using this dialog box. 



 

104 

 

ROLL FORMER FILES 

GS Truss can produce roll former files with all of the specifications required for the manufacture of your 
trusses.  To create roll former files for a batch of trusses, complete the following steps: 

1. From the menu bar within GS Truss, select File → Batch Process → Roll Former Files.  This will 
open the Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files to be included in your roll former 
output, and then click on the OK button at the bottom of the dialog. 

3. GS Truss will open a Windows Save As dialog box to initiate the process of saving two new roll 
former files.  These two files contain all the information required by a roll former to fabricate 
the pieces for your batch of trusses.  The default names for these files are GSSdata.txt and 
GSShead.txt, however, users are free to name these files as they see fit.  From within the Save 
As dialog box, users can also select the location 
at which these files are to be saved.  If any of 
the truss pieces are too small to be fabricated 
by the roll former, GS Truss will open a message 
box like the one pictured at right.  Note that this 
process is only available when GSS has been 
selected as the value in the Roll Former Style 
field of Cutting / Plotting Presets. 

PRODUCTION OUTPUT 

Production Output is a batch function that generates detailed logistics information to be used in 
component manufacturing, assembly, and shipping.  To generate Production Output files, perform the 
following actions: 

1. From the menu bar within GS Truss, select File → Batch Process → Roll Former Files.  This will 
open the Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files to be included in your Production 
Output files, and then click on the OK button at the bottom of the dialog box. 

3. GS Truss will open a Windows Save As dialog box to initiate the process of saving your 
Production Output files.  By default, the Production Output process will generate two files; 
ProductioDataTR.csv and ProductioDataTR.jsn.  Once again, by default, these files will be saved 
to the following location: [Drive Root]:\[GS Plan Directory]\JOBS\[Job Name]\Production. 

Content of the ProductionDataTR.csv File 
The ProductioDataTR.csv file contains the following columns of information: 

Truck # – The truck onto which an assembled truss or wall component is to be loaded for shipping.  
This data is entered into the CSV file manually. 

Stack – The stack of components to which an assembled truss or wall is to be placed in preparation 
for shipping. 

Stack Total – The total weight of the steel (both GSS-manufactured and purchased) to be used in the 
fabrication of a given stack of components. 

[Component] Name – The alpha-numeric code assigned to a given truss or wall component. 

Cart – The staging-area cart onto which the roll-formed pieces of the given truss or wall component 
are to be stored for later assembly. 

Figure 127: Small pieces are not included in roll-
former outputs. 
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Arm – The specific section of the assigned staging-area cart where roll-formed pieces of a given 
truss or wall component are to be stored for later assembly. 

Make – The weight of the steel that will be roll formed by a GSS machine to make a given truss or 
wall component. 

Buy – The weight of the steel that cannot be roll formed by a GSS machine and that must, therefore, 
be purchased from a third-party manufacturer in order to make a given truss or wall component. 

Total – The total combined weight of steel, both GSS-rolled and purchased from a third party, 
required to manufacture a given truss or wall component. 

Length – The total length of an assembled truss or wall component. 

Height – The total height of an assembled truss or wall component. 

Sq Ft – The total square feet of an assembled truss or wall component. 

LB/NLB – This column indicates whether a given truss or wall component is designated as load 
bearing or non-load bearing. 

Width – The depth of an assembled truss or wall component 

# Openings – The number of openings existing ion a given wall component. 

# Plies – The number of plies used in the manufacture of a given truss or wall component. 

# Plates – The total number of plates required to assemble a given truss or wall component. 

# Screws – The total number of screws required to assemble a given truss or wall component. 

# Clips – The total number of clips required to assemble and install a given truss. 

Estimated Labor Hours to Assemble – The projected number of hours required to fabricate a given 
truss or wall component. 

LF to Roll – The total number of linear feet of steel used in the manufacture of a given truss or wall 
component.  

Estimated Hours to Roll - Minutes – The projected amount of time it will take for a roll former to 
manufacture the pieces for a given truss or wall component.  

Material Types – A listing of the material codes required for manufacturing of all of the trusses 
and/or wall components in the given job. 

Total LF – The total linear feet of steel required to manufacture all of the trusses and/or wall 
components in the given job. 

Total LBS – The total pounds of steel required to manufacture all of the trusses and/or wall 
components in the given job. 

Changeover Time – The estimated total time required for changing-out rolls of steel on GSS roll 
formers for the given job. 

Plates – A listing of the plate materials required for manufacturing of all of the trusses and/or wall 
components in the given job. 

Total # – The total number of plates required to fabricate all the trusses in a given job. 

Total LBS – The weight of the steel plates required to fabricate all the trusses in a given job. 

Content of the ProductionDataTR.jsn File 
This feature is still under development, and will be documented in the next release of GS Truss. 
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Other Batch Processes 
As mentioned at the beginning of this document, six of the nine processes that can be executed for a 
batch can also be executed for individual truss files.  We will now turn to a brief, summary explanation 
of these six functions. 

DESIGN 

The Design batch function is used to run a collection of truss files through the analysis process or the 
design process.  Whether design is executed, or an analysis is performed instead, depends upon the 
user’s Batch Design Process settings within System Presets.  (See Figure 120 on page 97 of this 
document.)  To perform either an analysis or a design process, complete the following steps: 

1. From the menu bar within GS Truss, select File → Batch Process → Design.  This will open the 
Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files to be included in the analysis/design 
process, and then click on the OK button at the bottom of the dialog. 

3. From here, the specific manner in which GS Truss presents and processes your truss files is 
contingent upon the Batch Processes you have defined on the Runtime tab of your System 
Presets.  (See the section titled “Batch Related System Presets” on page 97 of this document.) 

4. When the system pauses between files for user input, the user can proceed to the 
next file in the batch in one of two ways.  The first is to press the End key on the 
keyboard.  The second is to click on the Next icon on the Batch toolbar.  (See the 
figure at right.)  Note that the Batch toolbar also includes an icon for going back to 
the Previous file in the batch, and an icon to Quit 
the batch process altogether.  There are no 
keyboard equivalents for these two functions. 

5. When all files in the batch have completed the 
analysis/design process, the Batch Log tab of the 
data pane will display the message “Batching 
Complete.”  (See the Figure 128 at right.) 

PLOTTING  

The Plotting batch function prints a separate Plot Drawing for each truss in a batch.  The specific content 
of these Plot Drawings is governed by the values defined within the Plotting tab of the user’s 
Cutting/Plotting Presets.  Note that each truss within the batch needs to have successfully completed 
the analysis/design process for plot data to be available.  To create Plot Drawings for a batch of trusses, 
complete the following steps: 

1. From the menu bar within GS Truss, select File → Batch Process → Plotting.  This will open the 
Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files for which you wish to create Plot 
Drawings and then click on the OK button at the bottom of the dialog. 

3. If you have the Select Printer checkbox enabled on the Runtime tab of your System Presets, GS 
Truss will open a Print dialog box, allowing you to select the target printer and number of copies 
you would like to print.  If this checkbox is not enabled, GS Truss will send the Plot Drawings 
directly to your computer’s default printer. 

For additional information about Plot Drawings, please refer to page 161 of this document. 

Figure 128: Batch log message that the batching 
process has completed. 
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CUTTING 

The Cutting batch option prints a separate Cut List report for each truss in a batch.  The specific content 
of these Cut Lists is governed by the values defined on the Cutting tab of the user’s Cutting/Plotting 
Presets.  Note that each truss in the batch must have successfully completed the analysis/design process 
for cutting data to be available.  To create Cut List reports for a batch of trusses, complete the following 
steps: 

1. From the menu bar within GS Truss, select File → Batch Process → Cutting.  This will open the 
Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files for which you wish to create Cut List 
reports, and then click on the OK button at the bottom of the dialog. 

3. If you have the Select Printer checkbox enabled on the Runtime tab of your System Presets, GS 
Truss will open a Print dialog box, allowing you to select the target printer and number of copies 
you would like to print.  If this checkbox is not enabled, GS Truss will send the Cut List reports 
directly to your computer’s default printer. 

For additional information about Cut Lists, please refer to page 160 of this document. 

JIG SETTINGS 

The Jig Settings batch function prints a separate Jig Settings report for each truss in a batch.  The specific 
content of these Jig Setting reports is governed by the values defined in the user’s Jig Setting Presets.  
Note that each truss in the batch must have successfully completed the analysis/design process for Jig 
Settings data to be available.  To create Jig Setting reports for a batch of trusses, complete the following 
steps: 

1. From the menu bar within GS Truss, select File → Batch Process → Jig Settings.  This will open 
the Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files for which you wish to create Jig 
Setting reports, and then click on the OK button at the bottom of the dialog. 

3. If you have the Select Printer checkbox enabled on the Runtime tab of your System Presets, GS 
Truss will open a Print dialog box, allowing you to select the target printer and number of copies 
you would like to print.  If this checkbox is not enabled, this step is skipped. 

4. Next, GS Truss will open a Jig Table Offsets dialog box like the 
one pictured at right.  This dialog box is used to enter horizontal 
(“X”) and vertical (“Y”) offsets for placement of the truss on a jig 
table.  Enter the desired “X” and “Y” offsets in their respective 
fields.  To apply these offsets to the entire batch, click in the 
Apply offsets to all trusses in batch checkbox.  If this checkbox is 
not activated, the Jig Table Offsets dialog box will remain open 
and GS Truss will pause after processing each file, awaiting the 
user’s entry of “X/Y” data for the next file in the batch. 

5. Click on the OK button to send your files to the printer and close the Jig Table Offsets dialog box. 

For additional information about Jig Setting Reports, please refer to page 166 of this document. 

 

 

Figure 129: The Jig Table Offsets 
dialog box. 
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FULL SCALE JOINT DETAILS 

The Full Scale Joint Details batch function prints a report containing a life-sized diagram of every joint on 
every truss in a batch.  (One diagram per page.)  Note that each truss in the batch must have successfully 
completed the analysis/design process for joint-details data to be available.  To create a Full Scale Joint 
Details report for a batch of trusses, complete the following steps: 

1. From the menu bar within GS Truss, select File → Batch Process → Full Scale Joint Details.  This 
will open the Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files for which you wish to create a report, 
then click on the OK button at the bottom of the dialog. 

3. If you have the Select Printer checkbox enabled on the Runtime tab of your System Presets, GS 
Truss will open a Print dialog box, allowing you to select the target printer and number of copies 
you would like to print.  If this checkbox is not enabled, GS Truss will send the Full Scale Joint 
Details report directly to your computer’s default printer. 

For additional information about Full Scale Joint Detail Reports, please refer to page 164 of this 
document. 

CONSOLIDATED CUT LISTS 

Like the Cutting option, the Consolidated Cut List batch function prints a Cut List report.  The difference 
between these two options is that the Consolidated Cut List function prints a single, combined and 
abbreviated report, while the Cutting function prints a separate and complete report for each truss in a 
batch.  The specific content of the Consolidated Cut List report is governed by the values defined on the 
Cutting tab of the user’s Cutting/Plotting Presets.  Note that each truss in a batch needs to have 
successfully completed the analysis/design process for Consolidated Cut List data to be available.  To 
create a Consolidated Cut List report for a batch of trusses, complete the following steps: 

1. From the menu bar within GS Truss, select File → Batch Process → Consolidated Cut List.  This 
will open the Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files for which you wish to create a 
Consolidated Cut List report, and then click on the OK button at the bottom of the dialog. 

3. If you have the Select Printer checkbox enabled on the Runtime tab of your System Presets, GS 
Truss will open a Print dialog box, allowing you to select the target printer and number of copies 
you would like to print.  If this checkbox is not enabled, this step is skipped. 

4. In the final step, GS Truss opens your new Consolidated Cut List report in a Print Preview 
window.  If the report meets with your approval, click on the Print command button to send the 
report to your printer and close the Print Preview window.  If the report does not meet with 
your approval, simply close the Print Preview window and the entire process will be terminated. 

For more information about Consolidated Cut List reports, please refer to the section within this 
document entitled “GS Truss Outputs.” 

LASER JIG FILES 
The Laser Jig Files batch function creates a single Laser Jig File for all trusses in a batch.  This file can then 
be imported into a Laser Jig machine to aid in the assembly of the trusses.  Note that each truss in the 
batch must have successfully completed the analysis/design process for Laser Jig data to be available.  
To create Laser Jig Files for a batch of trusses, complete the following steps: 
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1. From the menu bar within GS Truss, select File → Batch Process → Laser Jig Files.  This will open 
the Batch Selection dialog box. 

2. From within the Batch Selection dialog box, select the files you wish to include in the Laser Jig 
output, and then click on the OK button at the bottom of the dialog. 

3. GS Truss will create a single Laser Jig File with a “tps” extension.  Laser Jig Files are stored under 
the GS Truss Jobs folder for the particular job with which the trusses in the batch are associated. 

For more information about Laser Jig Files, please refer to the section within this document entitled “GS 
Truss Outputs.” 
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USING AUTO WEB & QUICK AUTO WEB 
Auto Web 
As its name implies, the Auto Web function is used to web trusses automatically.  There are two ways to 
initiate Auto Web: 

1. Go to the GS Truss menu bar and click on Geometry → Auto Web. 

2. On the GS Truss Geometry toolbar, click on the Auto Web icon. 

Performing 
either of these 
actions will 
open the Auto 
Web window 
like the one 
pictured at 
right.  This 
window 
contains fields 
for defining 
Auto Web 
parameters, as 
well as a 
diagram of the 
active truss in 
Element View.  
Notice that the 
fields presented 
in the Auto Web 
window, and 
their associated 
values, are 
identical to 
those defined in 
the user’s Auto Web Presets.  Review the Auto Web settings to make sure that they are defined to your 
liking.  For information about the individual fields and values associated with Auto Web Presets, please 
see the section of this document entitled “Working with GS Truss Presets.” 

Command Buttons 
Auto Web – Once you are sure that your Auto Web settings have been defined according to the current 
need, click on the Auto Web command button to complete the webbing of your truss. 

Return to Main – Once you have finished webbing your truss, click on the Return to Main command 
button to return to the main GS Truss window. 
  

Figure 130: The Auto Web window displays your truss in Element View. 
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Quick Auto Web 
As mentioned in the previous section, the Auto Web function provides users with an opportunity to 
review their Auto Web Presets prior to initiating the Auto Web process.  If you are confident that your 
Auto Web Presets are already defined in accord with your needs, you can bypass this review process by 
executing the Quick Auto Web function.  There are two different ways to execute Quick Auto Web: 

1. Click on the Quick Auto Web icon on the Auto Web toolbar.   

2. Go to the GS Truss menu bar and click on Geometry → Quick Auto Web. 

For information about Auto Web Presets, please see the section entitled “Working with GS Truss 
Presets.” 
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USING GABLE WEB & QUICK GABLE WEB 
Gable Web 
The Gable Web function is used to web gable trusses automatically.  There are two ways to initiate 
Gable Web: 

1. Go to the GS Truss menu bar and click on Geometry → Gable Web. 
2. On the GS Truss Geometry toolbar, click on the Gable Web icon. 

Performing either of these actions will open a Gable Web window like the one pictured above.  This 
window contains fields for defining Gable Web parameters, along with a diagram of the active truss in 
Element View.  Notice that the fields presented in the Gable Web window, and their associated values, 
are identical to those defined in the user’s Gable Web Presets.  Review the Gable Web settings to make 
sure that they are defined to your liking.  For information about the individual fields and values 
associated with Gable Web Presets, please see the section of this document entitled “Working with GS 
Truss Presets.” 

Command Buttons 
Gable Web – Once you are sure that your Gable Web settings have been defined according to the 
current need, click on the Gable Web command button to complete the webbing of your truss. 

Figure 131: The Gable Web window in GS Truss. 
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Return to Main – Once you have finished webbing your truss, click on the Return to Main command 
button to return to the main GS Truss window. 

Quick Gable Web 
As mentioned in the previous section, the Gable Web function provides users with an opportunity to 
review their Gable Web Presets prior to initiating the Gable Web process.  If you are confident that your 
Gable Web Presets are already defined in accord with your needs, you can bypass this review process by 
executing the Quick Gable Web function.  There are two different ways to execute Quick Gable Web: 

1. Click on the Quick Gable Web icon on the Auto Web toolbar.   

2. Go to the GS Truss menu bar and click on Geometry → Quick Gable Web. 

For information about Gable Web Presets, please see the section entitled “Working with GS Truss 
Presets.” 
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WORKING WITH BEARINGS 
When a new truss is created, GS Truss automatically adds a single bearing at 
either end of that truss.3  Trusses with long spans, or trusses carrying 
exceptional loads, may require additional bearings.  The Bearings window is 
used to create these additional bearings.  It is also used to create different 
combinations of bearings for analysis and design purposes.   

The Bearings window can be opened in two ways: 

1. On the menu bar, click on Geometry → Bearings, as pictured at right. 

2. On the Geometry toolbar, click on the Bearings icon. 

When you open the Bearings tool, a diagram of your truss will open in 
Element View, along with a Bearings window, like the one pictured below. 

Adding a New Bearing 
To add a new bearing to your truss, start by clicking on the Add Bearing button at the bottom of the 
Bearings window.  GS Truss will add a blank row below the rows providing information about the 
existing bearings.  Complete the fields in the new row of bearing information as follows: 

Cont – Activate the Continuous checkbox if you wish to create a bearing that spans two or more 
Nodes. 

Node – All bearings must be associated with a node.  Enter the number of the Node where the 
bearing is to be created, or where the bearing is to begin if you are creating a Continuous bearing. 

Width – Enter the Width of the bearing to be created. 

Fixity – The Fixity field defines the degree and direction a truss is permitted to move over a bearing.  
The three potential values are: 

 Pinned – A Pinned bearing is immovable.    
 H Roll – An H Roll bearing permits movement along the horizontal plane.       
 V Roll – A V Roll bearing permits movement along the vertical plane.    

                                                             
3  GS Truss adds bearings automatically when the user exits the Library or Oddball window in which the truss was created. 

Figure 132: Bearings on the 
Geometry menu. 

Figure 133: The Bearings window is used to define bearing properties and combinations. 
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        NOTE!  When the Cont checkbox is enabled for a given bearing, the Fixity value for that  
       bearing must be Pinned. 

Side – This field defines the Side of the node on which the bearing is to be placed.  Pinned and H Roll 
bearings may be placed to the Left, Right, or Center of their host node.  V Roll bearings may be 
placed on Top, Bottom, or Center of their node. 

Draw – Draw refers to the bearing’s placement on the vertical plane.  Enter the direction your 
bearing is to be drawn in relation to the truss member it supports.  Pinned and H Roll bearings can 
be drawn on the Top or Bottom of the truss member.  V Roll bearings can be drawn to the Left or 
Right of the truss member. 

Type – Enter the type of bearing to be created.  The three potential values are:  
 Wall 
 Truss to Structure (Trs to Struct) 
 Truss to Truss (Trs to Trs) 

Once the properties for your new bearing have been defined, no further action is required.  Simply click 
on the Return to Main command button in the upper right-hand corner of the Bearings window to 
return to the main window in GS Truss. 

Deleting a Bearing 
To delete an existing bearing, start by opening the Bearings window.  Next, click somewhere within the 
row of information that describes the bearing to be deleted.  Once this has been done, all that remains 
is to click on the Delete Bearing button.   

Note that all trusses require a minimum of two bearings.  If you 
attempt to delete one bearing when only two bearings are present, a 
warning message like the one pictured at right will open.  To resolve 
this situation, leave the existing bearings “as is”, or add at least one 
additional bearing to your truss before deleting another. 

Creating Bearing Combinations 
Bearing combinations are collections of bearings grouped together for analysis and design purposes.  For 
example, you may wish to use different bearing combinations when analyzing trusses that are designed 
to the same specification, but that will be used in different locations throughout your structure.  Each of 
these trusses, though identical in design, can be assigned different loadings.  Different bearing 
combinations can then be used to evaluate and maintain structural integrity without changing the 
design of the truss.  Multiple bearing combinations can be created for a single truss, and each bearing 
combination must have at least one pinned bearing.   

To create a new bearing combination, perform the following actions: 

1. From within the Bearings window, click on the Add Combo button.  GS Truss will insert a new 
column in the Combinations pane.  This column will contain a checkbox for each existing 
bearing. 

2. Activate the checkboxes for each bearing that you want included in your new combination. 
  

Figure 134: Error when deleting one 
of only two bearings. 
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3. When you are done adding new Bearing Combinations, click on the Return to Main button to 
return to the main GS Truss window. 

        NOTE!  Each bearing combination is acknowledged by GS Truss during the analysis process. 

Deleting Bearing Combinations 
To delete an existing Bearing Combination, click somewhere in the column representing the 
combination that is to be removed, and then click on the Delete Combo button. 
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USING THE STUB/CAP FUNCTION 
The Stub/Cap tool can be a real life saver when you need to create trusses that are too tall or too wide 
to be manufactured and/or delivered as a single unit.  Using Stub/Cap you can take your extra tall or 
extra wide trusses and split them into manageably sized components that are easy to manufacture and 
ship.  The complete truss can then be assembled on site, according to specifications. 

There are two ways to open the Stub/Cap window: 

1. From the GS Truss menu bar, click on Geometry → Stub/Cap. 

2. From the Geometry toolbar, click on the Stub/Cap icon. 

Performing either of these actions will open a Stub/Cap window, similar to the one pictured below.  

As you can see, this window contains fields for defining Stub/Cap parameters, as well as a diagram of the 
active truss in Element View.  Notice that many of the fields presented in the Stub/Cap window, and 
their associated values, are identical to those defined on the Cap Truss tab of the user’s Geometry 
Presets.  To stub and cap your truss, begin by reviewing and modifying the values in the fields provided 
as follows:  
  

Figure 135: The Stub/Cap window includes radio buttons, checkboxes, fields, and buttons for stubbing the active truss. 
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STUB END 

The Stub End radio buttons are used to identify the section of truss that is to be stubbed. 

 Left – Specifies that the left side of the 
truss is to be stubbed. 

 Right – Specifies that the right side of 
the truss is to be stubbed.  (See Figure 
136 at right.) 

 Top – Specifies that the top of the truss 
is to be stubbed. 

[OTHER] 

Ref Point – The panel point from which the stub dimension will be measured. 

Stub Dimension – The Stub Dimension field defines the precise length or height of the stub, 
depending upon the section of truss being stubbed. 

Autoweb – When this checkbox is enabled, GS Truss will configure webs automatically for the truss 
being stubbed. 

CREATE CAP 

The fields and checkbox contained within the Create Cap section of this window pertain only to trusses 
that have a stubbed top with a cap truss. 

Create Cap – When this checkbox is activated, GS Truss automatically creates a cap truss as a 
separate and distinct truss file from that of its stubbed base.  The default name for the cap truss is 
identical to that of the base truss with a hyphen and the word “CAP” appended at the end. 

Heel Height (Left/Right) – The left and right Heel Height fields are used to define the dimension  
of heels for a truss that is to be stubbed.  (See Figure 137.) 

OH Gap (Left/Right) – The left and right Overhang Gap fields define the space between the ends of 
a cap’s overhangs and the pitch break of the base truss on which it will rest.  (See Figure 137.) 

Chord Gap – When this checkbox is activated, a gap is created between the base truss and its cap.  
(See Figure 137.) 

Figure 137:  Detail for truss sections involved in stubbing. 

Figure 136: This truss will be stubbed on its right side. 
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[Chord Gap Dimension] – This field is used to define the precise size of the chord gap (the space 
between a base truss and its cap) that is to be created.  (See Figure 137 on the previous page.) 

Purlin Spacing – The Purlin Spacing field defines the default distance between bracing mechanisms 
connecting neighboring trusses on the top chord and the bottom chord.  (See Figure 137 on the 
previous page.)  

[COMMAND BUTTONS] 

Stub – When a user clicks on the Stub command button, the active truss is truncated in accord with 
the values specified within the Stub/Cap window. 

Undo – The Undo button cancels the user’s previous action. 

Redo – The Redo button reapplies the previously cancelled action. 

Return to Main – Clicking on the Return to Main button closes the Stub/Cap window and returns the 
user to the primary GS Truss window. 
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WORKING WITH MATERIALS & MATERIAL PRIORITY TABLES 
The Material Database and MPTs 
In GS Truss, Material Databases contain detailed information about the materials an organization uses 
in the design and construction of truss webs and chords.  Every GS Truss installation includes at least 
one Material Database.  A Material Priority Table (MPT), on the other hand, represents a subset of the 
data in a Material Database.  MPTs serve several essential functions: 

1. They limit the amount of data a user must wade through in order to locate materials required for 
truss design.   

2. They help automate the assignment of materials during the design process by pre-associating 
specific materials with the parts of a truss they will be used to fabricate.  (For example, one 
material might be associated with the creation of structural webs while another is associated 
with non-structural webbing.)   

3. They define the exact nature of each material’s participation in the bumping process. 

4. They define the specific Bracing requirements, if any, for a given web material. 

Each organization may have multiple MPTs, and each MPT will reflect a different subset of materials to 
be used and/or the bumping sequence of those materials.  Within GS Truss, every truss is associated 
with a specific MPT.  As will be explained in the pages to come, Material Priority Tables can be managed 
on a truss-specific basis or on a system-wide basis.   

Working with System MPTs 
A System Material Priority Table (MPT) defines the default values for materials to be used in the creation 
of new trusses.  An installation may have multiple System MPTs, however, only one MPT can serve as 
the system default at any given time.  As pictured in Figure 138 below, the System MPT chosen to serve 
as the default is selected from a drop-down list on the Files tab of System Presets.  In addition to 
selecting an MPT to serve as the system default, users can also edit the contents of any System MPT by 
clicking on the Edit MPTs command button on this tab.  Editing System MPTs provides users with an 
opportunity to: 

 Add to the list of available 
materials in the MPT. 

 Associate materials with 
the specific truss pieces 
they will be used to 
manufacture. 

 Activate or deactivate a 
material’s participation in 
the bumping process. 

 Change the bumping 
sequence for a specific 
material. 

 Create a new System MPT, 
or copy or delete and 
existing System MPT. Figure 138: The Files tab in the System Presets dialog box. 
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To edit a System MPT, go to the menu bar and select Presets → System → Files tab.  Click on the Edit 
MPTs command button to open the System MPT Editor window, as pictured in Figure 139 below.  As can 
be seen in Figure 139, the title bar of this dialog indicates that you are using the System MPT Editor (as 
opposed to the editor used for truss-specific MPTs).  We will now turn to an exploration of the various 
parts of the System MPT Editor. 

Priority Tables – The Priority 
Tables field provides a drop-
down list of all system-level 
Material Priority Tables 
currently available in GS 
Truss. 

Material Database – The 
read-only Material Database 
field displays the name of the 
database associated with the  
currently selected MPT file.  
(As mentioned previously, 
MPTs represent a subset of 
the data contained within 
their parent Material 
Database.) 

Description – The read-only 
Description field displays a 
brief narrative explanation of the purpose and/or application of the currently selected MPT. 

Material Application – The Material Application field provides a drop-down list of the various types 
of truss pieces with which a specific material can be associated.  The potential values in this drop-
down list include: 

1. Structural Chords 
2. Structural Webs 
3. Non-Structural Chords 
4. Non-Structural Webs 
5. Composite Only 

When you select a Material Application from this drop-down list, say Structural Chords for example, 
the Material Details pane will display all materials in the MPT that have been designated as suitable 
for the construction of Structural Chords.  Whether editing an existing MPT or creating a new one, 
you will want to be sure to define the materials associated with each different Material Application. 

  

Figure 139: The Material Priority Table Editor for System MPTs. 
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Copy Application – The Copy Application command button is 
used to duplicate the list of materials associated with one 
Material Application for use with a different Material 
Application.  For example, you may wish to copy all of the 
materials listed for Structural Webs for use as Structural Chords 
as well.  Clicking on the Copy Application command button will 
open a dialog box like the one pictured at right.  Within this 
dialog box, the Material Application serving as the data source 
will be grayed-out and inaccessible, as will any other application 
for which use of the copied materials is precluded.  Click in the 
checkbox for each Material Application to which you want the 
current list of materials copied.  Next, click on the Copy button.  Once the materials have been 
copied, select each new Material Application individually to edit the Bracing, Active, and/or Member 
Weight values of each newly copied material, as needed. 

MATERIAL DETAILS 

Material ID – The Material ID drop-down contains a list of all materials available in the current 
Material Database.  Within the Material Details pane, these materials are listed in order of their 
bumping sequence, with the last bumping substitution appearing at the bottom of the list.   

Bracing – The Bracing field is used to define the type of bracing, if any, to be used with the 
associated Material ID.  Since Bracing is only applied to webs, this field is disabled when either 
Structural Chords or Non-Structural Chords are selected as the Material Application.  When 
Structural Webs or Non-Structural Webs is selected as the Material Application, the list of potential 
Bracing values includes: 

 Unbraced 
 Sheathed 
 In plane (1) 
 In plane (2) 

 Out of plane (1) 
 Out of (2) 
 Both planes (1) 
 Both planes (2) 

Active – The Active checkbox dictates whether or not a material is included in the material-bumping 
process.  (The bumping sequence starts with the first material listed in the Material Details pane and 
then progresses down the list, one material at a time, until a material is found that satisfies loading 
requirements or the list of materials is exhausted – whichever comes first.)  When checked, the 
material is included in bumping; when unchecked, the material is excluded from bumping.  By 
default, the Active checkbox is checked (i.e. “true”). 

Mbr Wgt – The Member Weight field displays the weight for a specified length of a given material.  
GS Truss populates this field automatically using data supplied from the Material Database.  That 
said, however, the listed values can be edited directly by users.  Changing Member Weight values in 
one System MPT does not affect the associated values in other System MPTs, or in the Material 
Database itself. 

  

Figure 140: Copy Application dialog. 
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New Table – Clicking on the 
New Table command button 
opens a New Material Priority 
Table dialog box like the one 
pictured at right.  Enter a 
unique name for your new 
System MPT in the New Table 
Name field, and type a 
description for the new table in the Table Description field.  From the Material Database drop-down 
list, select the database that contains the desired materials for your new MPT, and then click on the 
OK button to complete the table-creation process.  Your new MPT will now appear in the list of 
available MPTs. 

Copy Table – Clicking on the Copy Table  
command button opens a Copy Material  
Priority Table dialog box like the one 
pictured here.  Select the MPT you wish to 
copy from the Table To Copy drop-down 
list, and type in a new name for the copied 
table in the New Table Name field.  The 
Material Database field in this dialog box is 
read-only, and displays the name of the Material Database associated with the MPT being copied.  
To complete the copy process, click on the OK button.  Your copied MPT will now appear in the list 
of available MPTs. 

 
Delete Table – Clicking on the Delete Table command button opens 
a dialog box like the one pictured at left.  Select the MPT to be 
deleted from the drop-down list and click on the OK button to 
complete the deletion process. 

 
View Table – Clicking on the 
View Table command opens a 
window displaying the entire 
contents of the active MPT, as 
shown in Figure 144 at right. 

Move Row Up – Clicking on the 
Move Row Up command moves 
the row currently selected in the 
Material Details pane up one 
place in the bumping sequence. 

Move Row Down – Clicking on 
the Move Row Down command 
button moves the row currently 
selected in the Material Details 
pane down one place in the 
bumping sequence. 

Figure 141: The New Material Priority Table dialog box. 

Figure 142: The Copy Material Priority Table dialog box. 

Figure 143: Delete Table dialog. 

Figure 144: The MPT View Report. 
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Add Row – Clicking on the Add Row command button adds a single, blank row to the bottom of the 
Material Details pane.  Once created, this row can be moved up in the bumping sequence using the 
Move Row Up command. 

Insert Row – Clicking on the Insert Row button adds a single, blank row above the currently selected 
row in the Material Details pane.  Once created, this row can be moved up and down in the 
bumping sequence by using the Move Row Up and Move Row Down commands. 

Delete Row – Clicking on the Delete Row button erases the currently selected row from the Material 
Details pane. 

OK – Clicking on the OK command button saves all user-defined changes to the MPT and closes the 
System MPT Editor window. 

Cancel – Clicking on the Cancel command button discards all user-defined changes to the MPT and 
closes the System MPT Editor window. 

Editing a Truss-Specific MPT 
As mentioned previously, all truss files are assigned to a single Material Priority Table (MPT).  This 
assignment happens automatically at the time a new truss file is created.  Specifically, when a new truss 
is created, GS Truss creates a copy of the default System MPT, gives the copy a new name, and assigns 
the new copy of the MPT to the truss.  (The name given to the new copy of the System MPT begins with 
the word “Truss” followed by a hyphen (–) and the name of the truss file.  (For example, “Truss – J002.”)  
Therefore, by editing the default System MPT, users are effectively modifying the template used to 
create truss-specific MPTs. 

When users want to edit the MPT settings for a specific truss (for example, to change the bumping 
sequence of materials), they must edit the MPT file assigned to that truss.  To edit a truss-specific MPT, 
begin by making sure that the truss file is open, active, and unlocked.  Once this is done, go to the menu 
bar and select Material → Edit MPT.  This will open a dialog box like the one pictured below.  As can be 
seen, the title bar of this dialog box indicates that you are using the Material Priority Table Editor for the 
“Current Truss” rather than the System MPT Editor.  Changes made using this dialog box affect the active 
truss only, not your System MPTs. 

Priority Tables – When using 
the truss-specific MPT Editor, 
the Priority Tables field is 
grayed-out and inaccessible.  
For information about how to 
change the MPT file 
associated with an existing 
truss, see “Changing the MPT 
Assigned to an Existing Truss” 
on page 128 of this 
document. 

Material Database – This 
read-only field displays the 
name of the Material 
Database providing source 
data for the current MPT. 

Figure 145: A truss-specific MPT Editor dialog box. 
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Description – The read-only Description field displays a brief narrative explanation of the purpose 
and/or application of the current MPT. 

Material Application – The Material Application field provides a drop-down list of the various types 
of truss pieces with which a specific material can be associated.  The values in this drop-down list 
include: 
 Structural Chords 
 Structural Webs 
 Non-Structural Chords 

 Non-Structural Webs 
 Composite Only 

Copy Application – The Copy Application command button is 
used to duplicate the list of materials associated with one 
Material Application for use with a different Material 
Application.  For example, you may wish to copy all of the 
materials listed for Structural Webs for use as Structural Chords 
as well.  Clicking on the Copy Application command button opens 
a dialog box like the one pictured at right.  Within this dialog box, 
the Material Application serving as the data source will be 
grayed-out and inaccessible, as will any other application for 
which use of the copied materials is precluded.  Click in the 
checkbox for each Material Application to which you want the 
current list of materials copied.  Next, click on the Copy button.   
Once the materials have been copied, select each new Material Application individually to edit the 
Bracing, Active, and/or Member Weight values of each newly copied material. 

MATERIAL DETAILS 

Material ID – The Material ID drop-down provides a list of all materials available in the current 
Material Database.  Within the Material Details pane, these materials are listed in order of their 
bumping sequence, with the last bumping substitution appearing at the bottom of the list.   

Bracing – The Bracing field is used to define the type of bracing, if any, to be used with the 
associated Material ID.  Since Bracing is only applied to webs, this field is disabled when either 
Structural Chords or Non-Structural Chords is selected as the Material Application.  When Structural 
Webs or Non-Structural Webs is selected as the Material Application, the list of potential Bracing 
values includes: 
 Unbraced 
 Sheathed 
 In plane (1) 
 In plane (2) 

 Out of plane (1) 
 Out of (2) 
 Both planes (1) 
 Both planes (2) 

Active – The Active checkbox dictates whether or not a material is included in the material-bumping 
process.  (The bumping sequence starts with the first material listed in the Material Details pane and 
then progresses down the list, one material at a time, until a material is found that satisfies loading 
requirements or the list of materials is exhausted – whichever comes first.)  When checked, the 
material is included in bumping; when unchecked, the material is excluded from bumping.  By 
default, the Active checkbox is checked (i.e. “true”). 

  

Figure 146: Copy Application dialog. 
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Mbr Wgt – The Member Weight field displays the weight for a specified length of a given material.  
GS Truss populates this field automatically using data supplied by the Material Database.  That said, 
however, the listed values can be edited directly by users.  Changing Member Weight values in one 
MPT does not affect the associated values in other MPTs, or in the Material Database itself. 

COMMAND BUTTONS 

Edit PPT – The Edit PPT function is documented on pages 138-142 of this manual. 

Copy to System – A truss-specific MPT can be saved as a System MPT by 
clicking on the Copy to System command button.  When you do so, a 
dialog box like the one pictured at right will open.  Simply type in a 
unique name for your new System MPT and click on the OK button to 
complete the copying process. 

 
Replace from System – The Replace 
from System command button allows users to substitute a System 
MPT for the current, truss-specific MPT.  Clicking on this button 
opens a dialog box like the one pictured at left.  Select the System 
MPT to be implemented from the drop-down list and then click on 
the OK button.  A message box will appear that states “This 
operation will recreate the truss geometry.  Continue?”  Once 
again, click on the OK button to implement your change and close 

the message box.  Though the contents of the MPT will change with the substitution of a System 
MPT, the MPT file name will remain the same. 

Restore Weights – When the 
weight value of one or more 
materials has been changed in 
the Member Weight (Mbr Wgt) 
column, clicking on the Restore 
Weights command button will 
discard those changes and 
restore the original weight 
values from the Material 
Database.  Note that, if the 
active truss file is locked, the 
Restore Weights command 
button will be grayed-out and 
inaccessible. 

View Table – Clicking on the 
View Table command button 
opens a window displaying the 
entire contents of the active 
MPT, as shown in Figure 149. 

  
Figure 149:  The View Table function opens a report like this one. 

Figure 147: Copy to System dialog. 

Figure 148: Replace from System dialog. 
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Move Row Up – Clicking on the Move Row Up command button moves the currently selected row 
up one place in the bumping sequence.  Note that if the active truss file is locked, the Move Row Up 
command button will be grayed-out and inaccessible. 

Move Row Down – Clicking on the Move Row Down command button moves the currently selected 
row down one place in the bumping sequence.  Note that if the active truss file is locked, the Move 
Row Down command button will be grayed-out and inaccessible. 

Add Row – Clicking on the Add Row command button adds a single, blank row to the bottom of the 
Material Details pane.  Once created, this row can be moved up in the bumping sequence using the 
Move Row Up command.  Note that, if the active truss file is locked, the Add Row command button 
will be grayed-out and inaccessible. 

Insert Row – Clicking on the Insert Row button adds a single row immediately above the currently 
selected row in the Material Details pane.  Once created, this row can be moved up and down in the 
bumping sequence by using the Move Row Up and Move Row Down commands.  Note that if the 
active truss file is locked, the Insert Row command button will be grayed-out and inaccessible. 

Delete Row – Clicking on the Delete Row button erases the currently selected row from the Material 
Details pane.  Note that if the active truss file is locked, the Delete Row command button will be 
grayed-out and inaccessible. 

OK – Clicking on the OK command button saves all user-defined changes to the MPT and closes the 
MPT Editor window. 

Cancel – Clicking on the Cancel command button discards all user-defined changes to the MPT and 
closes the MPT Editor window. 

Changing the Default MPT for All New Trusses 
To change the System MPT used as the default template for all new trusses, complete the following 
steps: 

1. Go to the menu bar and select Presets → System to open the System Presets dialog box. 

2. On the Files tab of the System Presets dialog box, navigate to the Material Priority Table drop-
down list and select the MPT you wish to use as the new system default. 

3. Click on the Save to System button.  All truss files created from this point forward will use the 
newly designated System MPT as the template for the creation of their truss-specific MPT files. 

Changing the Default MPT for a Single New Truss 
To use an MPT other than the default for a truss that you are about to create, complete the following 
steps: 

1. Go to the menu bar and select Presets → System to open the System Presets dialog box. 

2. On the Files tab of the System Presets dialog box, navigate to the Material Priority Table drop-
down list and select the MPT you wish to apply as the template for your new truss. 

3. Click on the OK button.  This will close the System Presets dialog box and the newly selected 
MPT will be applied when you create your new truss. 
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NOTE! When the procedure outlined above is followed, the newly selected MPT will remain active as the 
system default until the user:   

 Clicks on the Save to System command button to permanently save the newly selected MPT as 
the system default, or 

 Selects a different MPT from the Material Priority Table drop-down list and clicks on the OK 
button once again, or 

 Clicks on the Restore button, or closes and reopens the GS Truss program.  (Both of these 
actions will reinstate the previous MPT file as the system default.) 

Changing the MPT Assigned to an Existing Truss 
Existing truss files may have been created using an MPT that is different from the current default MPT 
defined in your System Presets.  To change the MPT associated with an existing truss file, follow these 
steps: 

1. Make sure the truss file you wish to change is currently closed. 

2. Go to the menu bar and select Presets → System to open the System Presets dialog box. 

3. On the Files tab of the System Presets dialog box, select the MPT you wish to apply to your 
existing truss file from the Material Priority Table drop-down list. 

4. Click in the Use Preset MPT checkbox to activate it. 

5. Click on the OK button to close the System Presets dialog 
box. 

6. Next, go to the Projects window in GS Truss and double-
click on your truss file to open it.  When you do, a 
message like the one pictured at right will appear, asking 
if you really want to override the file’s current MPT.  Click 
on the Yes button, and your newly selected MPT will be 
assigned to the truss. 

Changing the MPT Assigned to a Batch of Existing Trusses 
Follow these steps to change the MPT associated with an entire batch of existing truss files: 

1. Make sure that all truss files in the batch you wish to change are currently closed. 

2. Go to the menu bar and select Presets → System to open the System Presets dialog box. 

3. On the Files tab of the System Presets dialog box, select the MPT you wish to apply to your batch 
from the Material Priority Table drop-down list. 

4. Click in the Use Preset MPT checkbox to activate it. 

5. Click on the OK button to close the System Presets dialog box. 

6. Go to the menu bar and select File → Batch Process → Design to open the Batch Design dialog. 

7. From within the Batch Design dialog box, create or load the batch of truss files you wish to edit. 

Figure 150: Click Yes to overwrite the cur-
rent MPT settings with the System MPT. 
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8. Still within the Batch Design dialog box, navigate to the System Overrides section and make sure 
that the “MPT” checkbox is currently activated. 

9. Click on the OK button at the bottom of the Batch Design dialog box to begin running your 
batch.  As the batch runs, the previously assigned MPT file will be overwritten with the newly 
selected MPT. 

Material Selection Dialog 
Clicking on the Material menu’s Selection option opens the Material Selection tool 
shown in Figure 152 below.  This tool is used to for two purposes: 

1. To force the use of a particular material in the fabrication of specified 
portions of a truss. 

2. To specify the level at which the bumping process will be executed.  (That 
is, whether bumping is implemented for entire chords, chord segments, or 
chord pieces.) 

TOP CHORD 

Bump Whole Chord – When this radio button selected, GS Truss implements bumping at the chord 
level.  That is to say, if a single piece of the top chord fails load testing, the entire top chord is 
bumped to a sturdier grade of material. 

Bump by Segment – When this radio button selected, GS Truss bumps materials at the segment 
level.  If one segment fails only the failed segment is bumped instead of the entire chord. 

Bump by Piece – When this radio button selected, GS Truss bumps materials at the piece level.  In 
other words, if one piece fails, only the failed piece is bumped instead of an entire segment or the 
entire chord. 

Member – The Member field is read-only and displays each of the individual segments of the top 
chord of the active truss. 

  

Figure 152:  The Material Selection dialog box. 

Figure 151: Material 
Selection menu. 
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Material – The Material field contains a drop-down list of available materials that can be specified 
for use in the fabrication of each segment of the top chord.  Selection of materials in this column 
forces the use of those materials, and overrides any conflicting value selected in the “Bump by…” 
radio buttons for the Top Chord. 

BOTTOM CHORD 

Bump Whole Chord – When this radio button selected, GS Truss implements bumping at the chord 
level.  That is to say, if a single piece of the bottom chord fails load testing, the entire bottom chord 
is bumped to a sturdier grade of material. 

Bump by Segment – When this radio button selected, GS Truss bumps materials at the segment 
level.  If one segment fails only the failed segment is bumped instead of the entire chord. 

Bump by Piece – When this radio button selected, GS Truss bumps materials at the piece level.  In 
other words, if one piece fails, only the failed piece is bumped instead of an entire segment or the 
entire chord. 

Member – The Member field is read-only and displays each of the individual segments of the 
bottom chord of the active truss. 

Material – The Material field contains a drop-down list of available materials that can be specified 
for use in the fabrication of each segment of the bottom chord.  Selection of materials in this column 
forces the use of those materials, and overrides any conflicting value selected in the “Bump by…” 
radio buttons for the Bottom Chord. 

WEBS 

Force All – The Force All field contains a drop-down list of materials that can be specified for use in 
the fabrication of all web segments.  When a material is selected from this list, no other material will 
be available for web construction.  When the value “Unforce” is selected, GS Truss allows for the 
analysis and application of other materials for each web segment.  

Member – The Member field is read-only, and displays each of the individual web segments in the 
active truss. 

Material – The Material field contains a drop-down list of available materials that can be specified 
for use in the fabrication of each web segment. 

COMMAND BUTTONS 

OK – Clicking on the OK button saves all user-defined changes and closes the Material Selection 
window. 

Cancel – Clicking on the Cancel button discards all user-defined changes and closes the Material 
Selection window. 
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Note that when a material is forced, 
Piece View displays the affected truss 
segments in yellow, providing the user 
with a graphic representation of all 
areas within the truss that are subject to 
material forcing.  (See Figure 153 at 
right.) 

  Figure 153: Members with forced materials are displayed in yellow. 
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Chord Bracing 
As the name implies, the Chord Bracing function is used to define the type of 
bracing to be applied to the top and bottom chords of a truss.  To work with the 
chord bracing function, go to the GS Truss menu bar and select Material → Chord 
Bracing.  When you do so, GS Truss will open a Chord Bracing dialog box like the 
one pictured below. 

TOP CHORD BRACING 

Section – The read-only Section column displays the name of each segment of the top chord of the 
active truss. 

Bracing – The Bracing 
column contains a drop-
down list that is used to 
specify the type of bracing 
to be applied to each 
segment of the top chord 
of a truss.  The two 
potential values are: 

 Sheathed – When 
the Sheathed option is selected, bracing is provided solely by sheathing materials 
(continuous bracing), rather than through the use of purlins or battens. 

 Sparse – When the Sparse option is selected, purlins are used to provide discreet bracing at 
every panel point. 

Set Entire Chord – The drop-down list in the Set Entire Chord field is used to specify the bracing type 
to be applied to the top chord as a whole.  The value entered here overrides any conflicting values 
entered into rows in the Bracing column. 

BOTTOM CHORD BRACING 

Section – The read-only Section column displays the name of each segment of the bottom chord of 
the active truss. 

Bracing – The Bracing column contains a drop-down list that is used to specify the type of bracing to 
be applied to each segment of the bottom chord of a truss.  The two potential values are: 

 Sheathed – When the Sheathed option is selected, bracing is provided solely by sheathing 
materials (continuous bracing), rather than through the use of purlins or battens. 

 Sparse – When the Sparse option is selected, purlins are used to provide discreet bracing at 
every panel point. 

Set Entire Chord – The drop-down list in the Set Entire Chord field is used to specify the bracing type 
to be applied to the bottom chord as a whole.  The value entered here overrides any conflicting 
values entered into rows in the Bracing column. 

Figure 154: The Chord 
Bracing menu entry. 

Figure 155: The Chord Bracing dialog box. 
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WORKING WITH TRUSS-TO-TRUSS CONNECTION TABLES 

The Parts of a Table 
As the name implies, Truss-to Truss Connection Tables (TTCs) are used to specify the connections 
between carried trusses and the girders that carry them.  Below is an example of a Truss-to-Truss 
Connection Table along with an explanation of the columns of which it is comprised. 

NOTE!  Within this document, the terms “carrying truss” and girder are used interchangeably.  
This is due to fact that a girder can, itself, be connected to and supported by another girder.  
In such an instance, the supported girder would be referred to as a “carried truss”, while 
the supporting girder would be referred to as a “carrying truss.” 

ID – The ID column displays the label used to identify a connection between two trusses; a Carried 
Truss and its Carrying Truss (girder).  If there are multiple connection points between these two 
trusses, the same ID will be repeated for each row in the table that represents a unique connection 
between the two. 

Carrying Truss – The Carrying Truss column displays the unique identifier assigned to the Carrying 
Truss (girder) in a truss-to-truss relationship. 

Figure 156: An example of a Truss-to-Truss Connection Table. 
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Offset – The first of the two Offset columns in the TTC represents the placement of a Carried Truss, 
in the horizontal plane (left/right), along the bottom chord of its Carrying Truss.  If the Carried Truss 
is aligned with the left-most end of the Carrying Truss (as displayed on the GS Truss Main Screen), 
the offset is zero (0-0-0). 

V Offset – The first of the two Vertical Offset columns in the TTC represents the distance that the 
connector on the Carried Truss is raised above the bottom chord of the Carrying Truss.  This 
measure is displayed on screen in each of the various views of the Carrying Truss. 

Carried Truss – The Carried Truss column displays the unique identifier assigned to the Carried 
(supported) Truss in a truss-to-truss relationship. 

Offset – The second of the two Offset columns in the TTC is used to define the position of the 
connector on the Carried Truss, in the horizontal plane (left/right).  Generally speaking, the 
connector is usually placed at one end of the truss or the other. 

V Offset – The second of the two Vertical Offset columns in the TTC represents the distance the 
given connector is raised above the bottom chord of the Carried Truss. 

Angle – This column defines the angle at which the Carried Truss attaches to its Carrying Truss.  You 
can select one of the predefined values from the drop-down list, or type in a value of your own 
choosing.  Predefined values for this field include the following: 

 45 deg 
 90 deg 
 135 deg 

 225 deg 
 270 deg 
 315 deg 

Truss Connection – This field is used to specify the type of connection made between a Carried Truss 
and its Carrying Truss.  There are three potential values: 

 Chord to Chord – The connection between the Carried Truss its Carrying Truss is made on 
the chords of each. 

 Web to Web Flange – The connection between the Carried Truss its Carrying Truss is made 
from the Web Face of one truss to the Web Flange of the other. 

 Web to Web Face – The connection between the Carried Truss and the Carrying Truss is 
made from the Web Face of one truss to the Web Face of the other. 
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Creating a New Table 
There are two different ways to create a Truss-to-Truss Connection Table in GS Truss; the automated 
way and the manual way. 

CREATING A TABLE AUTOMATICALLY 

The easiest and quickest way to create a Truss-to-Truss Connection Table is to 
create your trusses in the GS Plan application first, and then import them into GS 
Truss.  (For information about designing and outputting trusses in GS Plan, please 
refer the GS Plan Designer’s Manual.)  Once your trusses have been designed and 
output from GS Plan, perform the following actions to import them into GS Truss 
and create a TTC automatically: 

1. Open the GS Truss application. 

2. From within the Projects pane in GS Truss, locate the job folder associated 
with your trusses. 

3. From within the job folder, double click on the LDG file associated with 
that job.  Note that the name of this file will be the same as that of the job 
folder, and the icon associated with the file will look like this       .  (See the 
Senior Center file in the job shown in Figure 157 at right.) 

4. When you double click on the LDG file, GS Truss will create copies of all the 
truss files associated with the job in its own native (KTS) format.  The icons 
representing these new files will appear blue in color, as pictured in Figure 
158 at right.  In addition to the new truss files, GS Plan will also 
automatically create a Truss-to-Truss Connection Table (TTC) file, 
represented by a blue icon that looks like this       . 

5. Double click on the new TTC file to open the Truss-to-Truss Connection 
Table that GS Truss has created for you. 

CREATING A TABLE MANUALLY 

If you are creating trusses from scratch using the GS Truss application, you will 
need to create a Truss-to-Truss Connection Table manually.  There are numerous 
variables that can affect this procedure, however, the basic workflow is as follows:  

1. From within the GS Truss application, go to the menu bar and click on File 
→ New TTC.  A blank TTC table will open, containing only the column 
headers for the new TTC. 

2. To define your first connection, return to the GS Truss menu bar and select 
TTC → Add Connection, or click on the New Connection icon on the GS 
Truss toolbar.  A single, blank row will be added to the TTC. 

  

Figure 157: LDG file 
imported from GS Plan. 

Figure 158: A TTC file. 
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3. With your 
first, blank 
row now 
added to the 
table, return 
to the GS 
Truss menu 
bar a select 
File → Save, or 
click on the 
Save button 
on the GS 
Truss toolbar.  
A Save As 
dialog box like 
the one 
pictured at 
right will 
open. 

4. From within the Save As dialog box, type in a name for your new TTC file in the File Name field. 

5. Next, click on the OK button to save your file and close the Save As dialog box.  Your new TTC file 
will now be displayed in the Projects pane, along with the other files associated with your job. 

6. Within the new TTC table, navigate to the ID column.  Click on the down-arrow in this column 
and select New.  GS Truss automatically enters the name of this first new connection as “TT1.” 

7. Next, click on the down arrow in the Carrying Truss column.  GS Truss will display a list of all 
trusses associated with the current job.  From this list, select the truss that is to serve as the 
girder for this new connection. 

8. Navigate to the Carried Truss field and, from the list of trusses presented, select the truss that is 
to be joined to the girder selected in the Carrying Truss field. 

9. Enter the desired values in the remaining columns for this row. 

10. Add an additional row for each connection to be made between trusses and girders associated 
with this job. 

11. When you are done, click once again on the Save button on the GS Truss toolbar. 

Updating a Table 
If changes are made to any of your trusses once a TTC has been created, then the TTC must be updated 
to reflect those changes and ensure their viability.  To accomplish this task, go to the GS Truss toolbar 
and click on the Analyze icon to re-run the analysis process.  (Note that we recommend using the 
Analyze function rather than the Design function in this instance, since this latter process can introduce 
additional changes to the design of your trusses.) 

Figure 159: Save your new TTC file using the Save As dialog box. 



 

137 

 

Modifying a Table 
If you modify a Truss-to-Truss Connection Table after it has been created, you must ensure that: 1) the 
changes made to the table are reflected in the trusses, and 2) that the trusses still successfully pass the 
analysis process.  Therefore, once you have completed making changes to a TTC, perform the following 
actions: 

1. Go to the GS Truss menu bar and click on TTC → Analyze, or click on the Analyze button on the 
GS Truss toolbar. 

2. A message box like the one pictured at right will 
open.  Click on the Analyze Affected button.  GS Truss 
will re-run the analysis process. 

3. Any trusses that fail the analysis process as a 
consequence of changes made to the TTC will be 
identified in the Batch Log tab of the GS Plan Data 
Window.  Rework the entries in your TTC as needed,  
until all trusses successfully pass analysis. 

 
 

 
 
 
 
  

Figure 160: Be sure to re-analyze trusses after 
making changes to a TTC. 
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WORKING WITH PLATE PRIORITY TABLES 

PPTs, MPTs and Material Databases 
Like Material Priority Tables (MPTs), Plate Priority Tables (PPTs) represent a subset of the data in a 
Material Database.  However, where MPTs are used to specify the materials that can be used in the 
construction of truss chords and webs, PPTs are used to specify the plate materials that can be used in 
the construction of the various joint types on a truss.  Once again, like Material Priority Tables, Plate 
Priority Tables can be modified on a system-wide basis (for all trusses using a given Material Database), 
or on a truss-specific basis. 

Modifying a System PPT 
To modify a Plate Priority Table on a system-wide basis, perform the following actions: 

1. Go to the GS Truss menu bar and click on Presets → System.  A System Presets dialog box will 
open. 

2. From within the 
System Presets 
dialog box, click on 
the Edit MPTs 
command button.  
This will open a 
System MPTs Editor 
dialog box like the 
one pictured in 
Figure 161.  Using 
the Priority Tables 
drop-down list in this 
dialog box, we need 
to select an MPT 
associated with a 
Material Database 
that contains plates.  
In this instance, we 
have selected the 
CapCee_MPT.  This 
will allow us to modify plate materials in the associated Capped Cee Material Database. 

NOTE! Not all Material Databases have a PPT associated with them.  If plate functionality is not 
available for a given Material Database, then the Edit PPT will not be visible in the MPT Editor 
dialog box. 

 

Figure 161:  The Material Priority Table Editor dialog box for System MPTs. 
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3. From within the System MPTs Editor dialog box, click on the Edit PPT command button to open a 
System PPT Editor dialog box like the one pictured in Figure 162.  The various parts of the System PPT 
Editor dialog box are described as follows: 

Priority Tables – The 
Priority Tables field 
provides a drop-down list 
of all system level 
Material Priority Tables 
currently available in GS 
Truss. 

Material Database – This 
read-only field displays 
the name of the Material 
Database associated with 
the Material Priority 
Table (MPT) that has 
been selected in the 
Priority Tables field of 
this dialog box. 

Connection Database – 
The information displayed in this read-only field is used exclusively by Keymark for version-
identification purposes and has no practical application for designers. 

Joint Type – The Joint Type field provides a drop-down list of the various types of truss joints to 
which specific plate materials can be assigned.  The potential values in this drop-down list include: 

6. End of  Chord 
7. Smooth Chord 
8. Full Closed Pitch Break 
9. Half Closed Pitch Break 
10. Full Open Pitch Break 

11. Half Open Pitch Break 
12. Studio 
13. Heel 
14. Interior 

Material ID – The read-only Material ID column displays a list of all plate materials available in the 
current Connection Database.  These materials are listed in order of their bumping sequence.  This 
bumping sequence starts with the plate at the top of the list and then progresses down, one plate at 
a time, until a plate that satisfies loading requirements is identified, or the list of plate materials is 
exhausted – whichever comes first. 

Active – The Active checkbox dictates whether or not a plate is included in the material-bumping 
process.  When checked, the material is included in bumping; when unchecked, the material is not 
included in bumping. 

COMMAND BUTTONS 

All On – Clicking the All On command button makes all plate materials Active in the bumping process 
for the selected Joint Type. 

Figure 162:  The Plate Priority Table Editor dialog box for System PPTs. 
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All Off – Clicking the All Off command button excludes all plate materials from the bumping process 
for the selected Joint Type. 

Quick Modify – Clicking on the Quick Modify command button opens a dialog box that allows the 
user to modify the availability of Plates and Mils for all Joint Types simultaneously, rather than one 
Joint Type at a time.  For more information about using the Quick Modify function, please see “Using 
the Quick Modify Function” section below. 

OK – Clicking on the OK button saves all user-defined changes to the PPT and closes the Plate 
Priority Table Editor dialog box. 

Cancel – Clicking on the Cancel button discards all user-defined changes to the PPT and closes the 
Plate Priority Table Editor dialog box. 

Using the Quick Modify Function 
As mentioned above, the Quick Modify function 
allows users to modify the plates available for all Joint 
Types simultaneously, rather than one Joint Type at a 
time.  When a user clicks on the Quick Modify button, 
a Quick Modify PPT dialog box like the one pictured in 
Figure 163 will open.  The features and functions of 
this dialog box are as follows: 

Activate vs. Deactivate – The Activate and 
Deactivate radio buttons are used to turn selected 
values in the Plate and Mil panes on or off for the 
selected Joint Types.  When Activate is selected, 
all Plate and Mil values with a checkmark are 
included in the bumping process for the selected 
Joint Types.  When Deactivate is selected, all Plate 
and Mil values with a checkmark are excluded 
from the bumping process for the selected Joint 
Types. 

Joint Type 
The Joint Type pane contains a checkbox for each of the nine potential categories of joints in a truss, 
which includes: 

1. End of Chord 
2. Smooth Chord 
3. Full Closed Pitch Break  
4. Half Closed Pitch Break 
5. Full Open Pitch Break 

6. Half Open Pitch Break 
7. Studio 
8. Heel 
9. Interior 

All On – Clicking the All On button under Joint Types will place a checkmark in the checkbox for 
every Joint Type. 

Figure 163:  The Quick Modify PPT dialog box. 
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All Off – Clicking the All Off button under Joint Types will remove checkmarks from all checkboxes in 
the Joint Types pane. 

Plate 
The Plate pane provides a list of all plate sizes available in the PPT. 

All On – Clicking the All On button in the Plate pane will place a checkmark in the checkbox for every 
plate size available in the PPT. 

All Off – Clicking the All Off button in the Plate pane will remove checkmarks from all checkboxes in 
the Plate pane. 

Mils 
The Mils pane provides a list of all plate thicknesses available in the PPT. 

All On – Clicking the All On button in the Mils pane will place a checkmark in the checkbox for every 
plate thickness available in the PPT. 

All Off – Clicking the All Off button in the Mils pane will remove checkmarks from all checkboxes in 
the Mils pane. 

OTHER COMMAND BUTTONS 

Do – Clicking on the Do button will save all user-defined changes and close the Plate Priority Table 
Editor dialog box. 

Cancel – Clicking on the Cancel button will discard all user-defined changes and close the Plate 
Priority Table Editor dialog box. 
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Editing a Truss-Specific PPT 
To edit the PPT for a specific truss, begin by making sure that the truss file is open, active, and unlocked.  
Once this is done, go to the menu bar and select Material → Edit MPT.  This will open an MPT Editor 
dialog box for the current truss, like the one pictured in Figure 164.  (As can be seen, the title bar of this 
dialog box indicates that you are using the Material Priority Table Editor for the Current Truss, rather 
than the System MPT.)  Click on the Edit PPT button to open the Plate Priority Table Editor dialog box for 
your specific truss.  The steps for editing a truss-specific PPT are the same as those, presented above, for 
editing a system-wide PPT.

 

  

Figure 164:  A truss-specific Material Priority Table Editor dialog box. 
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WORKING WITH GS TRUSS LOAD CASES 

The Case for Load Cases 
If you want to know how your truss designs are going to hold up in the real world, then you will need to 
put them through their paces using GS Truss load cases.  From standard live and dead loads, to snow 
loads, wind loads, and drag loads, GS Truss will let you know if your trusses pass muster.  The process 
begins with the selection of the load types you would like to apply, along with the configuration of those 
loads. 

Load-Tool Options 
There are three options for creating and editing load cases in GS Truss, all 
of which are accessed from the Loads option on the menu bar, as 
pictured at right: 

1. User Load Input Macro – Fairly limited in functionality, the User 
Load Input Macro tool can be used to: 
 Change the default values associated with Standard/Auto Loads. 
 Add point loads or additional distributed loads to the default Roof Live Load and the 

default Dead Load. 
 Create new load cases using a limited set of variables. 

2. User Load Cases/Combos – The User Load Cases/Combos tool provides a comprehensive 
environment for viewing, creating, and editing load cases, as well as for creating unique 
combinations of those load cases for testing purposes. 

3. Drag Load – The Drag Load option is used to define lateral loads, imposed by wind or 
earthquakes, which must be resisted by a structure. 

         TIP!  In the User Load Cases/Combos tool, the default Roof Live Load is referred to as “Lr1: Std  
         Live Load.”  In the User Load Input Macro, the default Roof Live Load is referred to as “1.”     
         Changes made to this load case using one tool are automatically reflected in the other tool. 

When working with GS Truss load tools, there are a few basic principles to keep in mind: 

 User-defined load cases and combinations are truss specific and cannot be applied to multiple 
trusses or a batch. 

 The loads associated with a truss cannot be edited unless the truss file is unlocked. 

 The analyze/design process must be re-run after a new load is created or an existing load is 
modified. 

 Users cannot delete any of the load cases that come standard in GS Truss. 

        NOTE!  If a user fails to design for a load case that is specified by code, GS Truss automatically  
       adds a note to all Plot Drawings that states, “Truss not engineered for all code specified loads.” 

Figure 165: The Loads menu. 
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The User Load Input Macro 
The User Load Input Macro tool is accessed from the Loads menu, as 
pictured at right.  As mentioned earlier, this tool is somewhat limited in 
functionality.  It is designed for quick entry of load data, and is used as an 
alternative to the User Load Cases/Combinations entry screen for those 
instances where: 

 You wish to create or modify loads that are to be applied to chords 
only (not webs). 

 The specific panel points where point loads are to be applied already exist on the truss. 

 You are only interested in working with or modifying values for the standard Roof Live Load, or 
creating new live and/or dead loads. 

In order to facilitate quick entry, some assumptions and restrictions have been put in place for the User 
Load Input Macro.  They are as follows: 

 Each defined load contains both live and dead loads. 

 Each load is assigned point numbers; a single point for point loads, and multiple points for 
distributed loads.  Dimensions cannot be used for the application of loads using the User Load 
Input Macro.  Therefore, if a point does not exist on a truss in the position where a load is to be 
applied, that load must be entered using the User Load Cases/Combinations tool instead of the 
User Load Input Macro. 

 Because loads defined using the User Load Input Macro are based on points, if points are altered 
because of changes to truss geometry, loads that were already in existence will no longer be 
valid.  For this reason, it is strongly recommended that loads not be applied until the geometry 
of the truss is stable. 

 Live distributed loads using the directions Up, Down, 
Left, or Right are assumed to be projected loads.  
(That is, loads applied relative to the horizontal 
plane.  See Figure 167 at right.)  Live distributed 
loads using the directions Normal Up, Normal Down, 
Parallel Left, or Parallel Right are assumed to 
be rake loads.  (That is, loads applied in line with, or 
perpendicular to, the angle of the member receiving 
the load.  See Figure 168 at right.)   

 Point loads have an assumed tributary width of zero.  

 As stated previously, web loading cannot be done 
using the User Load Input Macro tool.  Loads for 
webs must be entered using the User Load 
Cases/Combinations tool. 

 Because of its load type and tributary width 
assumptions, loads created with the User Load Input  
Macro tool should only be edited with the User Load  
Input Macro tool. 

 Loads created using the User Load Cases/Combinations tool are not viewable within the User 
Load Input Macro. 

  

Figure 167:  Projected loads. 

Figure 168:  Rake loads. 

Figure 166: Accessing User Load 
Input Macro via the Loads Menu. 
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         WARNING!  If you modify an existing load case for a  
          truss (or create a custom load case) using the User 
Load Cases/Combinations tool, and you subsequently 
attempt to open the User Load Input Macro tool, you will 
receive an error message like the one pictured at right. 

THE INTERFACE 

When you select the User Load Input Macro option from the menu bar, GS Truss opens a window that 
contains a diagram of your truss in Element View, along with the User Load Input Macro window 
pictured in Figure 170 below.  We will now turn our attention to a detailed examination of this window. 

1. Top Chord Live – The Top Chord Live field is used to enter the load produced by the use and 
occupancy of a building, as it applies to the top chord of a truss. 

2. Top Chord Dead – The value entered into the Top Chord Dead field represents the permanent, 
unmoving load applied to the top chord of a truss. 

3. Bottom Chord Live – The Bottom Chord Live field is used to enter the load produced by the use 
and occupancy of a building, as it applies to the bottom chord of a truss. 

4. Bottom Chord Dead – The value entered into the Bottom Chord Dead field represents the 
permanent, unmoving load applied to the bottom chord of a truss. 

5. Trib Width – This field defines the width of the Tributary to which distributed loads will be 
applied.  (Point loads have an assumed tributary width of zero.) 

6. Return to Main – Clicking on the Return to Main command button closes the User Load Input 
Macro window and returns the user to the main GS Truss window. 

7. Load Case – This field displays the GS Truss-assigned number associated with the active load 
case.  Note that user-generated load cases that were created using the User Load Cases/Combos 
tool are not visible in this drop-down.         

         TIP!  The values initially listed under the top chord and bottom chord live and dead load  
         fields are those defined under the Standard/Auto Loads tab of Engineering/Design Presets.   
         Changing a value in the User Load Input Macro window also changes the value in this preset. 

Figure 169: Error attempting to use the User Load 
Input Macro tool. 

Figure 170: Numbers presented here in the User Load Input Macro window correspond with those of the descriptions below. 
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8. Roof Live Load Case – When this checkbox is activated, the user-created point loads and 
distributed loads associated with the current load case are applied as Roof Live Loads.  The value 
associated with this checkbox (that is, checked or unchecked) is defined at the time a new load 
case is created and it cannot be altered thereafter. 

Load Case Command Buttons 
9. New – When the New button is clicked, a new load case number is added to the Load Case drop-

down list, and the newly created load case becomes active.  Load-case numbers are assigned by 
GS Truss automatically, in sequence, and cannot be modified by users. 

10. Delete – Clicking on the Delete command button erases the load case currently displayed in the 
Load Case drop-down list. 

11. Copy – This command button creates a duplicate copy of the load case currently displayed in the 
Load Case drop-down list.  The copied version can then be modified as necessary to meet the 
user’s needs. 

12. Reset – If you have deleted one or more point loads or distributed loads from the active Load 
Case, you can click on the Rest button to restore them in their entirety.  That said, however, if 
you click on the Return to Main button without clicking on the Reset button first, the deleted 
point loads and distributed loads will be gone for good. 

Point Loads 
13. Point – The Point column is used to enter the truss panel point to which a load will be applied. 

14. Dir – The Direction column defines the path along which a load will be applied.  The list of 
potential values in the column’s drop-down includes: Down, Up, Left, Right, N Up, N Down,  
P Left, and P Right.  For more information about the directions in which point loads may be 
applied, see Figures 167 and 168 on page 144. 

15. Live Load – The Live Load column defines the total weight of the load, produced by the use and 
occupancy of a building, which is to be applied to the specified panel point. 

16. Dead Load – The Dead Load column defines the total weight of the permanent, unmoving load 
that is to be applied to the specified panel point. 

17. Add Pt Ld – Clicking on the Add Point Load command button adds a blank row to the Point Loads 
section of the window.  By entering values into the columns associated with this new row, the 
user creates a new point load that is added to the active Load Case. 

Figure 171: Numbers presented here in the User Load Input Macro window correspond with the descriptions below. 
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18. Delete Pt Ld – Clicking on the Delete Point Load button erases the currently selected Point Loads 
row from the active Load Case. 

19. Clear Pt Ld – When the Clear Point Loads button is clicked, all rows are deleted from the Point 
Loads section of the window. 

Distributed Loads 
20. Pt1 – The Point 1 column defines the location where the application of a load is to begin. 

21. Pt2 – The Point 2 column defines the location where the application of a load is to end. 

22. Dir – The Direction column defines the path along which a load will be applied.  The list of 
potential values in the column’s drop-down includes: Down, Up, Left, Right, N Up, N Down,  
P Left, and P Right.  For more information about the directions in which point loads may be 
applied, see Figures 167 and 168 on page 144. 

23. Type – The Type column defines the breadth of the surface to which a load will be applied.  
There are two potential values: 

 Area – When the Area option is selected, the distributed load will be applied to the line 
extending from Point 1 to Point 2, as well as to the tributary on either side of that line. 

 Line – When the Line option is selected, the distributed load will be applied in a direct 
line extending from Point 1 to Point 2.  The load will not be applied to the tributary on 
either side of that line. 

24. Live Load – The Live Load column defines the total weight of the distributed load, produced by 
the use and occupancy of a building. 

25. Dead Load – The Dead Load column defines the total weight of the permanent, unmoving, 
distributed load that is to be applied. 

26. Add Dist Ld – Clicking on the Add Distributed Load command button adds a blank row to the 
Distributed Loads section of the window for the currently selected Load Case.  By entering 
values into the columns associated with this new row, the user creates a new distributed load 
that is added to the active Load Case. 

27. Delete Dist Ld – Clicking on the Delete Distributed Load button erases the currently selected 
Distributed Loads row from the active Load Case. 

Figure 172: Numbers presented here in the User Load Input Macro window correspond with those of the descriptions below. 
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28. Clear Dist Ld – When the Clear Distributed Loads button is clicked, all rows are deleted from the 
Distributed Loads section of the window. 

User Load Cases/Combinations 
The User Load Cases/Combinations tool is accessed from the Loads menu, 
as pictured at right.  The User Load Cases/Combinations tool allows users 
to view and edit load cases, and to apply those load cases in various 
combinations.  Users can create as many load cases as needed, and each 
load case can include multiple point loads and distributed loads.  Use the 
User Load Cases/Combinations tool when you wish to: 

 Apply a point load to an area of a truss for which a panel point does not currently exist. 
 Apply loads to webs. 
 View detailed specifications for an existing load case. 
 View a load case that was created previously with User Load Cases/Combinations. 
 Define different combinations of loads to be applied. 
 Use dimensions instead of points to define a load. 
 Create custom names for new load cases. 
 Add one or more point loads or distributed loads to the Standard Live Load (Lr1) or Standard 

Dead Load (D1) cases. 
 Create new, custom load cases consisting of one or more point loads and/or distributed loads. 

LOAD CASE EDIT TAB 

The Load Case Edit tab is used to create and modify individual load cases.  Following is a brief 
description of the various parts of this window. 

1. Load Case – The Load Case drop-down provides a list of GS Truss standard load cases, along with 
all of the custom load cases created using the User Load Cases/Combinations tool.  The standard 
load cases displayed in this drop-down list depend on the types of standard loads users have 
activated in their Engineering/Design Presets.  With regard to the standard load cases that are 
listed, only the Standard Live Roof Load (Lr1) and Standard Dead Load (D1) cases can be 
modified directly by users.  Point loads and distributed loads can both be added to the Lr1 and 
D1 load cases, however, the pre-populated distributed loads for Lr1 and D1 cannot be modified.  
(Lr1 and D1 load cases are applied to all trusses.)  Although the remaining standard load cases 
cannot be edited directly, users can elect to make a copy of any of these cases, and the copied 
versions can be altered as needed to suit the user’s requirements. 

Figure 173: The User Load 
Cases/Combos menu option. 

Figure 174: Numbers presented in this figure correspond with the descriptions provided below. 
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        TIP!  The values associated with the Lr1 and D1 load cases are initially defined in the user’s  
        Engineering/Design Presets, under the Standard/Auto Loads tab. 

2. Description – The Description field contains a narrative explanation of the purpose and/or 
application of the selected load case.  Description field values cannot be edited for any of the 
standard load cases. 

3. Type – The Type field defines the kind of load to be applied.  Type field values cannot be edited 
for any of the standard load cases.  The list of potential values in this drop-down includes: 
 Dead 
 Live 
 Roof Live 
 Wind 
 Snow 

 Earthquake 
 Rain 
 Live-10* 
 Drag 
 Ice Dam 

4. New – Clicking on the New command button opens a New Load 
Case dialog box like the one pictured at right.  Type in a name for 
your new load case in the Description field, and select the kind of 
load to be created from the Type drop-down list.  Potential Type 
values include: 
 Dead 
 Live 
 Roof Live 
 Wind 
 Snow 
 Earthquake 
 Rain 

5. Copy – Clicking on the Copy button opens a Copy Load Case dialog 
box like the one pictured at right.  Enter a new name for the 
copied load case in the Description field of this dialog box and then 
click on the OK button to complete the Copy process.  Once the 
Copy has been created, it can be modified as needed to meet the 
user’s requirements. 

6. Delete – Click on the Delete button to erase the active  
load case entirely (including both point loads and 
distributed loads).  Before the load case is deleted, GS 
Truss will display a warning message like the one 
pictured at right.  Click on the Yes button to confirm and 
complete the deletion.  Click on the No button to cancel 
the deletion process.  Note that only user-defined 
(custom) load cases can be deleted; GS Truss standard 
load cases cannot be deleted. 

 
  

Figure 175: The New Load Case 
dialog box. 

Figure 176: The Copy Load Case 
dialog box. 

Figure 177: Click OK to confirm deletion of 
your Load Case. 
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Point Loads 
As the name implies, Point Loads are applied to a specific spot on a truss member.  As shown in Figure 
178 below, there are six property columns and three command buttons associated with Point Loads: 

7. Mbr – The Member column defines the specific truss Member to which a load is to be applied.  
Note that the values displayed in this drop-down list depend upon the composition of the truss 
file that is currently active.  At a minimum, the list of values will include the following: 

 Top – The top chord 

 Bot – The bottom chord 

 Web n – A numbered list of webs 

8. Len – The Length column displays the overall span of the truss member to which a load will be 
applied.  The Length value is inserted by GS Truss automatically, based on the truss member 
selected in the Mbr field. 

9. Loc – The Location column identifies the specific dimension where the load will be applied.  If 
the truss member selected in the Mbr field has only one point, this field is populated 
automatically.  If the selected truss member has multiple points, Location information must be 
entered into this field manually. 

29. Dir – The Direction column defines the path along which the load will be applied.  The list of 
potential values in this drop-down includes: Down, Up, Left, Right, N Up, N Down, P Left, and  
P Right.  For more information about the directions in which point loads may be applied, see 
Figures 167 and 168 on page 144. 

10. Trib – The Trib field is used to specify the width of the point load. 

11. Load – The Load column specifies the total weight of the Load to be applied. 

12. Add Pt Ld – Clicking on the Add Point Load command button adds a blank row to the Point Loads 
section of the window.  By entering values into the columns associated with this new row, the 
user creates a new point load that is added to the active Load Case. 

13. Delete Pt Ld – Clicking on the Delete Point Load button erases the currently selected Point Loads 
row from the active Load Case. 

14. Clear Pt Ld – When the Clear Point Loads button is clicked, all rows are deleted from the Point 
Loads section of the window. 

Figure 178: Numbers presented in this figure correspond with the descriptions provided below. 
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Distributed Loads 

15.  Mbr – The Member column defines the specific truss Member to which a load is to be applied.  
Note that the values displayed in this drop-down list depend upon the composition of the truss 
that is currently active.  At a minimum, the list of values will include the following: 

 Top – the top chord 
 Bot – the bottom chord 
 Web n – a list of numbered webs 

16. Cont – If the Continuous checkbox is activated, the defined load is applied “continuously” along 
the entire length of the specified truss member.  If the Continuous checkbox is not activated, the 
user must manually enter a Start Location and an End Location for the applied load. 

17. Len – The Length column displays the overall Length of the truss member to which a load will be 
applied.  The length value is inserted by GS Truss automatically, based on the member selected 
in the Mbr field. 

18. S Loc – The Start Location column defines the specific location on a truss member where the 
application of a load is to start, as measured from the left end of that truss member.  Note that 
the Start Location (S Loc) column is disabled if the Continuous checkbox is activated. 

19. E Loc – The End Location column defines the specific location on a truss member where the 
application of a load is to end, as measured from the left end of that truss member.  Note that 
the End Location (E Loc) column is disabled if the Continuous checkbox is activated. 

20. Dir – The Direction column defines the path along which a load will be applied.  The list of 
potential values in this drop-down includes: Down, Up, Left, Right, N Up, N Down, P Left, and  
P Right.  For more information about the directions in which distributed loads may be applied, 
see Figures 167 and 168 on page 144. 

 
  

Figure 179: Numbers presented in this figure correspond with the descriptions provided below. 
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Figure 181:  A Rake Spread receives a greater load 
than a Projected Spread. 

Distributed Loads (continued) 

21. Spread – As pictured in Figure 181, the Spread column is used to define the total surface to 
which a load will be applied.  There are two potential values: 

 Proj – A Projected Spread is applied in 
relation to the horizontal plane. 

 Rake – A Rake Spread is applied along the 
full length of the member receiving the 
load.  

Note that, since loads are applied per linear or 
square foot (or the metric equivalent), the total 
load applied to a web will be greater when Rake is 
specified as the Spread, rather than Projected. 

22. Type – The Type column indicates the expanse to which the load will be applied.  The potential 
values are: 

 Area – When the Area option is selected, the load is applied to both the truss member 
and to the width of its associated tributary area. 

 Line – When the Line option is selected, the load is applied along the length of the truss 
member only, and does not include the tributary area. 

23. Trib – The Trib field defines the width of the tributary area to which a distributed load will be 
applied. 

24. Start Load – The Start Load column defines the weight of the load at its starting point on the left 
side of the target truss member. 

25. End Load – The End Load column defines the weight of the load at its end point on the right side 
of the target truss member. 

26. Add Dist Ld – Clicking on the Add Distributed Load command button adds a blank row to the 
Distributed Loads section of the window for the currently selected Load Case.  By entering 
values into the columns associated with this new row, the user creates a new distributed load 
that is added to the active Load Case. 

27. Delete Dist Ld – Clicking on the Delete Distributed Load button erases the currently selected 
Distributed Loads row from the active Load Case. 

Figure 180: Numbers presented in this figure correspond with the descriptions provided below. 
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28. Clear Dist Ld – When the Clear Distributed Loads button is clicked, all rows are deleted from the 
Distributed Loads section of the window. 

29. OK – Clicking on the OK button will save your changes and close the User Load Cases/Combin- 
ations tool. 

30. Cancel – Clicking on the Cancel button will discard your changes and close the User Load 
Cases/Combinations tool. 

        WARNING!  If you attempt to open the User Load  
          Input Macro tool after creating new load cases    
    using the User Load Cases/Combos tool, a warning 
message like the one pictured in Figure 182 will open. 

LOAD COMBINATIONS TAB 

The Load Combinations tab has three sections.  The left side of the screen contains Default Load 
Combinations.  These are all of the load combinations that GS Truss creates automatically.  The top-right 
side of the screen holds Custom Load Combinations.  These are the load combinations created by users.  
The bottom-right side of the screen contains Descriptions of the various load cases. 

Default Load Combinations 
The Default Load Combinations pane provides a listing of all the standard-load-case combinations 
available for your truss.  You can click on the “plus” sign (+) next to a folder to expand that folder 
and view its contents.  All of the load-case-combination checkboxes that are activated will be 
included in load testing; those left unchecked will be ignored. 

  

Figure 182: Error attempting to use the User Load 
Input Macro tool. 

Figure 183: The Load Combinations tab. 
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Custom Load Combinations 
The Custom Load Combinations pane is used to create 
load combinations of your own design. 

Combo ID – The Combo ID column is used to enter a 
unique identifier for each user-created custom load 
combination.  As pictured in Figure 185 below, custom 
Combo IDs appear at the bottom of the drop-down list 
of available load combinations displayed in Applied 
Loads View. 

Factor – The value entered into the Factor column is 
used to calculate the percentage of each particular load type (listed in the columns to the right) to 
be applied.  The default Factor value is 1.0, which translates as 100%. 

[Load Case Columns] – To the right of the Factor column, there is an additional column for each 
standard load case that has been activated in the user’s Engineering/Design Presets.  Users are to 
enter the percentage of each load case to be applied into the corresponding column.  Columns with 
no value entered will not be applied. 

EXAMPLE:  For Custom Load Combinations, the actual percentage of the load that is applied for any 
given load case is calculated as the value entered into that load case column, multiplied by the value 
entered into the Factor column.  So if, for example, a user entered a value of .5 (50%) into the load 
case column, and a value of 1.0 (100%) into the Factor column, the actual percentage of the load 
applied would be .5 x 1.0, or .5 (50%).  If a user entered a value of .5 (50%) into a load case column, 
and a value of .5 (50%) into the Factor column, the actual percentage of the load applied would be .5 
x .5, or .25 (25%). 

Add – When the Add button is clicked, a new row is inserted into the Custom 
Load Combinations section of the window.  By entering values into the 
columns associated with this new row, the user creates a new load-case 
combination that will appear at the bottom of the drop-down list of available 
load combinations displayed in Applied Loads View.  (See Figure 185 at right.) 

Delete – When the Delete button is clicked, the active row in the Custom 
Load Combinations pane is erased. 

Clear – When the Clear button is clicked, all Custom Load Combinations are 
deleted for the active truss. 

Load Case Descriptions 
The Load Case Descriptions pane provides a read-only narrative explanation 
of all standard and custom load cases available for the active truss. 

  

Figure 185: Custom 
Load Combina-tions 
shown in Applied Loads 
View. 

Figure 184: The Custom Load Combinations pane. 
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Drag Load  
The Drag Load menu option is used to add a lateral load to a truss, such as 
that resulting from an earthquake.  Clicking on this menu option opens 
the Drag Load dialog box, pictured in Figure 187. 

Apply Drag Load – Click in the Apply Drag Load checkbox to activate the 
Drag Load option.  Once activated, two different drag loads – Case 
LDrag1 and Case LDrag2 – will be displayed in the Load Combo drop-
down list available in Applied Loads View.  (See Figure 188 below.)  
These two load cases are identical except for the fact that the load 
associated with Case LDrag1 is applied from left to right, whereas the 

load associated with Case LDrag2 is applied from right to left. 

 
Required Drag Load Reaction – Enter the value of the full drag load to be applied 
across the entire span of the truss.  

  

 

 

 

 
  

Figure 187: The Drag Load dialog. 

Figure 186: The Drag Load menu 
option. 

Figure 188: Drag Loads 
in Applied Loads View. 
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Applied Loads View 
Once loads have been created and configured, they can be reviewed in action  
using the GS Truss Applied Loads View.  There are two ways to open the Applied 
Loads View window: 
 From the menu bar select View → Load View. 
 From the View toolbar, click on the Applied Loads View icon. 

Regardless of the method you use, the Applied Loads View window will open, 
looking similar to the one pictured below.  The parts of the Applied Loads View 
window are as follows: 

1. Menu Bar – The menu bar in the Applied Loads View window has only  
two listings: 

View – The View menu  
provides two options.  
Zoom Window allows 
users to select a specific 
area of a diagram to 
enlarge.  The Zoom Full 
function enlarges the 
diagram to the maximum 
size in which the entire 
diagram can be displayed 
within the confines of the 
current window. 

Diagrams – The Diagrams 
menu provides another 
method of accessing the 
seven different functions 
available on the Output 
View toolbar. 

2. Output View Toolbar – The 
Output View toolbar provides 
access to seven different types 
of stressors that can be 
applied to your truss.  The 
options include: Loads, Bearing Reactions, Deflections, Axial Forces, Shear Forces, Bending 
Moments, and Combined Stress Indices.  Detailed information about these functions is provided 
on the pages immediately following. 

3. Load Combo – The Load Combo drop-down provides access to a list of all of the standard and 
custom load cases and load combinations that have been assigned to the active truss. 

         TIP!  Once you have selected an item from the Load Combo drop-down list, you can use  
         the scroll button of your mouse to scroll through each of the other load combinations. 

  

Figure 190:  The Applied Loads View window. 

Figure 189: The Load 
View menu option. 
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4. Bearing Combo – The Bearing Combo drop-down list provides access to all combinations of 
bearings that have been created for the active truss.  These bearing combinations can be tested 
to identify their ideal arrangement from an engineering standpoint. 

5. Diagram Pane – The Diagram Pane displays the truss in Piece View and shows the direction and 
intensity of the stressors being applied to it. 

When a truss has already been analyzed or designed and is currently in a locked state, there are only 
two functions that are active and available from within the Applied Loads View window; Loads and 
Bearing Reactions.  The other functions on the Output View toolbar are grayed-out and unavailable.  To 
gain access to the full array of diagram functions, the analysis/design process must be re-run 
immediately prior to entering the Applied Loads View window.  This ensures that the most current code 
values are applied to the truss design prior to a detailed engineering review. 

LOADS 

The Loads function is 
automatically activated when 

entering Applied Loads View.  The review of 
loads begins with the selection of a load 
case or load combination from the Load 
Combo drop-down list.  (See Figure 188 on 
page 155.)  The specific loads and load 
combinations available on this list will 
depend upon two things: 1) the standard 
loads that have been enabled in the user’s 
presets, and 2) whether or not the user has 
created any custom loads or load combinations for the active truss. 

BEARING REACTIONS 

The Bearing Reactions 
function shows the impact of 

loads exerted on the bearings supporting a 
truss.  To begin, click on the Bearing 
Reactions command button on the Output 
View toolbar, and then select the desired 
values from the Load Combo and Bearing 
Combo drop-down lists.  (See Figure 188 
on page 155.) 

DEFLECTIONS 

Deflection refers to the 
displacement of a truss 

member, from its static position, as a 
result of the forces acting on that 
member.  In other words, Deflection 
diagrams show how much truss members  
will bend.  To begin, click on the 
Deflections button on the Output View  

Figure 191: The Applied Loads View. 

Figure 192: The Bearing Reactions diagram. 

Figure 193: The Deflections diagram. 
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toolbar, and then select the desired values from the Load Combo and Bearing Combo drop-down lists.  
(See Figure 188 on page 155.) 

Scale Factor – The Scale Factor field is used to define the percentage of a load case or load combination 
to be applied for Deflection calculations.  The default value is 954.28. 

AXIAL FORCES 

Axial Forces pass through the 
longitudinal axis of a truss member, and 
can be tension and/or compression 
related in nature.  Axial Force diagrams 
show areas of compression in pink and 
areas of tension in blue.  To begin, click on 
the Axial Forces button on the Output 
View toolbar, and then select the desired 
values from the Load Combo and Bearing Combo drop-down lists.  (See Figure 188 on page 155.) 

SHEAR FORCES 

Shear Force diagrams 
show the vertical pressures 

bearing upon truss members as a 
consequence of the opposing forces 
created by loads and reactions.  These 
diagrams show areas of positive Shear 
Force in blue and negative Shear Force 
in pink.  To begin, click on the Shear 
Forces button on the Output View toolbar, and then select the desired values from the Load Combo and 
Bearing Combo drop-down lists.  (See Figure 188 on page 155.) 

BENDING MOMENTS 

Bending Moments 
diagrams show the amount 

truss members will bow under the 
application of a load.  Bending Moment 
diagrams show positive (convex) 
bowing in blue and negative (concave) 
bowing in pink.   To begin, click on the 
Bending Moments button on the 
Output View toolbar, and then select the desired values from the Load Combo and Bearing Combo drop-
down lists.  (See Figure 188 on page 155.) 
  

Figure 194: The Axial Forces diagram. 

Figure 195: The Shear Forces diagram. 

Figure 196: The Bending Moments diagram. 



 

159 

 

COMBINED STRESS INDICES 

The Combined Stress 
Index (CSI) is the ratio of 

the maximum axial and bending 
forces expected in a member to the 
forces that the member should be 
capable of resisting.  With CSI 
diagrams, it is the color of the truss 
itself that represents whether or not 
the truss and its members pass the Combined Stress Indices test successfully.  As can be seen in Figure 
197 here, there is a key for the various colors in the upper-right-hand corner of the diagram pane. 

Show Envelope – When the Show Envelope checkbox is activated, the Combined Stress Indices are 
applied as a worse-case scenario.  Since the Load Combo and Bearing Combo drop-down lists are no 
longer needed, they are disabled when the Show Envelope checkbox is activated.  When the checkbox 
is not activated, CSI loads are applied on a per case basis.  

The Analog Element Window 
When reviewing Deflections, Axial Forces, Shear Forces, or Bending Moments, clicking anywhere on the 
outer portion of the truss profile opens an Analog Element window similar to the one pictured below.  
The Analog Element window provides additional detailed information about the performance of a 
specific piece of truss. 

 

 

 

 

 

 

 

 

  

Figure 197: The CSI diagram. 

Figure 198: The Analog Element window displays detailed info about the performance of a single piece of truss. 
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GS TRUSS OUTPUTS 
GS Truss offers a variety of report outputs for engineering, pricing, and manufacturing review and 
reference.  Outputs can be generated for individual truss files or run as a batch to provide data for 
multiple trusses.  This section of the GS Truss Designer’s Manual is dedicated exclusively to the topic of 
generating outputs for individual truss files.  For information about generating outputs for a batch of 
truss files, please refer to the section within this document entitled “GS Truss Batch Processes.”  

Cut Lists 
Cut List reports provide a wealth of information about the specific pieces required to create a given 
truss, including the materials to be used and the precise dimensions of each piece.  (For an example of a 
Cut List, see Appendix C of this document on page 187.)  To create a Cut List for the active truss and send 
it directly to your default printer (without reviewing it first), go to the GS Truss menu bar and select 
Output → Print → Cut List.  To preview a Cut List for the active truss file prior to printing it, perform 
either of the following actions: 

• From the GS Truss menu bar, 
select Output → Preview → 
Cut List. 

• On the GS Truss Output 
toolbar, click on the Preview 
Cut List icon. 

Either of these actions will open a 
Preview window like the one pictured 
at right.  Within this window, GS Truss 
provides a couple of fields and a 
handful of command buttons to help 
you navigate and review the contents 
of your Cut List: 

Scale – The Scale field is used to 
define the size of the Cut List as it 
is displayed within the Preview window.  Type a percentage into this field, or use the drop-down 
arrow to select one of the following predefined settings: 50%, 100%, 200%, Page Width, or Whole 
Page. 

Go To Page – Use the Go To Page field to type in the number of the specific page to which you wish 
to navigate.  If you prefer, you may click on the Up and Down arrow buttons to enter the desired 
page number. 

COMMAND BUTTONS 

Print – Click on the Print button to open a Windows Print dialog box.  From here, you can select the 
desired printer, along with the range of pages and the number of copies to be printed. 

First – Click on the First button to navigate back to the first page of a multi-page report. 

Previous – Click on the Previous button to navigate to the page immediately preceding the page 
currently displayed. 

Figure 199: Reviewing and printing a Cut List. 
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Next – Click on the Next button to navigate to the page that immediately follows the page currently 
displayed. 

Last – Click on the Last button to display the final page of a multi-page report. 

        NOTE! The specific content and format of Cut Lists are defined within the Cutting tab of Cutting/  
        Plotting Presets.  For additional information about Cut List content and format options, please  
    refer to the section within this document entitled “Working with GS Truss Presets.” 

Plot Drawings 
Plot Drawings provide both detailed and summary information about the reactions of your truss to the 
various loads that have been applied to it during analysis.  (For an example of a Plot Drawing, see 
Appendix D of this document on page 188.)  To create a Plot Drawing for the active truss and send it 
directly to your default printer (without reviewing it first), go to the GS Truss menu bar and select 
Output → Print → Plot Drawing.  To preview a Plot Drawing for the active truss file prior to printing it, 
perform either of the following actions: 

• From the GS Truss 
menu bar, select 
Output → Preview 
→ Plot Drawing. 

• On the GS Truss 
Output toolbar, click 
on the Preview Plot 
icon. 

Either of these actions will 
open a Preview window like 
the one pictured at right.  
Within this window, GS 
Truss provides a couple of 
fields and a handful of 
command buttons to help 
you navigate and review the 
contents of your Plot 
Drawing: 

Scale – The Scale field is used to define the size of the Plot Drawing as it is displayed within the 
Preview window.  Type a percentage into this field, or use the drop-down arrow to select one of the 
following predefined settings: 50%, 100%, 200%, Page Width, or Whole Page. 

Go To Page – Use the Go To Page field to type in the number of the specific page to which you wish 
to navigate.  If you prefer, you may click on the Up and Down arrow buttons to enter the desired 
page number. 

COMMAND BUTTONS 

Print – Click on the Print button to open a Windows Print dialog box.  From here, you can select the 
desired printer, along with the range of pages and the number of copies to be printed. 

First – Click on the First button to navigate back to the first page of a multi-page report. 

Figure 200: Reviewing and printing a Plot Drawing. 
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Previous – Click on the Previous button to navigate to the page immediately preceding the page 
currently displayed. 

Next – Click on the Next button to navigate to the page that immediately follows the page currently 
displayed. 

Last – Click on the Last button to display the final page of a multi-page report. 

        NOTE! The specific content and format of Plot Drawings are defined within the Plotting tab of  
        Cutting/Plotting Presets.  For additional information about Plot Drawing content and format  
    options, please refer to the section entitled “Working with GS Truss Presets.” 

Joint Detail Reports 
As the name implies, Joint Details Reports provide in-depth information about where and how the 
various pieces of a truss are joined together.  (For an example of a Joint Details Report, see Appendix E 
of this document on page 189.)  To create a Joint Details Report for the active truss and send it directly 
to your default printer (without reviewing it first), go to the GS Truss menu bar and select Output → 
Print → Joint Details.  To preview a Joint Details Report for the active truss file prior to printing it, 
perform either of the following actions: 

• From the GS Truss 
menu bar, select 
Output → Preview 
→ Joint Details. 

• On the GS Truss 
Output toolbar, click 
on the Preview Joint 
Details icon. 

Either of these actions will 
open a Preview window like 
the one pictured at right.  
Within this window, GS 
Truss provides a couple of 
fields and a handful of 
command buttons to help 
you navigate and review the 
contents of your Joint 
Details Report: 

Scale – The Scale field is used to define the size of the Joint Details Report as it is displayed within 
the Preview window.  Type a percentage into this field, or use the drop-down arrow to select one of 
the following predefined settings: 50%, 100%, 200%, Page Width, or Whole Page. 

Go To Page – Use the Go To Page field to type in the number of the specific page to which you wish 
to navigate.  If you prefer, you may click on the Up and Down arrow buttons to enter the desired 
page number. 

  

Figure 201: Reviewing and printing a Joint Details Report. 
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COMMAND BUTTONS 

Print – Click on the Print button to open a Windows Print dialog box.  From here, you can select the 
desired printer, along with the range of pages and the number of copies to be printed. 

First – Click on the First button to navigate back to the first page of a multi-page report. 

Previous – Click on the Previous button to navigate to the page immediately preceding the page 
currently displayed. 

Next – Click on the Next button to navigate to the page that immediately follows the page currently 
displayed. 

Last – Click on the Last button to display the final page of a multi-page report. 

Single Page Joint Details Reports 
Similar in content to the Joint Details report, each page of a Single Page Joint Details report provides an 
enlarged diagram of a single joint, along with a diagram of the entire truss as a whole.  (For an example 
of a Single Page Joint Details Report see Appendix F of this document on page 190.)  To create a Single 
Page Joint Details Report for the active truss and send it directly to your default printer (without 
reviewing it first), go to the GS Truss menu bar and select Output → Print → Single Page Joint Details.  To 
preview a Single Page Joint Details Report for the active truss file prior to printing it, perform either of 
the following actions: 

• From the GS Truss 
menu bar, select 
Output → Preview 
→ Single Page Joint 
Details. 

• On the GS Truss 
Output toolbar, click 
on the Preview 
Single Page Joint 
Details icon. 

Either of these actions will 
open a Preview window like 
the one pictured in Figure 
202 at right.  Within this 
window, GS Truss provides a 
couple of fields and a 
handful command buttons to 
help you navigate and review the contents of your Single Page Joint Details Report: 

Scale – The Scale field is used to define the size of the Single Page Joint Details Report as it is 
displayed within the Preview window.  Type a percentage into this field, or use the drop-down arrow 
to select one of the following predefined settings: 50%, 100%, 200%, Page Width, or Whole Page. 

Go To Page – Use the Go To Page field to type in the number of the specific page to which you wish 
to navigate.  If you prefer, you may click on the Up and Down arrow buttons to enter the desired 
page number. 

  

Figure 202: Reviewing and printing a Single Page Joint Details Report. 
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COMMAND BUTTONS 

Print – Click on the Print button to open a Windows Print dialog box.  From here, you can select the 
desired printer, along with the range of pages and the number of copies to be printed. 

First – Click on the First button to navigate back to the first page of a multi-page report. 

Previous – Click on the Previous button to navigate to the page immediately preceding the page 
currently displayed. 

Next – Click on the Next button to navigate to the page that immediately follows the page currently 
displayed. 

Last – Click on the Last button to display the final page of a multi-page report. 

Full Scale Joint Details Reports 
Each page of a Full Scale Joint Details report provides a life-sized, full-scale diagram of a single joint in a 
truss.  To create a Full Scale Joint Details Report for the active truss and send it directly to your default 
printer (without reviewing it first), go to the GS Truss menu bar and select Output → Print → Full Scale 
Joint Details.  To preview a Full Scale Joint Details Report for the active truss file prior to printing it, 
perform either of the following actions: 

• From the GS Truss 
menu bar, select 
Output → Preview 
→ Full Scale Joint 
Details. 

• On the GS Truss 
Output toolbar, click 
on the Preview Full 
Scale Joint Details 
icon. 

Either of these actions will 
open a Preview window like 
the one pictured at right.  
Within this window, GS 
Truss provides a couple of 
fields and a handful 
command buttons to help 
you navigate and review the 
contents of your Full Scale Joint Details Report: 

Scale – The Scale field is used to define the size of the Full Scale Joint Details as it is displayed within 
the Preview window.  Type a percentage into this field, or use the drop-down arrow to select one of 
the following predefined settings: 50%, 100%, 200%, Page Width, or Whole Page. 

Go To Page – Use the Go To Page field to type in the number of the specific page to which you wish 
to navigate.  If you prefer, you may click on the Up and Down arrow buttons to enter the desired 
page number. 

  

Figure 203: Reviewing and printing a Full Scale Joint Details Report. 
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COMMAND BUTTONS 

Print – Click on the Print button to open a Windows Print dialog box.  From here, you can select the 
desired printer, along with the range of pages and the number of copies to be printed. 

First – Click on the First button to navigate back to the first page of a multi-page report. 

Previous – Click on the Previous button to navigate to the page immediately preceding the page 
currently displayed. 

Next – Click on the Next button to navigate to the page that immediately follows the page currently 
displayed. 

Last – Click on the Last button to display the final page of a multi-page report. 

Pricing Reports 
Pricing reports provide information about the material and labor costs associated with the manufacture 
of a given truss.  (For an example of a Pricing Report, see Appendix G of this document on page 198.)  To 
create a Pricing Report for the active truss and send it directly to your default printer (without reviewing 
it first), go to the GS Truss menu bar and select Output → Print → Pricing.  To preview a Pricing Report 
for the active truss file prior to printing it, perform either of the following actions: 

• From the GS Truss 
menu bar, select 
Output → Preview 
→ Pricing. 

• On the GS Truss 
Output toolbar, click 
on the Preview 
Pricing icon. 

Either of these actions will 
open a Preview window like 
the one pictured at right.  
Within this window, Key-
Truss provides a couple of 
fields and a handful com-
mand buttons to help you 
navigate and review the 
contents of your report: 

Scale – The Scale field is used to define the size of the Pricing Report as it is displayed within the 
Preview window.  Type a percentage into this field, or use the drop-down arrow to select one of the 
following predefined settings: 50%, 100%, 200%, Page Width, or Whole Page. 

Go To Page – Use the Go To Page field to type in the number of the specific page to which you wish 
to navigate.  If you prefer, you may click on the Up and Down arrow buttons to enter the desired 
page number. 

COMMAND BUTTONS 

Print – Click on the Print button to open a Windows Print dialog box.  From here, you can select the 
desired printer, along with the range of pages and the number of copies to be printed. 

Figure 204: Reviewing and printing a Pricing Report. 
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First – Click on the First button to navigate back to the first page of a multi-page report. 

Previous – Click on the Previous button to navigate to the page immediately preceding the page 
currently displayed. 

Next – Click on the Next button to navigate to the page that immediately follows the page currently 
displayed. 

Last – Click on the Last button to display the final page of a multi-page report. 

        NOTE! The specific content and prices applied in Pricing Reports are defined in the user’s  
        Pricing Presets.  For additional information, please refer to the section within this document  
   entitled “Working with GS Truss Presets.” 

Jig Setting Reports 
Jig Setting Reports provide information about the setup and configuration of a jig table as required for 
the manufacture of a given truss.  (For an example of a Jig Settings Report, see Appendix H of this 
document on page 200.)  To create a Jig Settings Report for the active 
truss and send it directly to your default printer (without reviewing it 
first), go to the GS Truss menu bar and select Output → Print → Jig 
Settings.  This will open a Jig Table Offsets dialog box like the one 
pictured in Figure 205 at right.  Enter the desired horizontal (“X”) and 
vertical (“Y”) offsets for your table and then click on the OK button to 
close this dialog box and print your report. 

 To preview a Jig Settings Report for the active truss file prior to printing 
it, perform either of the following actions: 

• From the GS Truss 
menu bar, select 
Output → Preview → 
Jig Settings. 

• On the GS Truss 
Output toolbar, click 
on the Preview Jig 
Settings icon. 

Either of these actions will 
open a Jig Table Offsets 
dialog box like the one 
pictured in Figure 205.  Enter 
the desired horizontal (“X”) 
and vertical (“Y”) offsets for 
your table and then click on 
the OK button.  This will 
close the Jig Table Offsets 
dialog box and open a Preview window like the one pictured at above.  Within this window, GS Truss 
provides a couple of fields and a handful command buttons to help you navigate and review the 
contents of your Jig Setting Report: 

Figure 205:  The Jig Table Offsets 
dialog box. 

Figure 206: Reviewing and printing a Jig Settings Report. 
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Scale – The Scale field is used to define the size of the Jig Setting Report as it is displayed within the 
Preview window.  Type a percentage into this field, or use the drop-down arrow to select one of the 
following predefined settings: 50%, 100%, 200%, Page Width, or Whole Page. 

Go To Page – Use the Go To Page field to type in the number of the specific page to which you wish 
to navigate.  If you prefer, you may click on the Up and Down arrow buttons to enter the desired 
page number. 

COMMAND BUTTONS 

Print – Click on the Print button to open a Windows Print dialog box.  From here, you can select the 
desired printer, along with the range of pages and the number of copies to be printed. 

First – Click on the First button to navigate back to the first page of a multi-page report. 

Previous – Click on the Previous button to navigate to the page immediately preceding the page 
currently displayed. 

Next – Click on the Next button to navigate to the page that immediately follows the page currently 
displayed. 

Last – Click on the Last button to display the final page of a multi-page report. 

         NOTE! The specific content of Jig Setting Reports is dictated by the user’s Jig Settings  
         Presets. For additional information, please refer to the section within this document    
     entitled “Working with GS Truss Presets.” 
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APPENDIX A:  GLOSSARY OF TERMS 
Allowable Stress Design – Allowable Stress Design (ASD) is a method of proportioning the structural 
components of a building such that their allowable strength equals or exceeds the required strength of 
the components under the action of ASD loading combinations. 
American Society of Civil Engineers – The American Society of Civil Engineers (ASCE) is a professional 
organization founded in 1852 to represent members of the civil engineering profession worldwide.  
Based in Reston, Virginia, it is the oldest national engineering society in the United States. 

Analysis Process – The GS Truss analysis process checks current /selected materials against applied 
loads. 

Apex – The uppermost point of a truss where the sloped top chords meet.  Keymark uses the terms peak 
and apex interchangeably. 

Area – A space or surface contained within a defined set of geometric boundaries. 

ASCE – See “American Society of Civil Engineers.” 

ASD – See “Allowable Stress Design.” 

Axial Force – A force that passes through the longitudinal axis of a truss member.  Axial forces can be 
either tension or compression. 

Batch – A collection of trusses, usually consisting of an entire job. 

Bearing – An object or surface that serves as a structural support for a truss. 

Bearing Wall – A wall that supports a load in addition to its own weight. 

BIM – See “Building Information Modeling.” 

Blocking – Non-structural webbing used in gables. 

Building Category – The classification of structures (put forth by the American Society of Civil Engineers) 
based on the nature of occupancy, for the purpose of applying flood, wind, snow, earthquake, and ice 
provisions.  The categories range from I to IV, where category I represents buildings and other structures 
with a low hazard to human life in the event of failure and category IV represents essential facilities. 

Building Information Modeling – Building Information Modeling (BIM) is a design methodology that 
maintains a single database of information about a building’s design including components used to 
design the model, views of the project, drawings of the design, and related documentation. 

Building Standard Loads – Loads that are applied to a structure in GS Plan and imported into GS Truss 
via a GS Plan ITR or ITF file. 

Bumping – The process of upgrading the class of construction materials from 
less to more robust, one class at a time, until design requirements are satisfied. 

C & C – See “Components and Cladding.” 

Cantilever – The part of a structural member or truss that extends beyond one 
or both of its bearings. 
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Appendix A:  Glossary of Terms (continued) 

Chord – Any of the outer members of a truss that define its shape or profile. 

Combined Stress Index – The Combined Stress Index (CSI) is the ratio of the maximum axial and bending 
forces expected in a member to the forces that the member should be capable of resisting. 

Component – A building element that is usually delivered and installed on site, rather than built on site. 
For example, window and door components are usually delivered to a site fully assembled.  In contrast, 
walls, floors, and roofs are built on site. 

Components and Cladding – Elements of the building envelope that do not qualify as part of the Main 
Wind Force Resisting System (MWFRS).  Cladding receives wind loads directly.  (Roof covering and wall 
covering are examples of cladding.)  Components receive wind loads either directly or from the cladding 
and then transfer the loads to the Main Wind Force Resisting System.  (Examples of components include 
fasteners, purlins, girts, studs, roof decking, and roof trusses.) 

Compression – A force that pushes on a body and tends to compress or shorten it.  In truss members, 
this force acts along the length of the member.  As the term is used in Keymark applications, 
compression is the opposite of tension. 

Cripple Stud – A short steel member used above or below a window or door opening to support the 
frame. 

CSI – See “Combined Stress Index.” 

Cut Type – The style in which a material is trimmed.  For example, in GS Truss, overhanging members of 
a truss may be trimmed in four different ways, as pictured below.  Note: The difference between the Cut 
Types “Cut In” and “Cut Out” is one of dimension.  That is to say, though the cuts may appear to be 
identical, the actual length of each overhang will differ, with a “Cut In” overhang being slightly shorter 
than a “Cut Out” overhang of the same specified dimension. 

Cutback – The calculated adjustment to truss geometry that ensures chord and/or segment ends meet 
without overlapping one another at a join. 

Dead Load – 1) A vertical, gravity load that results from the weight of the building itself and any fixed 
equipment in the building.  2) A load that is permanent, unmoving, and consistent across its member, 
such as the weight of roofing, flooring, sheathing, insulation, or ceiling material, as well as the weight of 
the truss itself.   

Deflection – Displacement of a member from its static position as a result of the forces acting on that 
member. 

  

                                  Plumb Cut                              Cut In                            Cut Out                            Horizontal 
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Appendix A:  Glossary of Terms (continued) 

Design Process – The GS Truss design process distributes applied loads to truss members, computes 
internal force distributions, and selects truss member and connection materials to withstand the 
internal stresses and/or limit states in accordance with the selected building code design criteria. 

Dimension – A view-specific element that shows the size of an element or shows distances between 
elements or points in a building model. 

Distributed Load – A load that is spread over a defined length of a truss member. 

Drag Load – Lateral stresses, imposed by wind or earthquakes, which must  
be resisted by a structure. 

Drop Top – A gable truss in which the top chord has been lowered vertically in order to allow outlookers 
to form an overhang. 

DXF – Drawing Exchange Format (DXF) is an open file format that is supported by 
many CAD applications. 

Eave – The projecting edge of a roof that extends beyond its supporting wall. 

Elevation Table – An optional section of information that can be added to GS 
Truss cut lists and plot drawings.  Elevation tables provide details about the 
location of a truss’s chords along the horizontal plane. 

Enclosure Classification – The categorization of structures based upon the degree to which their interior 
space is enclosed.  Enclosure classifications in GS Truss include: Full, Partial, and 
Open. 

End Zone Truss – A truss located in the “end zone” of a building.  (See the figure at 
right.)  Trusses located in the end zone require a higher wind load capacity than 
those located in the interior zones of a structure. 

Engineer Title Block File – An Engineer Title Block File (TBE) contains information 
about the component engineer or company-specific engineering information that is to be displayed in 
the bottom right corner of the engineering plot drawings. Users can create multiple TBEs and, thereby, 
customize the engineering information displayed on engineering output (for example, plot drawings). 

Exposure Category – A classification of structures based upon the degree to which they are subject to 
elemental forces such as wind, rain, and snow.  Exposure categories in GS Truss include: Fully Exposed, 
Partially Exposed, and Sheltered. 

Exterior – The outside of a building, or the outside face of a surface. 

Fascia – The finish board covering the edges of a roof at the eaves.  

FBC – See “Florida Building Code.” 

Fixity – The degree to which a bearing is either moveable or immovable and, if  
permitted, the direction in which movement is allowed.  A pinned bearing is immovable.   
A horizontal roll (H Roll) bearing permits movement along the horizontal plane.  A vertical roll (V Roll) 
bearing permits movement along the vertical plane.  All trusses must have at least one pinned bearing. 
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Appendix A:  Glossary of Terms (continued) 

Flange – A ridge that projects at right angles from the edge of a truss member 
to provide strength and rigidity. 

Florida Building Code – The Florida Building Code (FBC) is based on national 
model building codes and national consensus standards which are amended, 
where necessary, for Florida’s specific needs.  The code incorporates all 
building-construction-related regulations for public and private buildings in the 
state of Florida. 

Force – The energy that causes a mass to accelerate.  In structural design, force is generally experienced 
as a push or pull. 

Foundation – The lower part of a building, which transfers structural loads from the 
building to the ground. 

Gable – A triangular portion of the end-wall of a building directly under the sloping roof 
and above the eave line. 

Gable Truss – A truss that has vertical “in-plane” webs fastened to its chords, instead of 
diagonal web members, so that sheathing can be easily attached.  These trusses usually 
occur at the ends of a structure. 

Gambrel Roof – A roof having two slopes on each side, the lower slope usually 
steeper that the upper one. Generally seen on farm structures. 

Girder Truss – A truss that supports other trusses. 

Gusset Joint – An area where two or more pieces of truss material are joined 
together with a gusset plate. 

Gusset Plate – A sheet of steel used to connect beams and girders to columns or to connect truss 
members.  A gusset plate can be fastened to a permanent member by bolts, rivets, welding, or a 
combination of the three. Gusset plates not only serve as a method of joining steel members together 
but they also strengthen the joint. 

Gusset Table – An optional section of information that can be added to GS Truss plot drawings, used to 
provide details about the gusset plates and joints associated with a given truss. 

Gutter – A trough (often made of metal or plastic) along the edge of a roof.  A gutter collects water off 
the eaves and carries it to the down spouts. 

H Roll – A bearing type that accommodates limited horizontal forces while resisting vertical 
forces.  Pictured at right are the icons that GS Truss uses to represent H-Roll bearings. 

Heel – The area of a truss where the top and bottom chords intersect.  With a high heel, the top and 
bottom chords of a truss do not actually meet. 

Heel Height – The length from the top of the top chord through the underside of 
the bottom chord on either end of a truss.  This includes any connection material.  
Heel heights may be different on either end of a truss. 

H Roll icons 

Gambrel Roof 
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Appendix A:  Glossary of Terms (continued) 

Hip Roof – A roof with three or more roof planes coming together at a peak, with 
four separate hip legs. 

Hip Set – A collection of trusses, girders, and connective materials required to 
frame a hip roof.  

Horizontal – Parallel to the horizon. 

Horizontal Offset – A measure of specific distance, from a given point, parallel to the plane of the 
horizon. 

Horizontal Roll Bearing – See “H Roll.” 

IBC – See “International Building Code.” 

Ice Dam – The ice that forms at the end of an overhang due to the processes 
of melting and refreezing. 

Imperial Units – The British imperial system of weights and measures.  
(Examples of imperial units include: feet and inches; pounds and ounces.) 

Inches on Center – Inches on Center (IOC) is the measure GS Truss uses to 
describe the spacing of trusses and bracing. 

International Building Code – The International Building Code (IBC) is a model building code developed 
by the International Code Council.  The IBC has been adopted throughout most of the United States. 

International Residential Code – The International Residential Code (IRC) is a comprehensive, stand-
alone residential code that creates minimum regulations for one- and two-family dwellings of three 
stories or less.  It includes building, plumbing, mechanical, fuel gas, energy, and electrical provisions. 

IOC – See “Inches On Center.” 

IRC – See “International Residential Code.” 

ITF – A floor truss file created in GS Plan.  ITF files contain the profile of a truss, some structure 
information, and some loading.  Only the profile (exterior shape), loads, and bearing locations of the 
truss are imported into GS Truss.  Webbing, bracing, and other internal design functions are added once 
the profile is imported. 

ITR – A roof truss file created in GS Plan.  ITR files contain the profile of a truss, some structure 
information, and some loading.  Only the profile (exterior shape), loads, and bearing locations of the 
truss are imported.  Webbing, bracing, and other internal design functions are added once the profile is 
imported. 

Jig Table – A specialized table, used to stage the construction of a truss, which holds the individual 
pieces of material and guides their placement as they are secured together.  A jig table’s primary 
purpose is to provide efficiency, repeatability, accuracy, and interchangeability in the manufacturing of 
trusses. 

  

Hip Roof 

http://en.wikipedia.org/wiki/Repeatability
http://en.wikipedia.org/wiki/Accuracy
http://en.wikipedia.org/wiki/Interchangeability
http://en.wikipedia.org/wiki/Manufacturing
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Appendix A:  Glossary of Terms (continued) 

Job – In GS Truss, the term “Job” refers to the organization of truss files into logical groups according to 
one or more shared properties, such as the name of the company, customer, or structure to which they 
belong.  Jobs are displayed in the GS Truss Projects window of GS Truss. 

Joint – Any area where two or more truss pieces are connected together. 

King Post – A vertical web at the center of a common or gable 
truss, or the vertical web at the end of a mono truss. 

KTC – A GS Truss file that contains truss-to-truss connection 
information. 

KTS – A truss file generated when an imported or newly created truss is saved in GS Truss.  KTS files 
contain all of the information required for output and production.  Other type of truss files (ITR/ITF) will 
be converted to KTS files upon their import into GS Truss. 

LDG – A GS Plan loading file that is converted to a KTC file when opened in GS Truss. 

Linear – Arranged in a line. 

Live Load – Stressors produced by the use and occupancy of a building or other structure.  Live loads do 
not include construction or environmental loads such as wind, snow, rain, earthquakes, or floods. 

Load – Any stressor, such as weight or friction, applied at any angle to a truss member. 

Load and Resistance Factor Design – A method of proportioning the structural components of a building 
such that their design strength equals or exceeds the required strength of the components under the 
action of LRFD load combinations.   

Load Factor – The amount by which a specified load is multiplied in order to calculate the design load.   

LRFD – See “Load Resistance Factor Design.” 

Main Wind Force Resisting System – Main Wind Force Resisting System (MWFRS) refers to the 
assemblage of structural elements assigned to provide support and stability for the overall structure.  
The system generally receives wind loading from more than one surface.  Structural elements such as 
cross bracing, shear walls, roof trusses, and roof diaphragms are part of MWFRS. 

Mansard – A decorative steep-sloped roof on the perimeter of a building. 

Material – The substance of which an object is made. 

Material File – See “MTR.” 

Material Priority Table – A GS Truss register that contains a detailed list of material options for the 
construction of truss chords and webs.  A single implementation of GS Truss can contain multiple MPTs; 
each based upon a company’s inventory and desired bumping sequence for truss materials. 

  

A king post affixed to a common truss 

Mansard Roof 
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Appendix A:  Glossary of Terms (continued) 

Member – A section of truss that extends between two points or nodes.  (See figure below.) 

Metric Units – The decimal-based system of measurement in predominant use throughout most of the 
world.  (Examples of metric units include: meters and centimeters; kilograms and grams.) 

Miter – A joint made by the equal beveling of each of the two parts to be joined. 

Model – A representation of a building or other design. 

Moment – A force that causes rotation, or has a tendency to cause rotation. 

Moment Connection – A connection that is designed to prevent joints from rotating when external force 
is applied to the unit. 

MPT – See “Material Priority Table.” 

MTR – A GS Truss file that provides material specifications for a given truss.  GS Truss provides the 
option to create an MTR file for each user-created truss. 

MWFRS – See “Main Wind Force Resisting System.” 

Node – Any point on a truss where two or more members intersect. 

Non-Bearing Wall – A wall that supports no additional vertical load beyond its own weight.  Non-bearing 
walls can be used to define and divide spaces  

Non-Structural – In GS Truss, any truss, or portion of a truss, that is not designed for loading or other 
forces. 

Offset – A defined distance from an element or line, along which the element or line will move, or a new 
element or line will be created. 

Open Joint – A joint connection type in which the joining members meet at one corner of an edge, 
leaving the remainder of the edge exposed. 

ORD – An output file for the AMS roll-former controller. 

The parts of a truss include chords, webs, segments, members, points, splices, and pieces. 
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Appendix A:  Glossary of Terms (continued) 

Origin – A fixed starting point, or the point in a coordinate system where the axes intersect. 

Orthogonal – At right angles to, or perpendicular to. 

Outlooker – A steel member affixed to a truss to form an overhang beyond the wall line of a gable. 

Outrigger – See “Outlooker.” 

Overhang – An extension of the top chord of a truss beyond the heel. 

Panel – Any section of truss between two adjacent joints. 

Panel Length – The distance between joints measured along a chord. 

Panel Point – A position on a truss member associated with a joint, bearing, or splice. 

PDF – A Portable Document Format (PDF) file. 

Peak – The uppermost point of a truss where the sloped top chords meet.  Keymark uses the terms peak 
and apex interchangeably. 

Piece – A portion of a truss formed from a single, continuous section of material. 

Pinned Bearing – A fixed bearing that resists horizontal and vertical forces.  Pictured at 
right are the icons that GS Truss uses to represent pinned bearings. 

Pitch – The overall slope of the top chord of a truss, usually expressed as vertical rise over horizontal run 
(e.g. 6/12).  In GS Truss, the terms pitch and slope are used interchangeably. 

Pitch Break – The point on a truss where two members with differing slopes meet. 

Plate – See “Gusset Plate.” 

Plot – An architectural- or engineering-plan drawing that shows the building(s), utility runs, and 
equipment layout of a project. 

Plumb Cut – A cut type in which the end of one member is cut vertically. 

Ply – A single truss belonging to a multi-truss unit.  In GS Truss, two to four identical trusses can be 
joined as a single unit for added strength. 

Point – See “Panel Point.” 

Point Load – A load concentrated at a specific location. 

Projected Load – A load that is applied relative to the horizontal plane. 

PRT – An output file for the AMS roll-former controller. 

Purlin – A bracing mechanism connecting neighboring trusses on the top chord and/or bottom chord.  
Purlins support the loads from the roof deck or sheathing. 

 

Pinned icons 
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Appendix A:  Glossary of Terms (continued) 

Queen Post – One of two upright supporting webs, set 
vertically between the bottom and top chords of a truss, at 
equal distances from the apex of the truss.  For example, an 
attic truss has two queen posts. 

R Value – A numerical value used to indicate resistance to the 
flow of heat. 

Radial – Arranged along a radius or arc. 

Rake – The sloped sides on the end of a roof. 

Rake Load – A load that is applied in line with, or perpendicular to, the angle of the member receiving 
the load. 

Reaction – The force on a bearing produced by a truss. 

Reference Point – An identified location that is used to position other objects relative to it. 

Ridge – The line formed by the juncture of two sloping roof planes. 

Roof Live Load – An impermanent load exerted on a roof, excluding snow and wind.  The combined 
weight of construction workers building a roof is an example of a Roof Live Load. 

Roof Plane – 1) A roofing area defined by having three or more separate edges. 2) A single side of a 
gable, hip, or mansard roof. 

Seat Cut – A horizontal section of truss, at the end of a sloping bottom chord, which 
provides a level surface for the truss to rest on a bearing. 

Segment – Any section of a truss that extends from end to end on a continuous 
member.  Segments include both chords and webs. 

Shear Force – A stress that develops in a truss member due to the opposing forces created by loads and 
reactions. 

SKP – The file format used for projects created using Trimble SketchUp. 

Slope – The angle of incline as measured against the horizontal plane, usually expressed as a ratio of 
vertical rise to horizontal run, or as a percent.  (For example, 6/12 or 33%.)  In GS Truss, the terms pitch 
and slope are used interchangeably. 

Soffit – A board (or other material) fixed to the underside of an eave, along the 
length of a structure, used to conceal the underlying assembly. 

Span – The distance equal to the total unsupported length of the bottom chord of 
a truss, from bearing to bearing. 

Splice – An area where two chord members are joined together to form a single 
member.  Splices may occur at or between panel points.  

Square Cut – A cut made perpendicular to the length of a member. 

Queen posts on an attic truss 
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Appendix A:  Glossary of Terms (continued) 
Stub – The action of cutting/trimming a section of 
a truss, usually to accommodate size limits for 
shipping. 

Structural – As the term is used in GS Truss, the 
term structural refers to any truss that supports 
load and adds to the physical integrity of a 
building as a whole.  With the exception of gables, most trusses are structural; however, gables may be 
designed for structural integrity as well. 

Substrate – A subsurface to which another material is bonded 

TBF – See “Title Block File.” 

Tension – A force that tends to stretch or elongate a body.  As the term is used in Keymark applications, 
tension is the opposite of compression. 

Terrain Category – A measure of the wind-breaking effect of the terrain surrounding a building site.  The 
more a building site is surrounded by trees, other buildings, and/or structures, the less exposed it is to 
the full force of the wind. 

Title Block File – A GS Truss Title Block File (TBF) file contains information about a company, including 
the organization’s name, address, logo, and contact numbers.  GS Truss embeds TBF information in 
construction-document outputs. 

Tributary Width – That portion of a roof where a load acts on the truss immediately below it.  Tributary 
width includes the width of the given truss, plus half the distance to the adjoining trusses on either side. 

Truss – An engineered, structural component, designed to carry its own weight plus the weight of 
superimposed loads.  Truss members form a semi-rigid structural framework, and are assembled such 
that members form triangles. 

Truss Engineering Drawing – A drawing, prepared by a professional engineer, that prescribes truss 
geometry (span, slope, chords, webs, panel point locations, plating, design loads, etc.) usually required 
for manufacturing and building inspection. 

Truss Member – See “Member.” 

Truss Panel – See “Panel.” 

Truss Piece – See “Piece.” 

Truss Segment – See “Segment.” 

Truss-To-Truss Connection Table – A Truss-to-Truss Connection (TTC) table defines the specific 
relationship between each carried truss and its carrying truss.  GS Truss automatically generates a TTC 
table each time a GS Plan LDG file is loaded.  Once created, the contents of a TTC table can be edited 
directly, when changes to truss design warrant it.  A TTC table can also be created manually when a 
collection of trusses has been created from scratch by the user.  GS Truss saves TTC information in a file 
with a “KTC” extension. 

TTC – See “Truss-To-Truss Connection Table.” 
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Appendix A:  Glossary of Terms (continued) 

V Roll – A bearing type that accommodates limited vertical forces while resisting 
horizontal forces.  Pictured at right are the icons that GS Truss uses to represent V-Roll 
bearings. 

Valley – The internal angle formed by the intersection of two sloping sides of 
a roof. 

Valley Set – A collection of trusses used to continue a roof line when roofs 
intersect. 

Vent – An opening placed in a structure in order to promote air circulation. 

Vertical – Perpendicular to the horizon. 

Vertical Offset – A measure of specific distance, from a given point, perpendicular to the plane of the 
horizon. 

Vertical Roll Bearing – See “V Roll.”  

Web – Internal members that join the top and bottom chords of a truss.  These members typically carry 
axial forces. 

Web Crippling – The limit state of local failure for a web plate in the immediate vicinity of a 
concentrated load or reaction. 
  

A Roof Valley 

V Roll icons 
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APPENDIX B:  GSS PRESETS 
GSS Presets are used to define the parameters used for manufacturing CFS-framing components with a 
Global Steel Systems (GSS) roll former equipped with a Beck controller.  The following is a description of 
the various fields and functions available in the GSS Presets dialog box: 

Machine Settings vs. Stick Functions – When the Machine Functions option is selected, the GSS Presets 
dialog box will appear as it does the figure above.  This page of the dialog box is used to control Section 
information (that is, profile and material specifications), as well as the assignment of Tool Numbers and 
Tool Settings.  The Stick Functions page of this dialog box is used to define the specific types of pieces to 
be manufactured.  (See page 185.) 

GLOBAL SETTINGS 

The following settings in the GSS Presets dialog box are global in nature, affecting both Machine Settings 
and Stick Functions. 

Scheme Name – All of the settings defined within the GSS Presets dialog box are saved, collectively, as a 
scheme.  A single scheme can be used to control the settings for multiple machines and, within a single 
scheme, the settings for each machine can be configured differently.  Likewise, each GSS machine can be 
assigned to multiple schemes.  Only one scheme can be active for at any given time.   

Figure 207:  The Machine Settings page for GSS Presets. 
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Appendix B:  GSS Presets (continued) 

The Scheme Name drop-down provides a list of all schemes available for your GSS roll formers.  The 
scheme that is selected from this list will serve as the default scheme for all your GSS Production 
files. 

Copy Scheme – Click on the Copy Scheme button to 
create a copy of the scheme that is currently selected 
in the Scheme Name drop-down list.  When you click 
on this button, GS Truss will open a Copy Scheme 
dialog box like the one pictured in Figure 208.  Type a 
unique name into the New Name field, and then click 
on the OK button to save the new copy of your 
scheme.  You can then modify the new copy of your 
scheme as desired.  (Click on the Cancel button to 
close this dialog box without saving a copy of your scheme.)   

Delete Scheme – Click on the Delete Scheme button to erase the 
scheme that is currently selected in the Scheme Name drop-down 
list.  When you click on this button, GS Truss will display the 
warning message shown in Figure 209.  Click on the OK button to 
proceed with erasing the selected scheme.  Click on the Cancel 
button to close this message box without deleting the scheme.  

Rename Scheme – Click on the Rename Scheme button  
to change the name of the scheme currently 
selected in the Scheme Name drop-down list.  When 
you do so, a Rename Scheme dialog box like the one 
pictured in Figure 210 will open.  Type a new and 
unique name for the scheme in the New Name field, 
and then click on the OK button to save your 
changes.  Click on the Cancel button to close this 
dialog box without changing the name of the 
selected scheme. 

Show Wall/Floor Presets – When this checkbox is activated, wall and floor-related presets in the 
GSS Presets dialog box are enabled and available for editing.  When not checked, wall and floor-
related presets are grayed-out and their current values cannot be changed. 

Show Truss Presets – When this checkbox is activated, truss-related presets in the GSS Presets 
dialog box are enabled and available for editing.  When not checked, truss-related presets are 
grayed-out and their current values cannot be changed. 

Metric – When this checkbox is activated, measurement values in the GSS Presets dialog box are 
displayed in millimeters, rather than feet, inches, and sixteenths of an inch. 

High Precision – When the High Precision checkbox is activated, measurement values in the GSS 
Presets dialog box are calculated and displayed down to four decimal points. 

Preset File –This read-only field displays the name of the file used to store GSS Presets information. 

Figure 208: The Copy Scheme dialog box. 

Figure 209: The warning message 
displayed when deleting a scheme. 

Figure 208:  The Rename Scheme dialog box. 
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Appendix B:  GSS Presets (continued) 

COMMAND BUTTONS 

Save – Clicking on the Save button stores all user-defined changes to GSS Presets and closes the GSS 
Presets dialog box. 

Cancel – Clicking on the Cancel button discards all user-defined changes to GSS Presets and closes 
the GSS Presets dialog box. 

MACHINE SETTINGS 

Machine – This drop-down provides a list of all roll formers currently entered into the system.  (Note 
that all machine names are user defined.)  The machines in this list are presented in the order in 
which they are designated to process a job.  Select a machine from this list if you wish to view or 
make changes to its current settings. 

Copy Machine – Click on the Copy Machine button 
to create a duplicate copy of all the settings defined 
for the roll former that is currently selected in the 
Machine drop-down list.  When you do so, a Copy 
Machine dialog box like the one pictured in Figure 
211 will open.  Type a name for your copy in the New 
Name field.  (Note that all machine names must be 
unique.)  When you are done, click on the OK button 
to save your copy and close the Copy Machine dialog 
box.  Click on the Cancel button to close the dialog box without saving your copy. 

 Delete Machine – Click on the Delete Machine button to erase 
the machine that is currently selected in the Machine drop-down 
list.  When you do so, a warning message like the one pictured in 
Figure 212 will open.  Click on the OK button to delete the 
selected machine and close this message box.  Click on the Cancel 
button to close the dialog box without deleting the selected 

machine. 

Rename Machine – Click on the Rename Machine 
button to change the name assigned to an existing 
roll former.  When you click on this button, a 
Rename Machine dialog box like the one pictured in 
Figure 213 will open.    Bear in mind that the name 
assigned to each machine must be unique. 

General Settings 

Minimum Depth – This field is used to define the minimum stick depth that the selected machine 
can accommodate. 

Maximum Depth – This field is used to define the maximum stick depth that the selected machine 
can accommodate. 

Figure 209:  The Copy Machine dialog box. 

Figure 210:  The warning message 
dis-played when deleting a machine. 

Figure 211: The Rename Machine dialog box. 



 

182 

 

Appendix B:  GSS Presets (continued) 

Minimum Thickness – This field is used to define the minimum stick thickness that the selected 
machine can accommodate. 

Maximum Thickness – This field is used to define the maximum stick thickness that the selected 
machine can accommodate. 

Shape Type 

Studs – When this checkbox is activated, the selected machine is designated for manufacturing stud 
sections.  If the checkbox is not activated, the machine is designated as not supporting the 
manufacture of stud sections. 

Tracks – When this checkbox is activated, the selected machine is designated for manufacturing 
track sections.  If the checkbox is not activated, the machine is designated as not supporting the 
manufacture of track sections.   

Mil Range – The minimum and maximum thicknesses of CFS coils supported by the selected 
machine. 

Additional Section Names 
In GS Truss, a section is the combination of the profile and material specification designated for 
machine output.  Section information allows products specified in GS Truss and GS Panel to have a 
coil associated with them. 

[Drop Down] – This drop-down provides a list of all 
sections currently available in the system. 

Add – Clicking on the Add button opens an Add 
Section dialog box like the one pictured in Figure 
214.  Type the desired Section Name and Coil Name 
into the fields provided, and then click on the OK 
button to save your new Section. Click Cancel to 
close this dialog box without saving the new Section. 

Modify – Clicking on the Modify button will open a 
Modify Section dialog box like the one pictured in 
Figure 215.  Change the Section Name and Coil 
Name data as desired, and then click on the OK 
button to save your changes. Click Cancel to close 
this dialog box without saving your changes. 

 

Delete – If you click on the Delete button, the section that is currently displayed in the Section Name 
drop-down list will be deleted from the system.  No warning message is displayed prior to the 
deletion, so be sure you wish to delete the selected section before clicking on this command button. 

 

 

Figure 212: The Add Section dialog box. 

Figure 213: The Modify Section dialog box. 
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Appendix B:  GSS Presets (continued) 

Tool Numbers 

Printer 1 – The assigned Tool Number for Printer 1.  A value of “-1” is used to designate that Printer 
1 does not exist.  A value of “99” indicates a GSS-specified printer command. 

Printer 2 – The assigned Tool Number for Printer 2.  A value of “-1” is used to designate that Printer 
2 does not exist.  A value of “99” indicates a GSS-specified printer command. 

Printer 3 – The assigned Tool Number for Printer 3.  A value of “-1” is used to designate that Printer 
3 does not exist.  A value of “99” indicates a GSS-specified printer command. 

Print Start – The field is used to define the starting location for location-specific printing operations. 

Index Hole – This field is used to assign a Tool Number for an Index Hole Punch.  A value of “-1” is 
used to designate that no Index Hole Punch is present. 

Full Shear – This field is used to assign a Tool Number for a Full Shear Punch.  A value of “-1”“ is used 
to designate that no Full Shear Punch is present. 

Half Shear – This field is used to assign a Tool Number for a Half Shear Punch.  A value of “-1 “ is 
used to designate that no Half Shear Punch is present. 

Utility Hole – This field is used to assign a Tool Number for a Utility Hole Punch.  A value of “-1 “ is 
used to designate that no Utility Hole Punch is present. 

Dimple – This field is used to assign a Tool Number for a Dimple Punch.  A value of “-1 “ is used to 
designate that no Dimple Punch is present. 

Double Dimple – This field is used to assign a Tool Number for a Double Dimple Punch.  A value of “-
1 “ is used to designate that no Double Dimple Punch is present. 

Anchor/Bolt Hole – This field is used to assign a Tool Number for an Anchor Punch.  A value of “-1 “ 
is used to designate that no Anchor Punch is present. 

Web Cut – This field is used to assign a Tool Number for a Web Cut Punch.  A value of “-1 “ is used to 
designate that no Web Cut Punch is present. 

Flange Cut – This field is used to assign a Tool Number for a Flange Cut Punch.  A value of “-1 “ is 
used to designate that no Flange Cut Punch is present. 

Lip Punch – This field is used to assign a Tool Number for a Lip Punch.  A value of “-1 “ is used to 
designate that no Lip Punch is present. 

Tool Settings 

Reverse Tracks – When this checkbox is activated, tracks that are modeled right-to-left are reversed 
to align printing with the other pieces in a given component. 

Courtesy Cuts – When this checkbox is activated, bottom tracks are machined to include web cuts 
for doors. 
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Appendix B:  GSS Presets (continued) 

Sort String – This field is used to define the sort order for sticks, according to the following values: 

 “W” sorts sticks by from greatest to least width. 
 “w” sorts sticks by from least to greatest width 
 “L” sorts sticks by from greatest to least length. 
 “l” sorts sticks by from least to greatest length 

Note that two characters may be entered into this field to designate a two-level sort order. 

Print Padding – This field is used to define the distance between a punch and the start of a print 
message. 

Character Width – This field specifies the width of individual print characters (in inches). 

Dimple Distance from Hard – The specified distance from the hard side of a section to a Dimple 
Punch.  A value of 0.0 is used to center the dimple in relation to both a stud and its track. 

Webcut Length – This field is used to define the actual size of the web cut tool. 

Webcut Overlap – This field is used to define the overlap required between successive web cut 
punches  to eliminate any extra sharp pieces of metal when there are double or triple web cuts. 

Webcut Padding – This field enlarges web cuts  at each end by the value entered here. 

Double Dimple Len – This field defines the spacing between dimples of double dimple tool. 

Flange Length – This field defines the size of the flange cut punch. 

Flange Overlap – This field defines the amount flange cuts will overlap when more than one 
successive cut is called for. 

Flange Offset – This field allows the user to offset the cutting if not aligning correctly. 

Utility Start – This field is used to define the location of the first utility hole. 

Utility O. C. Spacing – This field is used to define the spacing of utility punches. 

Utility Minimum – The minimum distance of a utility hole from the end of a stick. 

Half Shear Max Len – Sticks shorter than this length will receive a half shear rather than a full shear. 

Half Shear Min Len – The maximum total length for consecutive, half-sheared sticks. 

Company Name – When this checkbox is activated, the user may elect to enter a Company Name to 
be printed on machine outputs. 
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Appendix B:  GSS Presets (continued) 

STICK FUNCTIONS 

These checkboxes are used to define the stick types to be processed for the selected machine. 

Wall Pieces 
When any of the Wall Piece checkboxes are activated, the scheme for the selected machine will 
include the ability to manufacture the given piece type.  The list of wall pieces that can be produced 
includes the following: 

Party Stud 
King Stud 
Tee Stud 
End Stud 
Support Stud 
Trimmer 
Sill Trimmer 
Cripple 

Header 

Sill 
Bottom Plate 
Top Plate 
V. Bot Plate 
V. Top Plate 
Ribbon Plate 
Corner Blocking 

Tee Blocking 
Fire Blocking 

Blocking 
Bracing 
Backing 
User 1-6 
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Appendix B:  GSS Presets (continued) 

Truss Pieces 

Webs – When this checkbox is activated, the selected machine is designated to produce web pieces. 

Chords – When this checkbox is activated, the selected machine is designated to produce chord 
pieces. 
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APPENDIX C:  CUT LIST 
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APPENDIX D:  PLOT DRAWING  
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APPENDIX E:  JOINT DETAILS  
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APPENDIX F:  SINGLE PAGE JOINT DETAILS 
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Appendix F:  Single Page Joint Details  (continued)
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Appendix F:  Single Page Joint Details  (continued)
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Appendix F:  Single Page Joint Details (continued) 
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Appendix F:  Single Page Joint Details  (continued)
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Appendix F:  Single Page Joint Details  (continued)
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Appendix F:  Single Page Joint Details  (continued)
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Appendix F:  Single Page Joint Details  (continued)
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APPENDIX G:  PRICING REPORT 
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Appendix G:  Pricing Report  (continued)
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APPENDIX H:  JIG SETTINGS 
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